Customer Service

Technical Assistance
If you have general research, or technical questions about Thomson Reuters Case Logistix, call Customer Technical Support at 1-800-364-9853, Monday through Friday, 7:00 a.m. to 8:00 p.m. central time. You can also send an email message to clxhelp@thomsonreuters.com, or visit our contact page at legalsolutions.thomsonreuters.com/law-products/customer-service/contact-us.

Billing and Account Assistance
For billing and account assistance, call Customer Service at 1-800-364-9853 or email customerservice@thomsonreuters.com. Billing and account assistance is also available online at legalsolutions.thomsonreuters.com/customer-service.

Reference Materials
For free reference materials, visit legalsolutions.thomsonreuters.com/guides. Our products also contain comprehensive, searchable instruction available via the Help menu in the application.

Disclaimer
Thomson Reuters disclaims any and all liability arising from the use of this document and does not guarantee that any information contained herein is accurate or complete. This document contains information proprietary to Thomson Reuters and may not be reproduced, transmitted, or distributed in whole or part, in any form or by any means, without the express written permission of Thomson Reuters.

The example companies, organizations, products, domain names, email addresses, logos, people, places, and events depicted herein are fictitious. No association with any real company, organization, product, domain name, email address, logo, person, place, or event is intended or should be inferred.
# Contents

1 ABOUT CASE LOGISTIX

<table>
<thead>
<tr>
<th>Subheading</th>
<th>Page</th>
</tr>
</thead>
<tbody>
<tr>
<td>Working with Case Logistix Libraries</td>
<td>1</td>
</tr>
<tr>
<td>Case Logistix Definitions</td>
<td>1</td>
</tr>
<tr>
<td>Library Contents</td>
<td>1</td>
</tr>
<tr>
<td>Logging in to a Case Logistix Library</td>
<td>2</td>
</tr>
<tr>
<td>Switching Libraries</td>
<td>2</td>
</tr>
<tr>
<td>Logging out of a Library</td>
<td>2</td>
</tr>
<tr>
<td>Working with Offline Libraries</td>
<td>2</td>
</tr>
<tr>
<td>Creating Offline Libraries</td>
<td>2</td>
</tr>
<tr>
<td>Logging in to Offline Libraries</td>
<td>2</td>
</tr>
<tr>
<td>Synchronizing Offline Libraries</td>
<td>3</td>
</tr>
<tr>
<td>Supported File Types</td>
<td>3</td>
</tr>
<tr>
<td>Keyboard Shortcuts</td>
<td>4</td>
</tr>
<tr>
<td>Function Key Shortcuts</td>
<td>4</td>
</tr>
<tr>
<td>Ctrl Key Shortcuts</td>
<td>4</td>
</tr>
<tr>
<td>Alt Key Shortcuts</td>
<td>4</td>
</tr>
<tr>
<td>Shift Key Shortcuts</td>
<td>5</td>
</tr>
</tbody>
</table>

2 USING THE CASE LOGISTIX INTERFACE

<table>
<thead>
<tr>
<th>Subheading</th>
<th>Page</th>
</tr>
</thead>
<tbody>
<tr>
<td>Customizing the Interface</td>
<td>6</td>
</tr>
<tr>
<td>Creating Custom Toolbars</td>
<td>7</td>
</tr>
<tr>
<td>Adding and Removing Toolbar Buttons</td>
<td>7</td>
</tr>
<tr>
<td>Creating Custom Toolbars</td>
<td>7</td>
</tr>
<tr>
<td>Using the Default Toolbars</td>
<td>7</td>
</tr>
<tr>
<td>Standard Toolbar</td>
<td>7</td>
</tr>
<tr>
<td>Research Toolbar</td>
<td>8</td>
</tr>
<tr>
<td>Navigation Toolbar</td>
<td>8</td>
</tr>
<tr>
<td>Working with Views</td>
<td>8</td>
</tr>
<tr>
<td>Saving Custom Views</td>
<td>8</td>
</tr>
<tr>
<td>Loading Views</td>
<td>8</td>
</tr>
<tr>
<td>Managing Custom Views</td>
<td>8</td>
</tr>
<tr>
<td>Restoring Default Views</td>
<td>8</td>
</tr>
<tr>
<td>Viewing Session History</td>
<td>9</td>
</tr>
<tr>
<td>Configuring User Profile Options</td>
<td>9</td>
</tr>
<tr>
<td>General Options</td>
<td>9</td>
</tr>
<tr>
<td>Document Viewing Options</td>
<td>9</td>
</tr>
<tr>
<td>Data Entry Options</td>
<td>9</td>
</tr>
<tr>
<td>Advanced Options</td>
<td>10</td>
</tr>
</tbody>
</table>

3 WORKING WITH DOCUMENTS

<table>
<thead>
<tr>
<th>Subheading</th>
<th>Page</th>
</tr>
</thead>
<tbody>
<tr>
<td>Adding Documents</td>
<td>11</td>
</tr>
<tr>
<td>Adding Document Records</td>
<td>11</td>
</tr>
<tr>
<td>Linking Document Records to Native Files</td>
<td>11</td>
</tr>
<tr>
<td>Deleting Documents</td>
<td>12</td>
</tr>
<tr>
<td>Emptying the Recycle Bin</td>
<td>12</td>
</tr>
<tr>
<td>Restoring Documents from the Recycle Bin</td>
<td>12</td>
</tr>
<tr>
<td>Adding PST and ZIP Files</td>
<td>12</td>
</tr>
<tr>
<td>Adding PST Files</td>
<td>12</td>
</tr>
<tr>
<td>Adding ZIP Files</td>
<td>12</td>
</tr>
<tr>
<td>Attaching Documents</td>
<td>12</td>
</tr>
<tr>
<td>Adding Case Logistix Links to Microsoft Office Documents</td>
<td>13</td>
</tr>
<tr>
<td>Viewing Document History</td>
<td>13</td>
</tr>
</tbody>
</table>
Working with PDFs, TIFF Files, and TIFFLISTS .......................................................... 13
Combining TIFF and PDF Files .................................................................................. 13
Splitting TIFF and PDF Files .................................................................................... 13
Creating TIFFLISTS .................................................................................................... 14

4 WORKING WITH THE LIBRARY INDEX .................................................................. 15
Creating the Library Index ......................................................................................... 15
Updating the Library Index ....................................................................................... 15
Compacting the Library Index .................................................................................... 15
Configuring Index Settings ....................................................................................... 15
General Tab ............................................................................................................... 16
Alphabet Tab ............................................................................................................. 17
Noise Words Tab ....................................................................................................... 17
Filtering Options Tab ............................................................................................... 17
File Types Tab .......................................................................................................... 18
Service Tab .............................................................................................................. 18
Metadata Extractor Tab ............................................................................................ 19
Importing Index Settings ......................................................................................... 19
Installing Indexing Services on Separate Servers .................................................... 19

5 WORKING WITH THE DOCUMENT LIST .................................................................. 20
Adding Columns ........................................................................................................ 20
Navigating the Document List ................................................................................... 20
Sorting Columns ........................................................................................................ 20
Arranging and Resizing Columns ............................................................................. 20
Saving Custom Column Settings ............................................................................. 21
Delivering the Document List ................................................................................... 21
Printing the Document List ....................................................................................... 21
Saving the Document List ........................................................................................ 21
Emailing the Document List ....................................................................................... 21
Exporting to Excel .................................................................................................... 21
Filtering the Document List ....................................................................................... 21
Grouping Documents By Field .................................................................................. 21
Grouping Documents ............................................................................................... 22
Grouping by Cluster ................................................................................................... 22
Grouping by Document Family ................................................................................ 23
Grouping by Email Thread ....................................................................................... 24
Grouping by Exact Duplicates .................................................................................. 26
Grouping by Near Duplicates ................................................................................... 26
Using the Send To Feature ....................................................................................... 28
Sending Documents to Folders ................................................................................ 28
Sending Documents in Emails ............................................................................... 28
Sending Documents to CaseMap ............................................................................. 28
Sending Documents to Case Notebook ................................................................... 28
Endorsing Documents .............................................................................................. 31
Using Check Spelling ............................................................................................... 31
Using Find and Replace ............................................................................................. 32

6 WORKING WITH THE DOCUMENT VIEWER .......................................................... 33
Using the Mark-up Tab .............................................................................................. 33
Creating a Markup File .............................................................................................. 33
Using Split View ........................................................................................................ 33
Using the HTML Tab ................................................................................................ 33
Using the Associated Text Tab ................................................................................ 33
Using the Native/Image Tab ....................................................................................... 33
Using Split View ........................................................................................................ 33
Working with Keywords ............................................................................................ 33

Contents ii
<table>
<thead>
<tr>
<th>Section</th>
<th>Page</th>
</tr>
</thead>
<tbody>
<tr>
<td>11 WORKING WITH CASE LOGISTIX UTILITIES</td>
<td></td>
</tr>
<tr>
<td>Using the Bates Analyzer Utility</td>
<td>54</td>
</tr>
<tr>
<td>Using the Build Markup Utility</td>
<td>54</td>
</tr>
<tr>
<td>Generating Markup Files for Native PDFs</td>
<td>54</td>
</tr>
<tr>
<td>Monitoring the Markup Job</td>
<td>55</td>
</tr>
<tr>
<td>Viewing Log Files</td>
<td>55</td>
</tr>
<tr>
<td>Using the Duplicate Records Utility</td>
<td>55</td>
</tr>
<tr>
<td>Using the Metadata Locator Utility</td>
<td>55</td>
</tr>
<tr>
<td>What is Metadata?</td>
<td>55</td>
</tr>
<tr>
<td>Using the Missing Files Utility</td>
<td>56</td>
</tr>
<tr>
<td>Using the Optical Character Recognition (OCR) Utility</td>
<td>56</td>
</tr>
<tr>
<td>What is OCR?</td>
<td>56</td>
</tr>
<tr>
<td>Using the Orphan Files Utility</td>
<td>56</td>
</tr>
<tr>
<td>12 PRINTING DOCUMENTS</td>
<td>57</td>
</tr>
<tr>
<td>Select Documents to Print</td>
<td>57</td>
</tr>
<tr>
<td>Pages to Print</td>
<td>57</td>
</tr>
<tr>
<td>Printing Options</td>
<td>57</td>
</tr>
<tr>
<td>Printing Notes</td>
<td>57</td>
</tr>
<tr>
<td>Batch Options</td>
<td>57</td>
</tr>
<tr>
<td>13 USING THE FORMAT EXPRESSION BUILDER</td>
<td>59</td>
</tr>
<tr>
<td>Building an Expression</td>
<td>59</td>
</tr>
<tr>
<td>Selecting a Special Value</td>
<td>59</td>
</tr>
<tr>
<td>Selecting a Field Value</td>
<td>59</td>
</tr>
<tr>
<td>14 PRODUCING DOCUMENTS</td>
<td>60</td>
</tr>
<tr>
<td>Preparing for a Production</td>
<td>60</td>
</tr>
<tr>
<td>15 WORKING WITH CASE LOGISTIX ANALYTICS</td>
<td>61</td>
</tr>
<tr>
<td>Setting up Case Logistix Analytics</td>
<td>61</td>
</tr>
<tr>
<td>Specifying the Job Storage Location</td>
<td>61</td>
</tr>
<tr>
<td>Configuring Analytics Grouping and Sorting Options</td>
<td>61</td>
</tr>
<tr>
<td>Default Analytics Fields</td>
<td>61</td>
</tr>
<tr>
<td>Using the Case Logistix Analytics Wizard</td>
<td>62</td>
</tr>
<tr>
<td>Excluding Terms from Cluster Titles</td>
<td>63</td>
</tr>
<tr>
<td>16 WORKING WITH DASHBOARD UTILITIES</td>
<td>64</td>
</tr>
<tr>
<td>Troubleshooting Dashboard Utilities</td>
<td>64</td>
</tr>
<tr>
<td>Batching Utility</td>
<td>64</td>
</tr>
<tr>
<td>Batching Examples</td>
<td>64</td>
</tr>
<tr>
<td>Batching Scenario (Simple)</td>
<td>64</td>
</tr>
<tr>
<td>Batching Scenario (Advanced)</td>
<td>64</td>
</tr>
<tr>
<td>Batching Items Created During Installation</td>
<td>65</td>
</tr>
<tr>
<td>User Dashboard Tools</td>
<td>65</td>
</tr>
<tr>
<td>Batch Reports</td>
<td>65</td>
</tr>
<tr>
<td>Batching User Tools-All Levels</td>
<td>66</td>
</tr>
<tr>
<td>Reports</td>
<td>67</td>
</tr>
<tr>
<td>User Tools</td>
<td>67</td>
</tr>
<tr>
<td>Admin Dashboard Tools</td>
<td>68</td>
</tr>
<tr>
<td>Admin Reports</td>
<td>68</td>
</tr>
<tr>
<td>Admin Tools</td>
<td>68</td>
</tr>
<tr>
<td>Batching Admin Tools</td>
<td>69</td>
</tr>
<tr>
<td>User Hours (approx.) Chart</td>
<td>69</td>
</tr>
<tr>
<td>Database Overview Report Chart</td>
<td>69</td>
</tr>
<tr>
<td>User Productivity Report</td>
<td>69</td>
</tr>
<tr>
<td>Field Populated &amp; Null Count Report</td>
<td>70</td>
</tr>
<tr>
<td>Custom Report</td>
<td>70</td>
</tr>
<tr>
<td>Field Value Report</td>
<td>71</td>
</tr>
</tbody>
</table>
Using the Search Tags Utility ................................................................. 71
User Hours (approx.) Chart ................................................................. 71
Database Overview Report Chart ....................................................... 71
Logged In Users Reports ................................................................. 71
Logged In Users Reports ................................................................. 71
User Productivity Report ................................................................. 72
Distinct Users per Day Report ........................................................... 72
Field Populated & Null Count Report ............................................... 72
Document Notes Report ................................................................. 73
Tag Count Report .............................................................................. 73
User Tag Count Report ..................................................................... 73
Custom Report ................................................................................... 73
Login History Report .......................................................................... 73
Document File Report ......................................................................... 73
Tag Detail Report ................................................................................ 74
View Library Designer ....................................................................... 74
Identify Duplicates .............................................................................. 74
Link Attachments ............................................................................... 75
Store Attachment Range ..................................................................... 75
Create Editor ....................................................................................... 75
Identify Family Groups ...................................................................... 75
Update IntelliFolder Static Values .................................................... 76
Create IntelliFolders ......................................................................... 76
Copy Tag to Field ............................................................................... 76
Propagate Duplicate Data .................................................................. 76
Configure Database Overview Report ............................................... 77
Create Batches .................................................................................... 77
Manage Batches .................................................................................. 78
Save Batch QC Rules ......................................................................... 78
Configure Batch Status Report ......................................................... 79
Review Status Chart ........................................................................... 79
Batching Chart .................................................................................... 79
Batch Status Report ........................................................................... 79
Reviewer Status Report ...................................................................... 79
Batch History Report .......................................................................... 79
Batching User Filtering ...................................................................... 80
1 About Case Logistix

Case Logistix provides and integrates a wide variety of tools and features needed to perform litigation review and analysis, from document ingestion through data discovery to coding, tagging, and production.

Working with Case Logistix Libraries

A Case Logistix library is a collection of documents and their descriptions. Libraries are typically related to a particular subject or case. For example, you could have one library containing documents for a tobacco litigation case and another library containing documents related to pharmaceutical drug litigation. You would then use Case Logistix to organize, search, and review the documents in each library.

CASE LOGISTIX DEFINITIONS

- **Document**: A document serves as a record for an item in a library. Each library contains one or more documents. A document may or may not be associated with a document image or other files, such as an associated text file. Each document contains descriptive metadata, for example, a description, the date a document was created, notes, and bates numbers.

- **Document Image**: A document image is the actual document associated with a document record, for example, an image or PDF file, Microsoft Word document, PowerPoint presentation, Excel spreadsheet, video file, sound clip, or other files. If a document image is associated with a document in the library, a document icon () displays to the left of the document in the Document List.

- **Document Index**: A document index contains text from the documents in a library, and is required in order to execute Quick or Advanced searches. Case Logistix generates the index by examining the contents of the document files associated with each document. If the document file contains text, for example, a Microsoft Word document or an image or PDF file that has been processed with optical character recognition (OCR) technology, Case Logistix stores the text in the index.

LIBRARY CONTENTS

Case Logistix libraries include the following items:

- **Library Database**: A single SQL database per library that includes one or more document records. Each document record contains descriptive items including the names of associated document files, document date, notes, redactions and Bates numbers.

- **Documents folder**: A directory structure on a computer that contains document files. Typically, the document folder is located on a shared network that all Case Logistix users can access. The Documents folder contains the document files for a library. Case Logistix automatically copies documents to this folder when you add them to a library, renames documents to keep file names unique, and creates new sub-directories to prevent the directory from getting too large.

- **Index folder**: A directory structure on a computer that contains the index files generated by Case Logistix when a new index is created or an existing index is updated. Case Logistix creates a document index by examining the contents of the document files associated with each document in the library. If the document file contains text, such as a Microsoft Word document or an image or PDF file that has been processed with optical character recognition (OCR) technology, Case Logistix stores this text in the index to help you quickly search documents. Typically, the document index is located on a shared network that all Case Logistix users can access.
LOGGING IN TO A CASE LOGISTIX LIBRARY

You can log in to any library to which you've been granted access.

**Note:** To log in to an offline library, you must first connect to a local SQL instance and create the offline library. For more information, see "Working with Offline Libraries" on page 2.

1. Click the Start menu, point to All Programs, point to Westlaw CaseLogistix, and select Westlaw CaseLogistix.
2. Type your Username and Password in the boxes provided.
3. Select a library from the Library list.
4. Click OK to log in to the selected library.

SWITCHING LIBRARIES

To switch to another library, select the library from the Library list.

LOGGING OUT OF A LIBRARY

Click the File menu and select Log Out, or press Alt + X. The next time you launch Case Logistix, your most recently used library is preselected in the Library list.

To switch libraries without logging out of Case Logistix, select a library from the Library list on the Navigation toolbar. For more information, see "Using the Default Toolbars" on page 7.

Working with Offline Libraries

Case Logistix allows you to work on documents when not connected directly to the main library. In order to work offline, you must first create an offline copy of the library. After you finish your work, synchronize any changes with the main library.

Offline libraries can contain all of the documents in the main library or a subset of documents from specific IntelliFolders. If you have a large library, it is recommended that you take specific folders, rather than the entire library, offline. In order to create offline libraries, you must have the appropriate user permissions. Contact your library administrator for more information.

To work in an offline library, you must have at least 1GB of RAM on your computer and have the following software installed:

- Case Logistix
- An instance of Microsoft SQL Server. For more information, see the Case Logistix Installation Guide.

CREATING OFFLINE LIBRARIES

To create an offline library, do the following:

1. Click the Tools menu and select Synchronize.
2. Under File Options, accept the default Select folders to synchronize option.
3. Select a SQL instance from the Server Name or IP Address list.
4. Depending on how Case Logistix was installed, select either Windows NT Integrated Security or SQL Authentication. If using SQL Authentication, enter the Username and Depending on how Case Logistix was installed, select either Windows NT Integrated Security or SQL Authentication. If using SQL Authentication, enter the Username and Password in the boxes provided.
5. Click Connect.
6. Click OK.
7. Select the folders that you want to add to the offline library.
8. Click Synchronize Folders.

After you finish working in the offline library, be sure to synchronize your changes with the main library.

LOGGING IN TO OFFLINE LIBRARIES

The steps for logging in to an Offline Library are similar to the steps for logging in to other Case Logistix libraries. One key difference, however, is that you are not required to enter a password when logging in to an offline library.

1. Click the Start menu, point to All Programs, click Westlaw CaseLogistix, and then click Case Logistix (Offline Mode Only).
2. Select a library from the Library list and click OK. If you plan on searching the offline library, be sure to index it first.
3. Once your work is complete, synchronize your changes with the main library.
SYNCHRONIZING OFFLINE LIBRARIES

After you complete your work in the offline library, you must synchronize your changes with the main library. When you synchronize libraries, Case Logistix updates the database and documents folders of both the main and offline libraries by copying changes from the offline library to the main library and changes from the main library to the offline library. You also have the option of updating the offline library's index with the latest changes from the main library's index; however, you cannot update the main library's index. You must re-index the main library in order to search any new documents that were added to the offline library.

1. Start Case Logistix.
2. Select a library from the Library list and click OK.
3. Click the Tools menu and select Synchronize.
4. Select Synchronize previously selected folders.
5. Select the Overwrite offline database check box if you want to update the offline library with the latest changes from the main library's index.
6. Click OK.

Supported File Types

When you add a document to a library, Case Logistix compares the document's file extension against the file types list stored in tblFileTypes. If the file extension is listed in the file types list, the File Type field is populated with the corresponding application's name value (for example, Word Document or Adobe PDF). If the file extension is not found, the File Type field remains empty.

The following table lists the file types supported by Case Logistix:

<table>
<thead>
<tr>
<th>Supported File Types</th>
</tr>
</thead>
<tbody>
<tr>
<td>Access Database (.mdb, .accdb)</td>
</tr>
<tr>
<td>Audio Video Interleave (.avi)</td>
</tr>
<tr>
<td>Bitmap (.bmp)</td>
</tr>
<tr>
<td>Comma Separated Values (.csv)</td>
</tr>
<tr>
<td>Word Document (.doc, .docx)</td>
</tr>
<tr>
<td>Microsoft Word Template (.dot)</td>
</tr>
<tr>
<td>AutoCAD Drawing (.dwg)</td>
</tr>
<tr>
<td>Email Message (.eml)</td>
</tr>
<tr>
<td>Graphic Interchange Format (.gif)</td>
</tr>
<tr>
<td>HTML File (.htm, .html)</td>
</tr>
<tr>
<td>Joint Photographic Experts Group (.jpg, .jpeg)</td>
</tr>
<tr>
<td>Apple QuickTime Movie (.mov)</td>
</tr>
<tr>
<td>MP3 (.mp3)</td>
</tr>
<tr>
<td>MPEG</td>
</tr>
<tr>
<td>Outlook Email Message (.msg)</td>
</tr>
<tr>
<td>Adobe PDF (.pdf)</td>
</tr>
<tr>
<td>PowerPoint Presentation (.ppt, .pptx)</td>
</tr>
<tr>
<td>Portable Transcript Format (.ptf)</td>
</tr>
<tr>
<td>Rich Text Format (.rtf)</td>
</tr>
<tr>
<td>TIFF Image (.tif, .tiff)</td>
</tr>
<tr>
<td>TIFF Image List (.tiflist)</td>
</tr>
<tr>
<td>Summation Transcript (.trn)</td>
</tr>
<tr>
<td>Text File (.txt)</td>
</tr>
<tr>
<td>Windows Media Video (.wmv)</td>
</tr>
<tr>
<td>WordPerfect Documents (.wpd)</td>
</tr>
<tr>
<td>Excel Spreadsheet (.xls, .xlsx)</td>
</tr>
</tbody>
</table>
Keyboard Shortcuts

You can use keyboard shortcuts to complete the following tasks in Case Logistix:

**FUNCTION KEY SHORTCUTS**

<table>
<thead>
<tr>
<th>Shortcut</th>
<th>Command</th>
</tr>
</thead>
<tbody>
<tr>
<td>F1</td>
<td>Opens Help.</td>
</tr>
<tr>
<td>F3</td>
<td>Opens Advanced Search.</td>
</tr>
<tr>
<td>F5</td>
<td>Refreshes the Case Logistix workspace.</td>
</tr>
<tr>
<td>F6</td>
<td>Moves to the previous document in the Document List.</td>
</tr>
<tr>
<td>F7</td>
<td>Moves to the next document in the Document List.</td>
</tr>
<tr>
<td>F11</td>
<td>Moves to the first document in the Document List.</td>
</tr>
<tr>
<td>F12</td>
<td>Moves to the last document in the Document List.</td>
</tr>
</tbody>
</table>

**CTRL KEY SHORTCUTS**

<table>
<thead>
<tr>
<th>Shortcut</th>
<th>Command</th>
</tr>
</thead>
<tbody>
<tr>
<td>Ctrl + A</td>
<td>Selects all documents in the Document List.</td>
</tr>
<tr>
<td>Ctrl + C</td>
<td>Copies the selected image or text.</td>
</tr>
<tr>
<td>Ctrl + E</td>
<td>Moves cursor to Quick Search box.</td>
</tr>
<tr>
<td>Ctrl + I</td>
<td>Opens Create New Tag window.</td>
</tr>
<tr>
<td>Ctrl + N</td>
<td>Opens Add/Edit Document Note window.</td>
</tr>
<tr>
<td>Ctrl + V</td>
<td>Pastes the selected image or text.</td>
</tr>
<tr>
<td>Ctrl + X</td>
<td>Cuts the selected text.</td>
</tr>
<tr>
<td>Ctrl + F8</td>
<td>Displays all folders associated with a document.</td>
</tr>
<tr>
<td>Ctrl + Insert</td>
<td>Opens Add Multiple Documents window.</td>
</tr>
<tr>
<td>Ctrl + Delete</td>
<td>Moves documents to the Recycle Bin.</td>
</tr>
<tr>
<td>Ctrl + Home</td>
<td>Moves to the first document in the Document List.</td>
</tr>
<tr>
<td>Ctrl + End</td>
<td>Moves to the last document in the Document List.</td>
</tr>
<tr>
<td>Ctrl + Alt + I</td>
<td>Launches Index Manager.</td>
</tr>
</tbody>
</table>

**ALT KEY SHORTCUTS**

<table>
<thead>
<tr>
<th>Shortcut</th>
<th>Command</th>
</tr>
</thead>
<tbody>
<tr>
<td>Alt + X</td>
<td>Exit Case Logistix.</td>
</tr>
<tr>
<td>Alt + double-click document icon</td>
<td>Opens a document in its native application.</td>
</tr>
<tr>
<td>Shortcut</td>
<td>Command</td>
</tr>
<tr>
<td>--------------</td>
<td>--------------------------------------------------------------</td>
</tr>
<tr>
<td>Shift + F1</td>
<td>Displays or hides the IntelliFolders panel.</td>
</tr>
<tr>
<td>Shift + F2</td>
<td>Displays or hides the Tag Folders panel.</td>
</tr>
<tr>
<td>Shift + F3</td>
<td>Displays or hides the Coding panel.</td>
</tr>
<tr>
<td>Shift + F4</td>
<td>Displays or hides the Tagging panel.</td>
</tr>
<tr>
<td>Shift + F5</td>
<td>Displays or hides the Notes panel.</td>
</tr>
<tr>
<td>Shift + F6</td>
<td>Displays or hides the Document Viewer.</td>
</tr>
<tr>
<td>Shift + F7</td>
<td>Displays or hides the Document List.</td>
</tr>
<tr>
<td>Shift + Insert</td>
<td>Opens the Select Files to Add window.</td>
</tr>
<tr>
<td>Shift + Up Arrow</td>
<td>Select the previous document in the Document List (multi-document select).</td>
</tr>
<tr>
<td>Shift + Ctrl + Home</td>
<td>Select all documents above the current selected document (multi-document select).</td>
</tr>
<tr>
<td>Shift + Ctrl + End</td>
<td>Select all documents below the current selected document (multi-document select).</td>
</tr>
</tbody>
</table>
2 Using the Case Logistix Interface

When you launch Case Logistix, the Case Logistix interface allows you to open and work with the tools, features, and capabilities in Case Logistix. Categories of data display on the left and the Document List and Document Viewer display on the right. Click any category on the left to expand that category.

The Case Logistix workspace includes the following components:

- **Toolbars**: The Standard, Research, and Navigation toolbars are the default toolbars included with Case Logistix. You can modify the default toolbars, show or hide toolbars, and create new custom toolbars, if desired. For more information, see "Using the Default Toolbars" on page 7.
- **IntelliFolders panel**: The IntelliFolders panel displays all IntelliFolders in a hierarchal view. For more information, see "Working with IntelliFolders" on page 42.
- **Tag Folders panel**: The Tag Folders panel displays all Auto, Shared, and My Tags (private tags).
- **Coding panel**: The Coding panel contains Editors that you can use to code documents.
- **Tagging panel**: The Tagging panel identifies the Tags for the selected document, and allows you to apply one or more Tags to a document or set of documents.
- **Notes panel**: The Notes panel displays the Notes for the selected document. The Notes panel has its own toolbar, which you can use to create Notes. For more information, see "Working with Notes" on page 36.
- **Document List**: The Document List displays all documents in the library, documents returned in a search, and documents in a selected IntelliFolder or Tag. For more information, see "Working with the Document List" on page 20.
- **Document Viewer**: The Document Viewer allows you to view and annotate documents by adding notes and redactions. Each tab in the Document Viewer (Mark-up, HTML, Associated Text, and Native/Image) has its own toolbar. For more information, see "Working with the Document Viewer" on page 33.

Customizing the Interface

The library administrator is responsible for setting up your user account and determining which features you can access. This initial setup also determines which components display when you log in to a library.

To accommodate the various tasks you might perform, Case Logistix includes three standard workspace views. Each view provides a different configuration and positioning of panes. For more information, see "Restoring Default Views" on page 8.
Once you log in to a library, you can hide, reposition, and resize the workspace panes, Document List, and Document Viewer. To display or hide a workspace panel, click the View menu and select a panel from the list provided. A check mark next to a workspace panel indicates it is currently displayed.

To reposition workspace panes, do the following:

- To float or hide a panel or make it dockable, click the panel, click the Popout button. The panel pops out into a separate window. Right-click the panel heading, then click Floating, Dockable, or Hide. To auto-hide the panel, click the pin button or right-click the panel heading and select Auto-hide.
- Popout a panel then click and drag the panel over the arrow where you want to dock it in the workspace. The arrows indicate the available dock locations.
- Move the Document List or Document Viewer by dragging the panel over the arrow where you want to dock it in the workspace.

When you modify the workspace panes or window size settings, the changes are saved for the local Windows account only. For example, if Case Logistix is installed on a computer with the All Users option, and there are three Windows user accounts, Case Logistix preserves the unique settings for each local Windows user account on that computer.

Creating Custom Toolbars

You can change the dock location and add and remove toolbar commands on the default toolbars. The default toolbars cannot be renamed or deleted. For more information, see "Using the Default Toolbars" on page 7.

ADDING AND REMOVING TOOLBAR BUTTONS

To add or remove buttons from the default toolbars, click the arrow on the right-hand side of the toolbar, select Add or Remove Buttons, and then select the buttons that you want to add or remove. A check mark next to a button indicates it is currently visible on the toolbar.

CREATING CUSTOM TOOLBARS

To create custom toolbars, do the following:

1. Click the View menu, point to Toolbars, and select Customize.
2. Click New.
3. Type a name in the Toolbar Name box and click OK.
4. Select a dock location for the toolbar from the Modify Selection list. Toolbars can be docked above, below, and on the left and right side of the Case Logistix workspace.
5. Click the Commands tab.
6. Select the toolbar from the Toolbar list.
7. You have the following options:
   - To add commands to a toolbar, click Add Command, select commands from the list provided and click OK. To remove a command, select a command from the list provided, click Delete, then click Yes to confirm.
   - To reorder the toolbar commands, select a command and click Move Up or Move Down.
   - To group commands, select a command from the list provided and click Begin Group. A divider line is inserted before the selected command. All commands below the selected command are also added to the group.
8. Click Close.

Using the Default Toolbars

To display or hide the Case Logistix toolbars, click the View menu, point to Toolbars, and select a toolbar from the list provided. A check mark next to a toolbar indicates it is currently displayed. The following toolbars are available:

STANDARD TOOLBAR

The Standard toolbar contains the following options:

A. **Case Logistix Analytics Wizard**: Launches the Case Logistix Analytics Wizard. For more information, see "Using the Case Logistix Analytics Wizard" on page 62.
B. **Case Notebook**: Send documents or pleadings to Case Notebook.
C. **Print**: Print documents and barcode sheets, or deliver the Document List.
D. **Columns**: Add and remove columns or save, apply, or reset the current column settings.
E. **Grouping**: Enables grouping mode.
F. **Filtering:** Enables filtering mode.
G. **Refresh:** Refreshes the Case Logistix workspace.

**RESEARCH TOOLBAR**

The Research toolbar contains the following options:

A. **Search Text:** Quick Search text box.
B. **Search:** Run Recent Quick Searches, configure Quick Search settings, Open Advanced Search, and manage Saved Searches.

**NAVIGATION TOOLBAR**

The Navigation toolbar contains the following options:

A. **History:** View the current session history. When you change the Document List, for example, by clicking an IntelliFolder or running a search, those changes are tracked in the History list. Changes are only tracked during the current session, and are not saved when you log out of Case Logistix. To view the current session history, click the History list on the Navigation toolbar, then select an event from the list to repeat an action.
B. **Select Library:** Displays the name of the current library. Select a library from the list to log in to a different library.

**Working with Views**

Case Logistix includes three default workspace views that you can customize, and save, load, and share with other users. For example, reviewers who code documents may prefer a view that only shows the Coding panel and Document List.

**SAVING CUSTOM VIEWS**

You can save up to ten custom workspace views. Views can be shared with other users, including users that are members of other libraries if the libraries are part of a shared Central Database.

1. Click the **View** menu and select **Save and Share View**.
2. Type a name in the **View Name** box.
3. Select the **Share View** check box to share the view with other users.
4. Click **Save**.

**LOADING VIEWS**

To load a custom view, click the **View** menu, point to **Load View**, and select a view from the list provided. The list can contain up to ten locally saved views and an unlimited number of shared views.

**MANAGING CUSTOM VIEWS**

You can rename, share, unshare, and delete custom views.

1. Click the **View** menu and select **Manage Views**.
2. You have the following options:
   - **Rename View:** Select a view from the list provided and type a name in the **View Name** box.
   - **Share View:** Select the **Shared** check box. Clear the check box to make a view private.
   - **Delete View:** Click **Delete**, then click **Yes** to confirm.
3. Click **OK**.

**RESTORING DEFAULT VIEWS**

Click the **View** menu, point to **Restore Default Views**, and select from the following options:

- **Standard View 1:** Displays the associated panel (IntelliFolders, Tag Folders, Coding, Tagging, and Notes panes) on the left side of the workspace, and the Document List and Document Viewer on the right side of the workspace. Standard View 1 is the default view when you first log in to Case Logistix.
- **Standard View 2:** For dual monitor display. The Document Viewer displays on the second monitor, and the panel and Document List display on the main monitor.
- **Standard View 3:** Resembles the Case Logistix version 5.4 workspace.
**Note:** You can also restore the default views by pressing Ctrl + Shift + F#, where # is the number of the view. For example, to restore Standard View 2, you would press Ctrl + Shift + F2.

**Viewing Session History**

When you change the Document List, for example, by selecting an IntelliFolder or running a search, those changes are tracked in the History list. Changes are only tracked during the current session, and are not saved when you log out of Case Logistix.

To view the current session history, click the History list on the Case Logistix toolbar. Select an event from the list to repeat the action.

**Configuring User Profile Options**

You can modify the default profile options set by your library administrator. Any changes you make remain in effect until you change them again. Click the **Tools** menu and select **Options**. You have the following options:

### GENERAL OPTIONS

**Log In**
- **Launch dashboard after log in:** Automatically display the User Dashboard Tools window when you log in to Case Logistix.

**Document List**
- **Adjust column widths to fit on screen:** Automatically adjust the columns in the Document List so that all columns are visible. This option only applies to the columns currently displayed in the Document List.
- **Adjust row heights to display entire value:** Automatically adjust the rows in the Document List so that all field values are visible.
- **Use alternating row colors:** Display alternating row colors in the Document List.
- **Show vertical grid lines:** Display vertical lines between columns.
- **Show horizontal grid lines:** Display horizontal lines between rows.
- **Gridline color:** The color of the vertical and horizontal grid lines.

**Notifications**
- **Display assistance for document linking:** Open a link assistance prompt when creating document links.

**History Settings**
- **Remember this many quick searches:** The maximum number of quick searches that can be displayed under Recent Quick Searches.
- **Remember this many events in the history list:** The maximum number of events that can be displayed in the History list.

**Search Highlighting**
- **Select the highlight color for Search Hits, Find and Search Within results.**

### DOCUMENT VIEWING OPTIONS

**Preview Settings**
- **Preview Size limit _ (MB):** The maximum file size that can be displayed in the Document Viewer. If you attempt to view a document that exceeds the specified file size, a message stating that "The selected document exceeds the viewing size limit" opens. Type -1 to specify an unlimited file size.

**Conversion Settings**
- When you view Outlook (.msg) or email files (.eml) in the Document Viewer, the native application for those files opens outside of Case Logistix so that you can view the contents of the message. To prevent the native application from opening, Case Logistix allows you to convert these files to HTML and view them on the Document Viewer HTML tab.

### DATA ENTRY OPTIONS

**General**
- **Open new documents in native viewer when adding:** Automatically open new documents in the Document Viewer Native/Image tab.
- **Refresh document list after deleting:** Automatically refresh the Document List when you delete documents.
Prompting Options

- **Prompt to confirm when copying files**: Open a confirm prompt when copying files.
- **Prompt to confirm when moving files**: Open a confirm prompt when moving files.
- **Prompt to confirm deletions**: Open a confirm prompt when deleting files.

ADVANCED OPTIONS

Data Access

- **Virtual Page Size**: The number of documents to load in the Document List while scrolling. The default value is 500. If you specify a number larger than 500, Case Logistix refreshes the Document List less often while you scroll. Conversely, the Document List refreshes more often if you set the Virtual Page Size to a number smaller than 500.
- **Max Doc Load Count**: The number of documents to load in the Document List. The default value is 1000. Note that increasing the Max Doc Load Count is not recommended as it may affect performance when selecting multiple Document List rows. If you select all documents in the Document List, and the number of documents you select is greater than the Max Doc Load Count, Case Logistix enters Select All mode.

Viewing Office Documents

- **Display (Word, Excel, Project, Visio) using Internet Explorer browser plugin**: Open Microsoft Office documents in their native application when the documents are viewed in the Document Viewer Native/Image tab.
3 Working with Documents

You can add documents and document records from a local folder or a network location. When you add documents, you have the option to build mark-up copies of the files and, if adding image files, generate OCR text. If you choose to skip this process, you can build the mark-up files and, if necessary, run OCR at a later date.

You must re-index the library before you can search newly added documents.

**Adding Documents**

To add documents to a library, do the following:

1. Click the **File** menu and select **Add Document**.
2. Browse to the files and click **Open**.
3. If the library administrator has enabled On Demand Markup conversion, the OCR/Build Markup window opens (see the Library Designer Help for more information). Select or clear the **run OCR** and **create mark-up** check boxes and click **Yes**. Click **No** to skip this process.

**Note:** The **run OCR** check box is only enabled when adding image files and PDFs.

To add documents using drag and drop, select and drag files to an IntelliFolder in the IntelliFolders panel (see "Working with IntelliFolders" on page 42 for more information). To add documents without coding them to an IntelliFolder, drag them to the top-level IntelliFolder (library name).

If you are adding an email that contains attachments, the attachments are added as separate documents and are automatically attached to the original email. Although email metadata is typically transferred into Case Logistix data fields automatically, you should confirm with your library administrator that the library has the necessary standard and custom fields for emails.

**Note:** Case Logistix cannot extract metadata from .msg file attachments that are read-only. To remove the read-only attribute, right-click the file, select **Properties**, and then clear the **Read-only** check box. If the file resides on a CD, you must first copy it to a hard drive.

**Adding Document Records**

Document records are documents that are not associated with a native file. Document records serve as placeholders for the following items:

- Native files that you plan on adding to a library at a later date.
- Files that are not in electronic format. In this scenario, the metadata for the document records often contain information about the availability and physical location of the native files. For more information, see "Using the Metadata Locator Utility" on page 55.
- Paper documents that have yet to be scanned by a vendor. With the document records in place, a vendor can scan and generate the resulting electronic images with filenames that match the information encoded in the barcodes. You can then copy those files to the library's document storage location. If done correctly, the file names match the records.

To add document records, click the **File** menu and select **New Document**. Type the number of document records you want to add in the box provided and click **OK**.

**LINKING DOCUMENT RECORDS TO NATIVE FILES**

To link document records to their native files, do the following:

1. Copy the native files to the library's document storage location.
2. In Case Logistix, select a document record from the Document List.
3. Expand the Coding panel and select an editor from the Editor list.
4. Click the ellipsis to the right of the Filename field and select **Add File**. If the Filename field is not available in an existing editor, contact your library administrator.
5. Browse to the file and click **Open**.
6. If the library administrator has enabled On Demand Markup conversion, the OCR/Build Markup window opens (see the Library Designer Help for more information). Select or clear the **run OCR** and **create mark-up** check boxes and click **Yes**. Click **No** to skip this process.
**Deleting Documents**

You can delete documents from a Case Logistix library by sending documents to the Recycle Bin. The Recycle Bin is only visible to users with the appropriate permissions. Contact your library administrator for more information.

To delete documents from a library, select documents from the Document List, and then right-click the documents and select **Delete**. Click **Yes** to confirm.

**EMPTYING THE RECYCLE BIN**

To permanently delete all documents in the Recycle Bin, right-click the **Recycle Bin** and select **Empty Recycle Bin**. Click **Yes** to confirm. The next prompt asks whether you want to delete the images associated with the documents from the document storage location. Click **Yes** to delete the document images. Click **No** to keep the images in the library's document storage location.

**Note:** If you empty the recycle bin, the documents are permanently deleted and can only be recovered by restoring a backup copy of the library.

**RESTORING DOCUMENTS FROM THE RECYCLE BIN**

To restore deleted documents from the Recycle Bin, do the following:

1. Click the **Recycle Bin** in the IntelliFolders panel to populate the Document List with the deleted documents.
2. Select the documents you want to restore, then right-click and select **Restore**.
3. Click **Yes** to confirm.

**Adding PST and ZIP Files**

You can add .pst (Outlook Personal Folder) and .zip (Compressed Archive) files to a Case Logistix library.

**ADDING PST FILES**

When you add .pst files, Case Logistix creates separate documents for each email contained within the .pst file. Attachments are also added as separate documents and are attached to the document representing the parent email.

Metadata from emails is automatically transferred to the appropriate Case Logistix fields. If the library Administrator has created the **PST Source** and **PST Folder** fields, Case Logistix codes the fields for each document. The **PST Source** field is coded with the **PST Name**. The **PST Folder** field is coded with the name of the PST file and the folder associated with the email, for example, **Personal Folders–Inbox**. See the Library Designer Help for more information.

1. Click the **File** menu and select **Add Documents**.
2. Browse to the file and click **Open**.
3. Select the folders you want to import. The number of emails contained in the selected folders displays in the **Items Selected** box.
4. Type a name for the .pst in the **PST Name** box, or accept the default name provided.
5. Click **Import**.

**ADDING ZIP FILES**

When you add .zip files, the .zip file and the documents it contains are added to the Document List as separate documents. Case Logistix automatically attaches the compressed files to the document representing the .zip file. To add a .zip file, click the **File** menu and select **Add Documents**. Browse to the file and click **Open**.

**Attaching Documents**

You can attach documents to other documents in a Case Logistix library. Attaching documents can help you track related documents. When you attach documents, the Attachment Count ( ) and Parent Count ( ) columns display the number of documents that are attached to a document (Attachment Count), or the number of documents to which a document is attached (Parent Count).

To attach documents, select documents from the Document List, and then drag them to the document to which you want to attach them. Click **Yes** to confirm. To remove an attached document, right-click an attached document in the Document List, select **Detach from Parent**, and then click **Yes** to confirm.
Adding Case Logistix Links to Microsoft Office Documents

You can add links to Case Logistix documents in Microsoft Office documents. To link to a Case Logistix document, create a Case Logistix hyperlink file (.clxd), and then insert the link in a Microsoft Office document, for example, a Word document or Excel spreadsheet. To open the link, you must have access to the library document storage location.

1. Right-click a document in the Document List, point to Send To and then select Any Folder.
2. Select Hyperlinks and click OK.
3. Browse to the destination folder, or click Make New Folder to create a new folder.
4. Click OK. Case Logistix creates the hyperlink file (.clxd).
5. Open a Microsoft Office document, for example, a Word document and insert the hyperlink file you created in Step 4.
6. Double-click the link to open the document in Case Logistix.

Viewing Document History

You can view the complete history of a document, back-track to previous field values, and clear the document history.

1. Select a document from the Document List.
2. Do one of the following:
   - Right-click the document and select Show Document History.
   - Click the View menu and select Show Document History.
   - Click the Document History button ( ) on the Document Viewer toolbar.
3. You have the following options:
   - Back-Track: Select a row in the document history table and click the Back-Track button ( ) to revert to a previous field value, then click Yes to confirm.
   - Clear History: Click the Clear History button ( ) to delete the document history, then click Yes to confirm. This is a permanent action and cannot be undone.
   - Print: Click the arrow next to the Print Delivery button ( ) and select Print History. You can also save, email, and export the document history to Excel. For more information, see "Delivering the Document List" on page 21.

Working with PDFs, TIFF Files, and TIFFLISTS

Case Logistix allows you to combine and split PDFs, TIFFs, and TIFFLISTS. You can also create new TIFFLISTS from two or more image files.

COMBINING TIFF AND PDF FILES

You can combine PDFs, TIFF files, and TIFFLISTS into a single PDF file. Only documents of the same file type can be combined, for example, a PDF with another PDF. You cannot combine a PDF with a TIFF file.

When you combine documents, the markup and associated text files are also combined. If the documents contain Document notes that are exact duplicates, only one note is added to the combined document. If the notes are different, all of the notes are added to the combined document.

1. Select documents from the Document List.
2. Right-click the documents and select Combine Records.
3. Click Move Up and Move Down
4. Set the order in which you want the merged documents to display by
5. Select a document in the Select Document Order box and click Move Up or Move Down to specify the order in which the merged documents display.
6. The Keep Original Documents check box is selected by default. Clear the check box to delete the original documents.
7. Click OK.

SPLITTING TIFF AND PDF FILES

You can split PDFs, multi-page TIFF files, and TIFFLISTS into multiple PDF files. When you split a document, any existing associated text files, redactions, Anchor notes, and Transcript notes are automatically transferred to the new document if the page containing the redaction or note is moved to the new document.
You cannot split TIFFLISTS that were created from image files that did not have corresponding associated text files. For information on creating associated text files, see "Using the Optical Character Recognition (OCR) Utility" on page 56.

1. Right-click a document in the Document List and select **Split Document**.
2. You have the following options:
   - **Interactive Selection Tab**: Select the pages that you want to move to the new document, and then click the right arrow. Click **Move Up** or **Move Down** to specify the order in which you want the pages to display. Click **Sort By Page** to order the pages by page number.
   - **Simple Split Tab**: Type a page number in the **Split at Page** box.
3. The Document Notes list is enabled if the selected document contains one or more Document notes. You have the following options:
   - **Move to new document**: Move the Document notes to the new document.
   - **Stay with original**: Keep the Document notes with the original document.
   - **Both**: Keep the Document notes with both the new and original document.
4. The Links to document being split list is enabled if the document contains one or more links to document text in another document (see "Linking Documents" on page 38 for more information). You have the following options:
   - **Move to new document**: Move the links to the new document.
   - **Stay with original**: Keep the links with the original document.
   
   **Note**: If a document contains text that is linked to another document, the link automatically transfers to the new document if the page containing the linked text is moved to the new document.
5. Click **Execute Split**.

**CREATING TIFFLISTS**

You can create TIFFLISTS using .bmp, .gif, .jpeg, .tiff, and .png image files. When you create a TIFFLIST, Case Logistix assigns the file the Case Logistix-specific file extension .tifflist. In order to create a TIFFLIST, you must have access to an editor that has the Filename field. Contact your library administrator for more information.

**Note**: Case Production only supports TIFFLISTS that are made up of TIFF image files.

1. Add a document record to the library.
2. Select the document record from the Document List.
3. Expand the Coding panel in the Accordion Pane.
4. Select the editor that contains the Filename field from the Editor list.
5. Click the ellipsis next to the Filename field and select **Add Tiff List**.
6. Browse to the image files and click **Open**. If the selected image files have an associated text file, a message asking whether you want to overwrite the associated text files opens. Click **Yes** to confirm.
You can use the **Index Manager** to create and maintain the library index. The index is required in order to run Quick and Advanced searches. When you run a search, Case Logistix examines the index, rather than the documents themselves, to locate search terms. For example, if you code a document as responsive and the document text includes the term negligent, then, after indexing, you can search for the term negligent in the document text and responsive in the document metadata. The index is normally created and maintained by a library administrator.

**CREATING THE LIBRARY INDEX**

**Note:** If you are creating an index for a new library, you must set the Indexing Service for the library and specify how often you want the index to be updated and compacted. For more information, see "Configuring Index Settings" on page 15.

To create a new library index, click the **Tools** menu and select **Index Manager**. Select the **Create New Index** check box and click **Index Now**.

**UPDATING THE LIBRARY INDEX**

You should update the library index periodically to ensure optimal search results. For example, update the index after adding new documents to ensure the new documents are searchable. The Indexing Service updates the index automatically based on the frequency you specified when you first created the index. You can increase or decrease how often the index updates. You can also manually update the index at any time by doing the following:

**Note:** To replace an existing index, select the **Create New Index** check box. Creating a new index deletes the existing index.

1. Click the **Tools** menu and select **Index Manager**.
2. Clear the **Create New Index** check box, if necessary.
3. Click **Index Now**.

**COMPACTING THE LIBRARY INDEX**

Index compaction (also known as index compression) restructures the index and removes hidden entries. Hidden entries occur when a document is re-indexed or deleted, as the original document is not removed from the index. Instead, it is hidden to prevent it from appearing in search results. As the number of hidden entries increases, the index can become unnecessarily large and can cause slower performance.

Index compaction runs automatically based on the frequency you specified when you first created the index. You can increase or decrease the number of times the index is compacted each week.

**Note:** To prevent index compaction from automatically running, you must disable indexing by clicking **Disable Indexing** on the Index Manager. Note that disabling indexing prevents the index from updating.

1. Click the **Tools** menu and select **Index Manager**.
2. Click **Options**.
3. Click the **Service** tab.
4. Select the day of the week you want to compact the index.
5. Specify the time using the arrows next to the **at** box, then click **AM** or **PM**.
6. Click **OK**.

**Configuring Index Settings**

You can configure the index settings for a library using the Indexing Options. As you configure the index settings, you may notice that certain settings are already enabled. In general, these settings are appropriate for a typical English-language library.

To access the Indexing Options, click the **Tools** menu, select **Index Manager**, and then click **Options**. The following Indexing Options are available:

- **General Tab**: Specify how dtSearch indexes documents. dtSearch is the third-party tool used for indexing. For more information, see "General Tab" on page 16.
- **Alphabet Tab**: Modify the alphabet file. The alphabet file determines how dtSearch interprets certain characters in your documents (for example, characters in the ASCII table in decimal range 32-127). For more information, see "Alphabet Tab" on page 17.
- **Noise Words Tab**: Modify the noise words list. Noise words are words that are generally too common to be useful in searching, for example, a, and, it, and or. Noise words are not indexed and are ignored in searches. For more information, see "Noise Words Tab" on page 17.
• **Filtering Options Tab**: Specify how dtSearch handles binary files and Unicode text during filtering operations. For more information, see "Filtering Options Tab" on page 17.

• **File Types Tab**: View the default file types rules. This tab is read-only. For more information, see "File Types Tab" on page 18.

• **Service Tab**: Set the Indexing Service for the library, and specify how often the Indexing Service updates and compacts the index. For more information, see "Service Tab" on page 18.

• **Metadata Extractor Tab**: Specify how metadata is extracted from documents. For more information, see "Metadata Extractor Tab" on page 19.

**GENERAL TAB**

**Note**: To apply modified settings to an existing index, you must re-create the library index.

You can specify how dtSearch indexes documents on the General tab. Click the **Tools** menu, select **Index Manager**, and then click **Options**. You have the following options:

• **Restore Content**: Restore the most recently saved settings. The index settings are automatically saved when you click **OK**.

• **Restore Defaults**: Restore the default indexing settings. Note you must use the Default button on the Alphabet tab and Noise Words tab to restore the default alphabet and noise words files.

• **Index Mark-up Documents**: Index the mark-up PDF and the text from the native document. If you clear this option, dtSearch ignores the mark-up versions of files. Clearing this option does not prompt you to re-index, but you should consider clearing it if you want to eliminate double hits (for example, a hit in an original document and a hit in the mark-up version of the document) when you search your library.

• **Index filenames as text (not recommended)**: Append the filename of each document to the end of the text during indexing, so that text in the filename is searchable like other document text.

• **Index HTML Scripts, styles, links and comments**: Make non-visible text searchable (for example, HTML scripts, styles, links and comments). Normally, HTML scripts, styles, links and comments are not indexed and dtSearch indexes only visible text and META tags in HTML files.

• **Index Numbers**: Include numbers in the library index. If your documents contain a lot of numbers and you do not want to search for them, clear this option. Excluding numbers makes your indexes smaller and speeds indexing.

• **Enable numeric range searching**: Clear this check box if you not need to index numbers as both text and numeric values, which is required for numeric range searching. Numbers are still searchable as text if the Index Numbers option is selected. This setting can reduce the size of your indexes by about 20%.

**Note**: A numeric range search retrieves numbers that fall within a range. To add a numeric range to a search, type the lower and higher numbers of the numeric range separated by ~~~ (for example, apple /5 12~~17). The search retrieves documents containing the term apple within 5 terms of a number between 12 and 17.

• **Index hidden content in Office documents**: Make embedded data, for example, macros, viruses, or other embedded documents, visible in dtSearch.

• **Index NTFS Summary Information streams**: Index NTFS Summary Information data for each indexed document. NTFS Summary Information properties are created when you right-click a document in Windows Explorer and enter values in the Summary Information fields (Author, Subject, etc.).

• **Index field names in XML files**: Index field names in XML files.

• **Index field attributes in XML files**: Index field attributes in XML files.

**Note**: If both the Index field names in XML files and Index field attributes in XML files options are cleared, dtSearch only indexes field values in XML.

• **Ignore common HTML field names**: Ignore common HTML field names. Clear this option if you want to index common HTML field names; this may slow the indexing process.

• **Automatically recognize dates, email addresses and credit card numbers**: Scan for text that looks like a date, email address, or credit card number. If you enable this option, you can search for text that matches credit card numbers, email addresses, or ranges of dates. Selecting this option slows indexing.

• **Create a Case-Sensitive Index (not recommended)**: Make document text searches case sensitive. If enabled, searching for the word “cotton” does not return “Cotton”.

• **Create a Accent-Sensitive Index**: Include the accent mark in text searches. If enabled, searching for the word “fiancé” does not return “fiancé”.

• **Cache Document Text**: Place document text in the index. Although this speeds up the process for retrieving Context Reports, it is generally not recommended.

• **Create Log File**: Create a log file of index errors.

Click **OK** to save your changes.

If the library has an existing index, a message stating the modified settings cannot be applied unless the index is recreated displays. Click **Yes** to return to the Index Manager. Click **No** to remain on the General tab. If you click **Yes**, the Create New Index
check box is selected on the Index Manager. The Index Manager, however, does not recreate the index until the next time it updates. Click Index Now to recreate the index right away.

ALPHABET TAB

Note: To apply modified settings to an existing index, you must re-create the library index.

The Alphabet file determines how dtSearch interprets certain characters in your documents (for example, characters in the ASCII table in decimal range 32-127). Other character properties are set to conform to the Unicode standard and cannot be modified. The default alphabet file included with dtSearch is DEFAULT.ABC.

To modify the alphabet file, click the Tools menu and select Index Manager. Click Options, then click the Alphabet tab. You have the following options:

- Add a Character Entry: Click anywhere in the list, press Enter, and then type the character you want to add.
- Edit a Character Entry: Select an entry from the list and make the appropriate edits.
- Delete a Character Entry: Select an entry from the list and press Delete.
- Import an Alphabet File: Click Import, browse to the file, and then click Open.
- Remove All Entries: Click Clear, then click Yes to confirm.
- Restore the default Alphabet File: Click Default.
- Maximum word length: The maximum character length in the alphabet.

Click OK to save your changes.

If the library has an existing index, a message stating the modified settings cannot be applied unless the index is recreated displays. Click Yes to return to the Index Manager. Click No to remain on the Alphabet tab. If you click Yes, the Create New Index check box is selected on the Index Manager. The Index Manager, however, does not recreate the index until the next time it updates. Click Index Now to recreate the index right away.

NOISE WORDS TAB

Note: To apply modified settings to an existing index, you must re-create the library index.

You can modify the noise words list on the Noise Words tab. Noise words are words that are generally too common to be useful in searches (for example, a, and, it, and, or). Noise words are not indexed and are ignored in Quick and Advanced searches. Click the Tools menu and select Index Manager. Click Options, then click the Noise Words tab. You have the following options:

- Add a Noise Word: Click anywhere in the list, press Enter, and then type the word you want to add. Note the words in the list do not have to be in a specific order, and may include wildcard characters such as the asterisk (*) and question mark (?). Noise words, however, may not begin with wildcard characters.
- Edit a Noise Word: Select a word from the list and make the appropriate edits.
- Delete a Noise Word: Select a word from the list and press Delete to confirm.
- Import a Noise Words File: Click Import, browse to the file and click Open.
- Remove all Noise Words: Click Clear, then click Yes to confirm.
- Restore Default Noise Words List: Click Default.

Hyphens

- Treat hyphens as spaces (index "first-class" as "first" and "class"): Selected by default. Ignores hyphens and indexes each part of a hyphenated word as a separate word.
- Treat hyphens as searchable (index "first-class" as "first-class"): Include hyphens in the indexed text.
- Ignore hyphens (index "first-class" as "first-class"): Removes hyphens from the indexed text.
- All three: Use all three options when handling hyphens.

Click OK to save your changes.

If the library has an existing index, a message stating the modified settings cannot be applied unless the index is recreated displays. Click Yes to return to the Index Manager. Click No to remain on the Noise Words tab. If you click Yes, the Create New Index check box is selected on the Index Manager. The Index Manager, however, does not recreate the index until the next time it updates. Click Index Now to recreate the index right away.

FILTERING OPTIONS TAB

Note: To apply modified settings to an existing index, you must re-create the library index.

You can specify how dtSearch handles binary files and Unicode text during filtering operations on the Filtering Options tab. Click the Tools menu and select Index Manager. Click Options, then click the Filtering Options tab. You have the following options:
Binary Files

A binary file has a format that cannot be recognized and does not appear to be a plain text file. The Exclude Filter list displays the file types that dtSearch excludes from the index.

- **Do not index**: Skip binary files.
- **Index as plain text**: Index binary files as plain text.
- **Filter text**: Filter out only the text of binary files.

Unicode Options

- **Block size for segmenting data in large binary files (in kilobytes)**: Specify the size block that input files are divided into before being filtered by typing the appropriate value in the box provided. For example, if you specify a block size of 100 kilobytes, a 1000 kilobyte file would be indexed as 10 separate blocks.
- **Minimum size of text segments to include from filtered data**: Specify how many text characters must occur consecutively for a block of text to be included by typing the appropriate value in the box provided. For example, at the default value of 6, a series of five text characters surrounded by non-text data would be filtered out.
- **Overlap blocks**: Prevents text that crosses a block boundary from being missed in the filtering process. With this option enabled, each block extends 256 characters past the start of the previous block.
- **Extract blocks as HTML**: Adds additional information in HTML comments to each extracted block. This option has no effect on the text that is extracted. The HTML comments identify the starting byte offset and encoding of each piece of text extracted from a file. To view the comments, right-click anywhere in the text of a block returned in a search and select View source.
- **Allow filter to insert word breaks for long character sequences**: Automatically insert word breaks where appropriate (for example, where there is a lower-case letter followed by a capital letter), and to break up very long consecutive streams of letters.
- **Overlap words generated by the automatic word breaks for long character sequences**: Overlap text that crosses block boundaries to prevent it from being missed in the filtering process. With overlapping enabled, each block extends the number of characters indicated past the start of the previous block.
- **Allow filter to insert a word break when a capital letter appears following lower-case letters**: Automatically inserts word breaks in places where a lower-case letter is followed by a capital letter, and breaks up very long consecutive streams of letters.
- **Allow filter to insert a word break when a digit follows letters**: Automatically inserts word breaks in places where a digit follows a letter, and breaks up very long consecutive streams of letters.
- **Use filtering to index corrupt or encrypted documents**: Attempts to recover text from corrupt or encrypted documents. By default, dtSearch skips corrupt or encrypted documents and generates a list of these files in the index update log.
- **Use filtering to index all documents**: Select this option to use the filtering algorithm to index all documents, regardless of whether they have a recognizable file format. This option is not recommended for most users. If enabled, dtSearch scans all files for segments of recognizable text using the filtering algorithm only. This type of scan can locate data that was intentionally hidden or accidentally left in documents, for example, text in unused streams in Microsoft Word or Excel files. However, this type of scan misses data that is only accessible through a file format-aware scan of a document, such as compressed data in a PDF file. Therefore, this option should only be used in combination with a standard file format-aware index.

Click OK to save your changes.

If the library has an existing index, a message stating the modified settings cannot be applied unless the index is recreated displays. Click Yes to return to the Index Manager. Click No to remain on the Filtering Options tab. If you click Yes, the Create New Index check box is selected on the Index Manager. The Indexing Manager, however, does not recreate the index until the next time it updates. Click Index Now to recreate the index right away.

**FILE TYPES TAB**

dtSearch recognizes most file types automatically (for example, Microsoft Word documents). If you index file types that dtSearch does not recognize, it refers to the File Types rules to determine how the file should be processed.

The File Types tab displays existing rules and is read-only. The rules have been modified for the most efficient indexing in Case Logistix. To add or remove a rule, contact Technical Support. To view the existing rules, click the Tools menu and select Index Manager. Click Options, then click the File Types tab.

**SERVICE TAB**

**Note**: To apply modified settings to an existing index, you must re-create the library index.

You can configure the Indexing Service and specify how often you want to update and compact the library index on the Service tab. Click the Tools menu and select Index Manager. Click Options and click the Service tab. You have the following options:
• **Service**: Select the indexing service for the library from the Service list. To assign a different Indexing Service to a library, you must first disable indexing by clicking the **Disable Indexing** button on the Index Manager.

• **Index Every**: Specify how often you the index to update by entering the appropriate value using the arrows next to the Index Every box, then click either seconds, minutes, or hours. To prevent the index from automatically updating, you must disable indexing by clicking **Disable Indexing** on the Index Manager. Note that disabling indexing prevents index compaction from running.

• **Remove Deleted Documents**: Select the **Remove Deleted Documents** check box to remove deleted documents from the index when the index updates. When you delete a document, the original document is not removed from the index. Instead, it is hidden to prevent it from appearing in search results. As the number of these hidden entries increases, the index can become unnecessarily large. Index compaction also removes deleted documents from the index.

• **Compact Index**: Select the day of the week you want index compaction to run, enter the appropriate value using the arrows next to the box, then click **AM** or **PM**. To prevent index compaction from automatically running, you must disable indexing by clicking **Disable Indexing** on the Index Manager. Note that disabling indexing prevents the index from updating.

Click **OK** to save your changes.

If the library has an existing index, a message stating the modified settings cannot be applied unless the index is recreated displays. Click **Yes** to return to the Index Manager. Click **No** to remain on the Service tab. If you click **Yes**, the **Create New Index** check box is selected on the Index Manager. The Indexing Manager, however, does not recreate the index until the next time it updates. Click **Index Now** to recreate the index right away.

**METADATA EXTRACTOR TAB**

**Note**: To apply modified settings to an existing index, you must re-create the library index.

You can specify how metadata is extracted from documents on the **Metadata Extractor** tab. Click the **Tools** menu and select **Index Manager**. Click **Options** and click the **Metadata Extractor** tab. You have the following options:

Create New Fields

• **Overwrite Existing Values**: Overwrite existing field values.

• **Log Field Changes in History**: Track metadata changes in history.

Basic Metadata Settings

• **Include File System Info**: Include operating system information, for example, file size and date; last accessed; and last modified.

• **Include Document Properties**: Include document properties information, for example, title, subject and author.

Other Options

• **Calculate MD5 Hash**: Assign unique MD5 Hash values to documents. MD5 is a security algorithm that is a standard in document security. If Case Logistix finds duplicate documents, it assigns identical MD5 Hash values to the documents. You can then use this value to locate the duplicate documents. Select the field you want to store the MD5 Hash values in from the Store In list.

Click **OK** to save your changes.

If the library has an existing index, a message stating the modified settings cannot be applied unless the index is recreated displays. Click **Yes** to return to the Index Manager. Click **No** to remain on the Metadata Extractor tab. If you click **Yes**, the **Create New Index** check box is selected on the Index Manager. The Indexing Manager, however, does not recreate the index until the next time it updates. Click **Index Now** to recreate the index right away.

**Importing Index Settings**

Depending on your indexing requirements, you may find that a particular group of settings are appropriate for more than one library. You can save the index settings as an XML file, and then import the settings into another library. To save the index settings, click the **Tools** menu and select **Index Manager**. Click **Options**, then click **Save to File**. Browse to a destination folder, type a **File Name** in the box provided, and then click **Save**. To import index settings, click the **Tools** menu and select **Index Manager**. Click **Options**, then click **Load From File**. Browse to the file and click **Open**.

**Installing Indexing Services on Separate Servers**

Large cases may require additional installations of the Indexing Service, thereby allowing IT personnel to distribute server workloads to enhance application performance. Use the Indexing Service installer to install standalone Indexing Services on as many servers as necessary. During the Indexing Service installation, you associate the Indexing Service with a Case Logistix Central Database. You then assign libraries to specific Indexing Services on the Index Manager Service tab (see “Service Tab” on page 18 for more information).
5 Working with the Document List

The Document List provides a list of the documents in a library. When you select an IntelliFolder or tag, the documents contained in the folder or tag display in the Document List. The Document List also displays fields as columns, for example, Custodian. Documents that you have not yet viewed are highlighted in bold.

The Document List displays the following icons when a document is associated with a tag, note, or document image or filename:

<table>
<thead>
<tr>
<th>Icon</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>![Icon]</td>
<td>Indicates the document is associated with one or more tags.</td>
</tr>
<tr>
<td>![Icon]</td>
<td>Indicates the document is associated with one or more notes.</td>
</tr>
<tr>
<td>![Icon]</td>
<td>Indicates the document has an associated image or filename.</td>
</tr>
</tbody>
</table>

Adding Columns

1. Do one of the following:
   - Click the arrow next to the Columns button ( ) and select Select Columns.
   - Click the View menu and select Select Columns.
   - Right-click a column header and select Select Columns.
2. Select the check boxes for the columns you want to add.
3. Click OK.

To remove a column, right-click a column header and select Remove Column.

Navigating the Document List

You can use the navigation buttons located below the Document List to move between documents:

<table>
<thead>
<tr>
<th>Button</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>![Previous]</td>
<td>Move to the first document in the Document List.</td>
</tr>
<tr>
<td>![Previous]</td>
<td>Move to the previous document in the Document List.</td>
</tr>
<tr>
<td>![Page Number]</td>
<td>Shows the current document and total number of documents in the Document List. Type a number in the box and press Enter to move to a different document. The number in the box is not the same as the document number (Doc#).</td>
</tr>
<tr>
<td>![Last]</td>
<td>Move to the last document in the Document List.</td>
</tr>
</tbody>
</table>

Sorting Columns

To sort the values in a column, click the column header. Click the column header again to reverse the sort order. To sort by multiple columns, hold Shift while clicking additional column headers. You cannot sort on multi-value fields.

Arranging and Resizing Columns

To arrange the Document List columns in the order you want them to display, drag a column header to the appropriate location in the Document List. To resize a column, point to the right side of a column header and then drag the column to the desired width when the cursor changes to a double-headed arrow.
Saving Custom Column Settings

When you modify the columns in the Document List, your changes only apply to the selected IntelliFolder or tag. Case Logistix allows you to save the column settings and apply them to other IntelliFolders or tags.

To save the current column settings, click the View menu and select Save User-defined Column Settings. To apply saved column settings to an IntelliFolder or tag, click the View menu and select Apply User-defined Column Settings. Click Reset Folder Column Settings to restore the default columns.

Delivering the Document List

You can print, save, and email a list of the documents in the Document List. You can also export the Document List to an Excel spreadsheet. The list includes the field values from the columns in the Document List.

Printing the Document List

1. Populate the Document List with the documents that you want to deliver, for example, by selecting a tag or IntelliFolder.
2. Click the File menu, point to Deliver Document List, and then select Print List.
3. Type a Title, Header, and Footer in the boxes provided, or accept the default values.
4. Click OK.

Saving the Document List

1. Populate the Document List with the documents that you want to deliver, for example, by selecting a tag or IntelliFolder.
2. Click the File menu, point to Deliver Document List, and then select Save List.
3. Browse to the destination folder and type a name in the File name box.
4. Select a file type from the Save as type list. You can save the file as a text file (.txt), Excel spreadsheet (.xlsx, .xls), or HTML file (.html).
5. Click Save, then click Yes to open the file.

Emailing the Document List

You must have Microsoft Outlook installed on your computer in order to email the Document List. Click the File menu, point to Deliver Document List, and then select Email List. A new email message opens in Outlook with the Document List attached as an Excel spreadsheet. Type a message in the box provided and click Send.

Exporting to Excel

You must have Microsoft Excel installed on your computer in order to export the Document List to Excel.

1. Click the File menu, point to Deliver Document List, and then select Send to Excel.
2. Browse to the destination folder and type a name in the File name box.
3. Click Save, then click Yes to open the file in Excel.

Filtering the Document List

You can filter the documents in the Document List to view documents that contain the same values in one or more fields. When you filter the Document List, you have the option to select the check boxes for the field values you want to filter on, or use the lists and text boxes to create a filter query, for example, a query that returns documents that contain at least one of two field values.

The filter check boxes always take precedence before the filter query. If you try using both options, Case Logistix filters on the selected check boxes and not on the filter query. You cannot filter multi-value fields.

1. Click the Show/Hide Filter Selectors button ( ) on the Case Logistix toolbar.
2. Click the filter icon ( ) in the Document List column header that you want to filter on.
3. You have the following options:
   - Select the check boxes for the field values you want to filter on.
   - Create a filter query by selecting modifiers and typing values in the lists and boxes provided.
4. Click Filter.
5. Repeat Steps 2-4 to add additional filter criteria.

To clear a filter, click the filter icon in the column header and click Clear Filter. To clear all filters, click the Show/Hide Filter Selectors ( ) button.

Grouping Documents By Field

You can use the Group By This Field feature to organize the documents in the Document List by field. For example, you can group the Document List by Custodian to view all documents that are coded with a specific custodian value.
To group documents by field, right-click a column header in the Document List and select Group By This Field. The column header displays in the Column Grouping Box at the top of the Document List. Listed below the box are the field values for the selected column. Click the arrow next to a value to view the documents that are coded with that value. To add additional fields, right-click column headers in the Document List and select Group By This Field.

To remove columns, point to a column header in the Column Grouping Box and click the X that displays next to the column name. To remove the Column Grouping Box, click the View menu and select Show Column Grouping Box.

Grouping Documents

You can use the Grouping feature to view related documents in the Document List. Case Logistix includes the following grouping modes:

- **Group by Cluster**: A cluster consists of documents that are conceptually similar. For more information, see “Grouping by Cluster” on page 22.
- **Group by Document Family**: A document family consists of all parent, child, and sibling documents, for example, email and its attachments. For more information, see “Grouping by Document Family” on page 23.
- **Group by Email Thread**: An email thread includes all messages that belong to the same thread or conversation. For more information, see "Grouping by Email Thread" on page 24.
- **Group Exact Duplicates**: Exact duplicates are documents that contain the same text and in the same order of display. For more information, see "Grouping by Exact Duplicates" on page 26.
- **Group Near Duplicates**: Near duplicates are documents that contain most of the same text in the same order of display. For more information, see "Grouping by Near Duplicates" on page 26.

GROUPING BY CLUSTER

You must run Case Logistix Analytics before you can group by cluster (see "Working with Case Logistix Analytics" on page 61 for more information). A cluster consists of documents that are conceptually similar, for example, documents that contain the same keywords, terms, and concepts. When you group by cluster, the following columns are added to the Document List:

- **CLX Cluster Title**: Displays the terms, keywords, and concepts associated with each cluster group.
- **CLX Cluster Score**: Displays the cluster score for each document.

To group by cluster, click the arrow next to the Grouping button on the Case Logistix toolbar and select Group by Cluster. The Document List displays the cluster groups with alternating row colors and sorts them based on the selected column.
In the above example, the Document List is sorted on the Doc# column. The Doc# for the top-level document in the first cluster group is 354. The Doc# for the top-level document in the second cluster group is 357. Note that the other documents in each group are ordered based on the cluster score and not the Doc#.

To view the cluster group to which an individual document is assigned, right-click a document and select **Display Clusters**. The Document List displays the documents that are members of the same cluster group. You can also view the documents in a cluster group by selecting a Cluster IntelliFolder (see "Understanding Cluster IntelliFolders" on page 23 for more information). To disable grouping, click the **Grouping** button ( ) on the Case Logistix toolbar.

**Understanding the Cluster Score**

The cluster score indicates how close a document is to the cluster center for the cluster group to which the document is assigned. A higher score, for example, .9, indicates a document is close to the cluster center. A lower score, for example, .7, indicates a document is further away from the cluster center.

**Understanding Cluster IntelliFolders**

You can view the documents in a cluster group by selecting a Cluster IntelliFolder. The Cluster IntelliFolder titles are determined by the concepts in the data set. You can display up to ten terms in a title and up to four levels of sub-folders. These options are specified when you run Analytics (see "Using the Case Logistix Analytics Wizard" on page 62 for more information).

**GROUPING BY DOCUMENT FAMILY**

A document family is a group of related documents that includes all parent, child, and sibling documents, for example, an email and its attachments. The email is the parent document and the email attachments are its children. Siblings are child documents that have the same parent document.
Family relationships are depicted by numbers in the Attachment Count ( ) and Parent Count ( ) columns. The Attachment Count column displays the number of documents that are attached to a document. The Parent Count column displays the number of documents to which a document is attached.

To group by document family, click the arrow next to the Grouping button ( ) on the Case Logistix toolbar, point to Group by Document Family, and then select from the following options:

- **Standard List Sort**: Sort each document by the selected Document List column. This option does not keep families together in the Document List. To view the document family for a document, right-click the document, point to Group by Document Family, and then select Standard List Sort. The Document List displays the documents that are members of the same family.
- **Parent/Child Primary Sort (slower)**: Group document families together in the Document List with the child documents sorted by the selected column.
- **Parent Primary Sort (faster)**: Group document families together in the Document List with the child documents sorted by document number (Doc#).

To disable grouping, click the Grouping button ( ) on the Case Logistix toolbar.

**GROUPING BY EMAIL THREAD**

You must run Case Logistix Analytics before you can group by email thread (see "Working with Case Logistix Analytics" on page 61 for more information). An email thread includes all messages that belong to the same conversation, including attachments. When you group by email thread, the following columns are added to the Document List:

- **CLX Thread ID**: Displays a unique value for each email thread.
- **CLX Thread Inclusive**: Displays a value of True for inclusive emails (see "Understanding Inclusive Emails" on page 25 for more information).
- **CLX Thread Sort**: Displays values that identify the original email in a thread and the emails that are included in or missing from the library (see "Understanding Email Thread Sort Values" on page 25 for more information).

To group by email thread, click the arrow next to the Grouping button on the Case Logistix toolbar and select Group by Email Thread. The Document List displays the email threads with alternating row colors and sorts them based on the selected column.
In the above example, the Document List is sorted on the Doc# column. The Doc# for the top-level email in the first email thread is 409. The Doc# for the top-level email in the second email thread is 410. Note that the other documents in each group are ordered based on the CLX thread sort score and not the Doc#.

To view the email thread to which an individual document is assigned, right-click a document and select Display Email Thread. The Document List displays the documents that are members of the same email thread. To disable grouping, click the Grouping button (°) on the Case Logistix toolbar.

Understanding Inclusive Emails
An inclusive email contains content that is not included in any other email. In contrast, a non-inclusive email is one where the text and attachments are fully contained in another email. A value of True in the CLX Thread Inclusive column indicates that a document is inclusive. Examples of inclusive emails include:

- An email with no replies or forwards.
- The last email in a thread.
- An email with attachments.

In the last example, when an email contains an attachment, and the recipient replies, it is common that the attachment is not included with the response. As a result, Analytics identifies the email containing the attachments as being inclusive.

Understanding Email Thread Sort Values
The values in the CLX Thread Sort column identify the original email in a thread and the emails that are included in or missing from the library. Email thread sort values are limited to a maximum of 512 characters. If the thread sort value exceeds the character limit, only the first 512 characters display. The following example shows an email that was sent to several recipients:
A. **F000000f+**: Identifies the original email; all subsequent emails in this thread include this value.
B. **0000**: Identifies the response from one recipient.
C. **Plus symbol (+)**: Indicates the second email in this thread is included in this library.
D. **Duplicate of the previous email.**
E. **Minus symbol (-)**: Indicates the third email in this thread is not included in this library.
F. **0001**: Identifies a response from a second recipient.
G. **True**: Identifies an inclusive email.

**Adding the Email Threads Column**

You can view whether a document is included in an email thread by adding the Email Threads column to the Document List. Right-click a column header in the Document List and select **Select Columns**, select the **Email Threads** check box, and then click **OK**. The column displays the email thread icon ( 🔵) for documents that are members of an email thread.

**GROUPING BY EXACT DUPLICATES**

Exact duplicates are documents that have the same text in the same order of display. When you group by exact duplicates, the **CLX NearDupe Hash** column is added to the Document List. The column displays a unique value for each exact duplicate group.

To group by exact duplicates, click the arrow next to the **Grouping** button on the Case Logistix toolbar and select **Group Exact Duplicates**. The Document List displays the exact duplicate groups with alternating row colors and sorts them based on the selected column.

In the above example, the Document List is sorted on the Doc# column. The Doc# for the top-level document in the first exact duplicate group is 3. The Doc# for the top-level document in the second group is 4.

To view the exact duplicate group to which an individual document is assigned, right-click a document and select **Display Exact Duplicates**. The Document List displays the documents that are members of the same exact duplicate group. To disable grouping, click the **Grouping** button ( 🔵) on the Case Logistix toolbar.

**GROUPING BY NEAR DUPLICATES**

You must run Case Logistix Analytics before you can group by near duplicates (see "Working with Case Logistix Analytics" on page 61 for more information). Near duplicates are documents that contain most of the same text in the same order of display. When you group by near duplicates, the following columns are added to the Document List:

- **CLX NearDupe Group**: Displays a unique value for each near duplicate group.
- **CLX NearDupe Sort**: Displays a value that indicates the order in which the documents in each group display. The value for the principal document is always 1.
- **CLX NearDupe Similarity**: Displays the near duplicate score for each document in the group. The principal document's near duplicate score is always 100.

To group by near duplicates, click the arrow next to the **Grouping** button on the Case Logistix toolbar and select **Group Near Duplicates**. The Document List displays the near duplicate groups with alternating row colors and sorts them based on the selected column.
In the above example, the Document List is sorted on the Doc# column. The Doc# for the principal document in the first near duplicate group is 47. The Doc# for the principal document in the second group is 51. Note that the other documents in each group are ordered based on the near duplicate score and not the Doc#.

To view the near duplicate group to which an individual document is assigned, right-click a document and select Display Near Duplicates. The Document List displays the documents that are members of the same near duplicate group. To disable grouping, click the Grouping button ( ) on the Case Logistix toolbar.

Understanding the Near Duplicate Score

When you run Analytics, you specify a percentage to determine how close you want near duplicate documents to be to the principal document. For example, if you select a value of 90 percent, documents must be at least 90 percent similar to the principal document to be identified as a near duplicate. The near duplicate score displays in the CLX Near Dupe Similarity column. The principal document for each group is always assigned a score of 100. A score of 92 indicates a document is 92 percent similar to the principal document.

Comparing Text in Near Duplicate Documents

You can use the Equivio Compare feature to compare the text in two near duplicate documents. To compare documents, select the documents from the Document List, right-click the documents and point to Send To, then click Equivio Compare.
Adding the Near Duplicates Column
You can view whether a document is included in a near duplicate group by adding the Near Duplicates column to the Document List. Right-click a column header in the Document List and select Select Columns, select the Near Duplicates check box, and then click OK. The column displays the near duplicate icon ( ) for documents that are members of a near duplicate group.

Using the Send To Feature
You can use the Send To feature to send documents to a folder or attach them to an email. Documents are saved or attached in their native file format. You can also use the Send To feature to add tags to documents (see "Working with Tags" on page 45 for more information), and link to Case Logistix documents from other applications, for example, Microsoft Word (see "Adding Case Logistix Links to Microsoft Office Documents" on page 13 for more information).

SENDING DOCUMENTS TO FOLDERS
To send documents to a folder, do the following:
1. Select documents from the Document List.
2. Right-click the documents, point to Send To, and then select Any Folder.
3. Select File Attachments and click OK.
4. Browse to the destination folder, or click Make New Folder to create a new folder.
5. Click OK.

SENDING DOCUMENTS IN EMAILS
To send documents in an email, do the following:
1. Select documents from the Document List.
2. Right-click the documents, point to Send To, and then select Mail Recipient.
3. Select File Attachments and click OK. A new email message opens in Outlook with the attached documents. Type a message in the box provided and click Send.

SENDING DOCUMENTS TO CASEMAP
You can use the Send To feature to send documents to CaseMap. You must have a new or existing case open in CaseMap before you can send documents from Case Logistix.
1. Select documents from the Document List.
2. Right-click the documents, point to Send To, and then select CaseMap.
3. Select a CaseMap category from the list provided.
4. Type a name in the Full Name box, or accept the default name.
5. Click OK.
6. Edit the text in the Text Selection box and select a field from the Append Text Selection to list, if applicable.
7. Under the Favorite Fields heading, type or edit the values in the boxes provided.
8. Click OK. CaseMap creates a new records that includes a link to the original documents. Click the paperclip icon and select the linked file to open a document in Case Logistix.
9. Click Yes to switch to CaseMap. Click No to remain in Case Logistix.

SENDING DOCUMENTS TO CASENOTEBOOK
You can send documents and pleadings from Case Logistix to Case Notebook when both applications are installed on the same computer. Case Notebook retains all coding, shared tags, redactions, and notes from the original document.

When additional Custom Fields have been created in Case Logistix and you have already created matching Custom Fields in Case Notebook, you can include the additional Custom Fields while sending document and pleadings from Case Logistix to Case Notebook. Case Logistix fields will automatically map to Case Notebook fields with the same name if they already exist.

You can also manually map Case Logistix fields to Data Groups, Doc-Level Issues, and Doc-Level Notes fields in Case Notebook. If you do not map a Case Logistix field, the data in that field will not be available in Case Notebook.
Case Logistix and Case Notebook use different terminology when referring to the same items. The following table compares the differences in terminology usage between the two applications:

<table>
<thead>
<tr>
<th>Case Logistix</th>
<th>Case Notebook</th>
</tr>
</thead>
<tbody>
<tr>
<td>Shared Tags</td>
<td>Doc-Level Issues</td>
</tr>
<tr>
<td>Notes</td>
<td>Doc-Level Notes</td>
</tr>
<tr>
<td>IntelliFolders</td>
<td>Data Groups</td>
</tr>
<tr>
<td>Redactions</td>
<td>Redaction Issues</td>
</tr>
<tr>
<td>Anchor Notes</td>
<td>Annotations</td>
</tr>
</tbody>
</table>

Note: If you change information in a Case Logistix document after you send it to Case Notebook, those changes are not reflected in the document in Case Notebook.

1. Select a document from the Document List and do one of the following:
   - Right-click the documents, point to Send To, and then select Case Notebook as Document or Case Notebook as Pleading.
   - Click the Case Notebook menu and select Send as Document or Send as Pleading. To access the Send To Case Notebook wizard, you must enable the Show Send To Wizard option by selecting the option from the Case Notebook menu. A check mark displays next to Show Send To Wizard.

2. You have the following options:
   - Include document Tags as Issues: Convert Tags to Doc-Level Issues in Case Notebook. Tags that are converted to Doc-Level Issues are assigned the default issue color. You can map more than one Case Logistix field to Doc-Level Issues.
   - Include document IntelliFolders as Data Groups: Convert IntelliFolders to Data Groups in Case Notebook. IntelliFolders that are converted to Data Groups retain the IntelliFolder name. If a Data Group with the same name as the IntelliFolder already exists in Case Notebook, the document or pleading is added to the existing group. If no group exists, a new one is created. You also have the option of selecting existing data groups upon import to Case Notebook. Uncoded IntelliFolders are not converted to Data Groups (see "Using The Uncoded Sub-folder" on page 42 for more information).
   - Include additional Custom Fields: Select this option if additional Custom Fields have been created in Case Logistix, and you have already created matching Custom Fields in Case Notebook with the same name. Case Notebook will receive and properly map the data from the document sets transmitted from Case Logistix. You must create Custom Fields with the same names in Case Notebook before sending a document or pleading with Custom Fields from Case Logistix to Case Notebook (see "Mapping Data Types to Case Notebook" on page 30 for a guide to assigning Data Types in Case Notebook for Custom Fields that have been created in Case Logistix with the given Data Types). See the Case Notebook Help for detailed information on creating Custom Fields in Case Notebook.
   - Include Notes: Convert Document Notes to Doc-Level Notes in Case Notebook. Doc-Level Notes apply to the entire document. You can map more than one Case Logistix field to Doc-Level Notes. To confirm that Doc-Level Notes have been imported successfully, right-click a document in the Navigation panel in Case Notebook and click Properties.
   - Include document Redactions: Transfer redactions to Case Notebook. Redactions are converted to annotations in Case Notebook and are assigned a gray issue color. Redaction labels are prefaced by the word Redaction. Case Notebook displays redactions in the navigation panel below their associated document or pleading.
   - Send Mark-up when available: Transfer a document’s markup file to Case Notebook, if available.
   - Do not show this wizard again: Disable the Show Send To Wizard option on the Case Notebook menu. To re-enable the option, click the Case Notebook menu and select Show Send To Wizard. A check mark displays next to Show Send To Wizard.

3. Click Next. If you chose to Include document Tags as Issues, the Select Tags to send as Doc-Level Issues page displays.
4. All tags are selected by default. Clear the check boxes for the tags that you do not want to send. Tags are only sent if they have been added to the documents you are sending to Case Notebook.
5. Click Next. If you chose to Include document IntelliFolders as Data Groups, the Select IntelliFolders to send as Groups page displays.
6. All IntelliFolders are selected by default. Clear the check boxes for the IntelliFolders that you do not want to send. IntelliFolders are only sent if they contain one or more of the documents you are sending to Case Notebook.

7. Click Next. If you choose to Include additional Custom Fields, the Select additional Custom Fields to send page displays.

8. No Fields are selected by default. Select the Custom Fields you want to send.

9. Click Finish.

If Case Notebook is open, the Data Import Wizard displays. Select the appropriate load field mappings and click Finish. If Case Notebook is closed, it prompts you to select a case. After you select a case, the Data Import Wizard displays. Select the appropriate load field mappings and click Finish.

Note: Some Fields are always sent from Case Logistix to Case Notebook by default and will not appear in the list of additional Custom Fields (see “Sending Fields to Case Notebook” on page 31 for more information).

To open a Case Logistix document from Case Notebook, right-click the document in the Case Notebook Navigation panel and select Open in Case Logistix.

Mapping Data Types to Case Notebook

Each Case Logistix field has a Data Type which defines the kind and size of the data the field holds. The table below can be used as a guide for assigning Data Types in Case Notebook for Custom Fields that have been created in Case Logistix with the given Data Types.

<table>
<thead>
<tr>
<th>Data Type</th>
<th>Description</th>
<th>Corresponding Case Notebook Data Type</th>
</tr>
</thead>
<tbody>
<tr>
<td>bigint</td>
<td>Integer data from (-2^{63} \text{ through } 2^{63}-1)</td>
<td>Number (Integer)</td>
</tr>
<tr>
<td>int</td>
<td>Integer data from (-2,147,483 \text{ through } 2,147,483,647)</td>
<td>Number (Integer)</td>
</tr>
<tr>
<td>smallint</td>
<td>Integer data from (-32,768 \text{ through } 32,767)</td>
<td>Number (Integer)</td>
</tr>
<tr>
<td>tinyint</td>
<td>Integer data from (0 \text{ through } 2^{55})</td>
<td>Number (Integer)</td>
</tr>
<tr>
<td>bit</td>
<td>Integer data with either a 1 or 0 value</td>
<td>Number (Integer)</td>
</tr>
<tr>
<td>decimal</td>
<td>Fixed precision and scale numeric data from (-10^{38} +1 \text{ through } 10^{38} -1)</td>
<td>Number (Decimal)</td>
</tr>
<tr>
<td>money</td>
<td>Monetary data values from (-2^{63} \text{ through } 2^{63} - 1)</td>
<td>Number (Currency)</td>
</tr>
<tr>
<td>smallmoney</td>
<td>Monetary data values from (-214,748.3648 \text{ through } +214,748.3647)</td>
<td>Number (Currency)</td>
</tr>
<tr>
<td>float</td>
<td>Floating precision number data from (-1.79E + 308 \text{ through } 1.79E + 308)</td>
<td>Number (Decimal)</td>
</tr>
<tr>
<td>real</td>
<td>Floating precision number data from (-3.40E + 38 \text{ through } 3.40 + 38)</td>
<td>Number (Decimal)</td>
</tr>
<tr>
<td>dateonly</td>
<td>Date data from January 1, 0001, through December 31, 9999</td>
<td>Date</td>
</tr>
<tr>
<td>datet ime</td>
<td>Date and time data from January 1, 1753, through December 31, 9999, with an accuracy of 3.33 milliseconds</td>
<td>Date &amp; Time</td>
</tr>
<tr>
<td>smalldatetime</td>
<td>Date and time data from January 1, 1990, through June 6, 2070, with an accuracy of 3.33 milliseconds</td>
<td>Date &amp; Time</td>
</tr>
<tr>
<td>char</td>
<td>Fixed-length character data with a maximum length of 8,000 characters</td>
<td>Text (Advanced)</td>
</tr>
<tr>
<td>varchar</td>
<td>Variable-length data with a maximum length of 7,800 characters</td>
<td>Text (Advanced)</td>
</tr>
<tr>
<td>nchar</td>
<td>Fixed-length Unicode data with a maximum length of 4,000 characters</td>
<td>Text (Advanced)</td>
</tr>
<tr>
<td>nvarchar</td>
<td>Variable-length Unicode data with a maximum length of 3,900 characters</td>
<td>Text (Advanced)</td>
</tr>
</tbody>
</table>

Sending Fields to Case Notebook

The table below lists the Fields that are always sent from Case Logistix to Case Notebook.

<table>
<thead>
<tr>
<th>Field</th>
<th>Type</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Bates Number</td>
<td>nvarchar</td>
<td>Bates Number</td>
</tr>
<tr>
<td>Bates Start</td>
<td>nvarchar</td>
<td>Bates Range: Start</td>
</tr>
<tr>
<td>Bates End</td>
<td>nvarchar</td>
<td>Bates Range: End</td>
</tr>
<tr>
<td>Title</td>
<td>nvarchar</td>
<td>Title</td>
</tr>
<tr>
<td>Document Type</td>
<td>nvarchar</td>
<td>Document Type</td>
</tr>
<tr>
<td>Created By</td>
<td>varchar</td>
<td>Author</td>
</tr>
<tr>
<td>To</td>
<td>varchar</td>
<td>Recipient</td>
</tr>
<tr>
<td>Date</td>
<td>datetime</td>
<td>Document Date</td>
</tr>
<tr>
<td>Custodian</td>
<td>nvarchar</td>
<td>Custodian</td>
</tr>
<tr>
<td>CC</td>
<td>varchar</td>
<td>CC</td>
</tr>
<tr>
<td>BCC</td>
<td>varchar</td>
<td>BCC</td>
</tr>
</tbody>
</table>
### Field List

<table>
<thead>
<tr>
<th>Field</th>
<th>Type</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Date Accessed</td>
<td>datetime</td>
<td>Date Accessed</td>
</tr>
<tr>
<td>Date Created</td>
<td>datetime</td>
<td>Date Created</td>
</tr>
<tr>
<td>Date Modified</td>
<td>datetime</td>
<td>Date Modified</td>
</tr>
<tr>
<td>Date Printed</td>
<td>datetime</td>
<td>Date Printed</td>
</tr>
<tr>
<td>Date Received</td>
<td>datetime</td>
<td>Date Received</td>
</tr>
<tr>
<td>Date Sent</td>
<td>datetime</td>
<td>Date Sent</td>
</tr>
</tbody>
</table>

### Endorsing Documents

When you add an endorsement, Case Logistix generate a PDF that contains the endorsement and adds it to the library as a separate document. The PDF retains the same field values as the original document.

1. Right-click a document in the Document List and select **Endorse Document**.
2. Click the **Set** button that corresponds to the location on the page where you want the endorsement to display.
3. Create the endorsement text by selecting values from the Field Values list and typing text in the box provided. Endorsements are limited to a maximum of 255 characters. For more information on the Format Expression Builder, see "Using the Format Expression Builder" on page 59.
4. The **Keep Original Document** check box is selected by default. Clear the check box to delete the original document.
5. Select the **Mark this field 'Endorsed'** check box and select a field from the list provided to code the selected field with the value Endorsed.
6. Click **OK**.

### Using Check Spelling

You can use Check Spelling to spell check field values in the Document List. Check Spelling only applies to the cells and columns in the Document List; it does not replace the actual text in a document.

1. Select one or more documents from the Document List.
2. Right-click the documents and select **Check Spelling**. To run Check Spelling on a specific column, right-click any cell in the column and select **Check Spelling**.
3. You have the following options:

   **Column Options**
   - **Current Cell**: Spell check the values in the selected cell only. Row Options are disabled when you select Current Cell.
   - **Current Column**: Spell check the values in the selected column for the documents specified under Row Options.
   - **Visible Columns**: Spell check the values in all columns in the Document List for the documents specified under Row Options.
   - **All Columns**: Spell check the values in all existing columns, including columns not displayed in the Document List, for the documents specified under Row options.

   **Row Options**
   - **Current Row**: Spell check the values in the selected document for the columns specified under Column Options.
   - **Selected Rows**: Spell check the values in the selected documents for the columns specified under Column Options.
   - **Current Folder**: Spell check the values in all documents in the selected IntelliFolder for the columns specified under Column Options.
   - **Entire Library**: Spell check the values in all documents in the library for the columns specified under Column Options.

4. Select the **Check Spelling of Notes** check box to spell check the notes in the selected documents.
5. Click **OK**.
6. If Case Logistix finds a misspelled term, or a term not found in the dictionary, the Spelling dialog box opens with the misspelled term highlighted in the **Not in dictionary** box. You have the following options:
   - **Ignore**: Skip the current instance of the term, but alert the user the next time the term is encountered.
   - **Ignore All**: Skip all instances of the term.
   - **Add**: Add the term to the user dictionary. The term will no longer be identified as misspelled.
   - **Change**: Replace the term with the selected term in the Suggestions list.
   - **Change All**: Replace all instances of the term with the selected term in the Suggestions list.
   - **Auto Correct**: Automatically correct the misspelled term from the list of common spelling mistakes.
   - **Undo**: Undo the last action.
   - **Cancel**: Exit Check Spelling.
Using Find and Replace

You can use Find and Replace to modify field values in the Document List. Find and Replace only applies to the cells and columns in the Document List; it does not replace the actual text in a document. It is recommended that you perform a database backup before using Find and Replace. You cannot run Find and Replace on multi-value field columns.

1. Select one or more documents from the Document List.
2. Right-click the documents and select Find and Replace. To run Find and Replace on a specific column, right-click any cell in the column and select Find and Replace.
3. Type the terms you want to find in the Find What box, or click the arrow next to the box and select <Any Value>.
4. Type the replacement terms in the Replace With box.
5. You have the following options:

   **Column Options**
   - **Current Cell**: Replace the value in the selected cell only. Row Options are disabled when you select Current Cell.
   - **Current Column**: Replace the value in the selected column for the documents specified under Row Options.
   - **Visible Columns**: Replace the value in all columns in the Document List for the documents specified under Row Options. It is recommended that you avoid this option when running Find and Replace on <Any Value>.
   - **All Columns**: Replace the value in all existing columns, including columns not displayed in the Document List, for the documents specified under Row Options. It is recommended that you avoid this option when running Find and Replace on <Any Value>.

   **Row Options**
   - **Selected Rows**: Replace the value in the selected documents for the columns specified under Column Options.
   - **Current Folder**: Replace the value in all documents in the selected IntelliFolder for the columns specified under Column Options.
   - **Entire Library**: Replace the value in all documents in the library for the columns specified under Column Options.

6. Select the Track Changes in History check box to add the Find and Replace actions to document history. For more information, see "Viewing Document History" on page 13.
7. Click Replace.
6  Working with the Document Viewer

The Document Viewer allows you to do the following:

- View documents in their native file format, for example, Microsoft Word and Excel.
- View text files and text from image and PDF files that were processed using OCR (Optical Character Recognition).
- View keywords and search results.
- Create notes and redactions.

**Using the Mark-up Tab**

The Mark-up tab displays a PDF rendering of a document, also known as a markup file. You can use the Mark-up tab to add notes and redactions to documents, and view keywords and search results. If a markup file does not exist for the selected document, the Mark-up tab is empty.

**CREATING A MARKUP FILE**

To create a markup file for a document, click the [Markup Document] button on the Mark-up tab toolbar. You can also use the Build Markup Utility to create markup files for multiple documents at the same time (see "Using the Build Markup Utility" on page 54 for more information).

**USING SPLIT VIEW**

You can use Split View to view both the markup file and an HTML rendering of a document. To enable Split View, click the [Toggle Split View] button at the bottom of the Document Viewer.

**Using the HTML Tab**

The HTML tab displays an HTML rendering of a document. The HTML rendering is created when you run a search and can be used to view keywords and search results. The contents of the rendering varies based on the document's native file format. For example, the HTML rendering of a Microsoft Word document may appear nearly identical to its native view, but the HTML rendering of a TIFF image file may only show metadata, such as the filename and date created.

**Using the Associated Text Tab**

The Associated Text tab allows you to view text files and text from image and PDF files that were processed using OCR (Optical Character Recognition). For more information, see "Using the Optical Character Recognition (OCR) Utility" on page 56.

**Using the Native/Image Tab**

The Native/Image tab allows you to view the following file types in their original electronic, or native, formats:

- Microsoft Office (Excel, PowerPoint, Word) documents.
- Adobe PDF files (requires that you have a PDF reader installed).
- Image files, for example, .tif, .gif, and .jpeg files.

If the native application for a specific file format is not installed on your computer, the Native/Image tab toolbar is disabled. Library administrators can configure Case Logistix to display an HTML rendering of a document for those file formats where the native application is not available. For more information, see "Document Viewing Options" on page 9.

**USING SPLIT VIEW**

If the document you are viewing is an image file, you can use Split View to view both the native image file and an HTML rendering of the selected document. To enable Split View, click the [Toggle Split View] button at the bottom of the Document Viewer.

**Working with Keywords**

Keywords can help you find terms related to a specific litigation theme or concept. You can view the keywords in a document from the Document Viewer Mark-up, HTML, and Associated Text tabs. Keywords that appear in a document are highlighted. To change the keyword highlight color, see "Managing Keywords and Keyword Groups" on page 34.
VIEWING KEYWORDS
1. Select a document from the Document List.
2. Click the Document Viewer Mark-up, HTML, or Associated Text tab.
3. Click the View Markup list on the Document Viewer toolbar and select Keywords. A check mark displays next to the word Keywords.
4. Click the Select Keywords to Display list ( ) on the Document Viewer toolbar and select one or more keyword group. A check mark displays next to the selected keyword groups.
5. Click the Hit Type list ( ) on the Document Viewer toolbar and select Keyword. The number of keywords that appear in the document displays in the Keyword hit box. Use the hit navigation buttons to navigate to the next or previous keyword in the document.

MANAGING KEYWORDS AND KEYWORD GROUPS
Keywords and keyword groups created in Case Logistix are private by default, meaning they can only be viewed by the user who created them. To create public keywords or keyword groups, you must use Library Designer. See the Library Designer Help for more information.

You can add keywords to more than one group. If a keyword is in both a public and private keyword group, the highlight color for the public keyword group displays. If a keyword is in two or more public keyword groups, the highlight color for the last group in the Select Keywords to Display list displays.

Keyword phrases always display before single keywords. For example, the keyword color for United States displays before the keyword color for United.

Managing Keywords
1. Do one of the following:
   - Click the Tools menu and select Manage Keywords.
   - Click the Select Keywords to Display ( ) list on the Document Viewer toolbar and select Manage Keywords.
2. Select a keyword group form the Groups list.
3. You have the following options:
   - Add a Keyword: Click Add, type a keyword in the box provided, and then click Add.
   - Import Keywords from a Text File: Click Import, browse to the text file, and then click Open.
   - Rename a Keyword: Select a keyword from the list, click Edit, edit the keyword in the box provided, and then click Save.
   - Delete a Keyword: Select a keyword from the list, click Delete, and then click Yes to confirm.
   - Delete All Keywords: Click Delete All, then click Yes to confirm.
4. Click OK.

Managing Keyword Groups
1. Do one of the following:
   - Click the Tools menu and select Manage Keywords.
   - Click the Select Keywords to Display ( ) list on the Document Viewer toolbar and select Manage Keywords.
2. You have the following options:
   - Add a Keyword Group: Click Add, type a name in the Group name box, select a background and foreground color, and then click Add.
   - Edit a Keyword Group: Select a keyword from the Groups list, click Edit, make the appropriate edits, and then click Save.
   - Delete a Keyword Group: Select a keyword from the Groups list, click Delete, and then click Yes to confirm.
3. Click OK.

Working with Redactions
Case Logistix allows you to remove confidential and proprietary information from documents by redacting text and images. When you create a redaction, you select a redaction code, for example, Trade Secret. The redaction code displays in the upper-right corner of the redaction.

You must have a markup file for a document before you can create redactions. Redactions remain visible during the review process, but are hidden when included in a production. For more information, see "Producing Documents" on page 60.
CREATING REDACTIONS

1. Select a document from the Document List.
2. Click the Document Viewer Mark-up tab.
3. Click the View Markup list on the Mark-up tab toolbar and select Redactions. A check mark displays next to the word Redactions.
4. Select the text or images you want to redact, then click Select Redaction Code.
5. Select a redaction code from the list provided and click OK.

To edit or delete an existing redaction, right-click a redaction and select Edit Redaction or Delete Redaction. To navigate redactions on the Mark-up tab, click the Hit list on the Mark-up tab toolbar and select Redactions. Use the Next Hit and Previous Hit buttons to move to the next or previous redaction. You can also use Quick or Advanced Search to search for specific redaction codes in the Redaction Codes field. For more information, see "Working with Search" on page 47.

CREATING NEW REDACTION CODES

1. Click the Document Viewer Mark-up tab.
2. Click the arrow next to the Create Redactions button () and select Manage Redaction Codes.
3. Click the Add button, type the redaction code in the box provided, and then click OK.
4. Click Done.

To delete a redaction code, select a code from the All Redactions Code list and click Remove. You cannot delete redaction codes that are currently in use.

Working with Quick Redaction Mode

There may be times during the review process when you need to create multiple redactions using the same redaction code. Instead of having to choose a code each time you create a new redaction, you can use Quick Redaction mode to automatically apply the same redaction code when text or images are selected in the Document Viewer Mark-up tab.

ENABLING QUICK REDACTION MODE

To enable Quick Redaction mode, do the following:

1. Select a document from the Document List.
2. Click the Document Viewer Mark-up tab.
3. Click the View Markup list on the Mark-up tab toolbar and select Redactions. A check mark displays next to the word Redactions.
4. Select the text or images you want to redact, then select a redaction code under the Apply Quick Redaction Code heading on the popup menu. Case Logistix creates the redaction and enables Quick Redaction mode for the selected code.

Note: When you enable Quick Redaction mode, the Create Redaction button () on the Mark-up tab toolbar changes to ().

DISABLING QUICK REDACTION MODE

To disable Quick Redaction mode, do one of the following:

- Click the arrow next to the Create Redaction button () on the Mark-up tab toolbar and select Stop Quick Redaction.
- Right-click anywhere in the Document Viewer and select Stop Quick Redaction.
- Edit a redaction.
- Delete a redaction.

MANAGING QUICK REDACTION FAVORITES

You can choose up to six redaction codes to display as Quick Redaction Code favorites on the Document Viewer popup menu. Library administrators can also set the default favorites for a library.

Note for Administrators: If you do not set the Quick Redaction favorites for the library, Case Logistix automatically assigns the first six redaction codes (based on alphanumeric order) as the default favorites. For example, if a library has six redaction codes (A, B, D, E, F, G), those six codes are automatically assigned as the default Quick Redaction favorites for the library. If you create redaction code C, G is replaced by C as a default favorite.

1. Click the Document Viewer Mark-up tab.
2. Click the arrow next to the Create Redaction button () on the Mark-up tab toolbar and select Manage Redaction Codes.
3. If you are an administrator, select Library Defaults under the Quick Redaction Favorites heading to set the default library favorites.
4. You have the following options:
   - **Add a Quick Redaction Favorite**: Select a code from the All Redaction Codes list and click Add ->.
   - **Remove a Quick Redaction Favorite**: Select a code from the Quick Redaction Favorites list and click <- Remove.
   - **Restore the Default Favorites**: Click Restore Defaults. If the library administrator has not set the default favorites for the library, the first six codes (based on alphanumeric order) are assigned as the Quick Redaction favorites. When you restore the default favorites, your Quick Redaction favorites are automatically deleted.

5. Click **Save** to apply your changes, then click **Done**.

**Working with Notes**

Notes can contain text you type, text highlighted in a document, or a combination of both. Case Logistix allows you to create the following notes:

- **Anchor Notes**: Notes that are associated with specific text or images in a document.
- **Document Notes**: Notes that are associated with a document.
- **Transcript Notes**: Notes that are associated with specific text or images and that include transcript citation information.

**USING THE NOTES PANEL**

The Notes panel displays the notes in a selected document. You can also create notes from the Notes panel (see "Adding and Removing Notes" on page 37 for more information), send notes in an email or to an Excel spreadsheet, and generate HTML reports on the notes in a document.

**Sending Notes in Emails**

To send the notes from a document in an email, do the following:

1. Select a document from the Document List.
2. Expand the Notes panel in the Accordion Pane. To send some, but not all, of the notes, select the notes that you want to send from the list in the Notes panel.
3. Click the arrow next to the Print Notes button ( ), point to Send Notes, and then click Mail Recipient.
4. You have the following options:
   - **Include**
     - **Selected Notes**: Send only the selected notes.
     - **All Notes**: Send all notes.
     - **All Shared Notes**: Send only shared notes.
     - **My Private Notes**: Send only private notes.
   - **File Type**
     - **Excel**: Attach the notes in an Excel spreadsheet. The spreadsheet includes the values from the columns in the Notes panel.
     - **HTML**: Attach the notes in an HTML file. The file includes the document name and a link to the document.
     - **Text**: Attach the notes in a text file.
5. Click **OK**. A new email message opens in Outlook with the attached notes. Type a message in the box provided and click **Send**.

**Sending Notes to Excel**

To send the notes from a document to an Excel spreadsheet, do the following:

1. Select a document from the Document List.
2. Expand the Notes panel in the Accordion Pane. To send some, but not all, of the notes, select the notes that you want to send from the list in the Notes panel.
3. Click the arrow next to the Print Notes button ( ), point to Send Notes, and then click Excel.
4. You have the following options:
   - **Selected Notes**: Send only the selected notes.
   - **All Notes**: Send all notes.
   - **All Shared Notes**: Send only shared notes.
   - **My Private Notes**: Send only private notes.
5. Click **OK**, browse to the destination folder, type a name in the **File name** box, and then click **Save**. The Excel spreadsheet automatically opens.
Creating Note Reports

To create a report on the notes in a document, do the following:

1. Select a document from the Document List.
2. Expand the Notes panel in the Accordion Pane.
3. Click the Print Notes button ( ). You have the following options:

   **Report Options**
   - **Include References**: Display the page and paragraph number where the note is located.
   - **Include Note Image Clips**: Display an image of the text from which the note was created.
   - **Include Selected Notes**: Include the selected notes.
   - **Include All Notes**: Include all notes.
   - **Include All Shared Notes**: Include only shared notes.
   - **Include My Private Notes**: Include only private notes.

4. Type a **Title**, **Header**, **Footer**, and **Reference** in the boxes provided, or accept the default values. You can also click the ellipsis to use the Format Expression Builder to configure the formatting for each item. For more information, see “Using the Format Expression Builder” on page 59.
5. Click **OK** to open the report in a web browser.

Adding Columns to the Notes Panel

To add columns to the Notes panel, click the **Add Columns** button ( ) on the Notes panel toolbar, select the check boxes for the columns you want to add, and then click **OK**.

Adding and Removing Notes

You can add and remove Anchor, Document, and Transcript notes from the Document Viewer Mark-up tab or Notes panel (see "Working with Notes" on page 36 for more information). When you add a note to a document, a Note icon ( ) displays in the Document List Notes column.

**ADDING ANCHOR NOTES**

1. Select a document from the Document List.
2. Click the Document Viewer **Mark-up** tab.
3. Click the View Markup list on the Mark-up tab toolbar and select **Notes**. A check mark displays next to the word Notes.
4. Select the text or images to which you want to add a note, then do one of the following:
   - **Notes Panel**: Click the **Create new Anchored Note** button ( ) on the Notes panel toolbar.
   - **Document Viewer Mark-up Tab**: Click the **New Anchor Note** button on the popup menu.
5. Type the note in the box provided.
6. Select the **Private Note** check box to make the note private. Anchor notes are shared with all library users by default.
7. Click **Clean Up Note** to reformat the note text.
8. Click **OK**.

To edit or delete an Anchor note, right-click the note in the Notes panel or Document Viewer Mark-up tab and select **Edit** or **Delete**.

**ADDING DOCUMENT NOTES**

1. Select a document from the Document List.
2. Click the Document Viewer **Mark-up** tab.
3. Do one of the following:
   - **Notes Panel**: Click the **Create a new note** button ( ) on the Notes panel toolbar.
   - **Document Viewer Mark-up Tab**: Click the arrow next to the **Create Note** button ( ) on the Mark-up tab toolbar and select **New Document Note**.
4. Type the note in the box provided.
5. Select the **Private Note** check box to make the note private. Document notes are shared with all library users by default.
6. Click **Clean Up Note** to reformat the note text.
7. Click **OK**.
To edit or delete a Document note, right-click the note in the Notes panel and select Edit or Delete.

**ADDING TRANSCRIPT NOTES**

1. Select a document from the Document List.
2. Click the Document Viewer Mark-up tab.
3. Click the View Markup list on the Mark-up tab toolbar and select Notes. A check mark displays next to the word Notes.
4. Select the text or images to which you want to add the note, then do one of the following:
   - Notes Panel: Click the Create new Transcript Note button (✍️) on the Notes panel toolbar.
   - Document Viewer Mark-up Tab: Click New Transcript Note on the popup menu.
5. Type the note in the box provided.
6. Select the Private Note check box to make the note private. Transcript notes are shared with all library users by default.
7. Click Clean Up Note to reformat the note text.
8. Click OK.

To edit or delete a Transcript note, right-click the note in the Notes panel or Document Viewer Mark-up tab and select Edit or Delete.

**Linking Documents**

You can link document text to another document or note in the library. Linking documents can help you analyze documents that have a common theme or outline a specific flow of events.

1. Select the document that contains the text for the link.
2. Click the Document Viewer Mark-up tab.
3. Click the View Markup list on the Mark-up tab toolbar and select Links. A check mark displays next to the word Links.
4. Select the text for the link, then click Create New Link.
5. Click OK.
6. Select the document you want to link to from the Document List.
7. Click the Document Viewer Mark-up tab.
8. You have the following options:
   - Link to a Note: Click an Anchor or Transcript note, then click the arrow next to the Create New Link (✍️) button on the Mark-up tab toolbar and select Link to Note. You cannot link to Document notes.
   - Link to a Document: Click the arrow next to the Create New Link (✍️) button on the Mark-up tab toolbar and select Link to Document. The Link to Note option is disabled if you select multiple notes.
9. Type a description in the Description box, or accept the default value.
10. Select the After linking, open document I linked from check box, if applicable.
11. Click OK.

If you linked to a document, a light red box displays above the text you linked from. If you linked to a note, the box is light yellow. Right-click the box and select Open Document Link to view the document to which the text is linked.

To edit the description for a link, right-click the box and select Edit Document Link. Type a new description in the Description box and click OK. To delete a link, right-click the box and select Delete Document Link, then click Yes to confirm.
7 Working with Editors

You can use the editors in the Coding panel to code documents. Each editor has its own set of fields. The fields display the current values for the selected documents. **Varied** displays if the documents contain different values for the same field.

**Using the Coding Panel**
1. Select documents from the Document List.
2. Expand the Coding panel in the Accordion Pane.
3. Select an editor from the Editor list.
4. For each editor field, do one of the following:
   - Type values in the text box.
   - Select values from the list provided.
5. Press **Tab** to move to the next field.

**ADDITION OF EDITORS TO THE CODING PANEL**
To add editors to the Coding panel, do the following:
1. Expand the Coding panel in the Accordion Pane.
2. Click **Add to List**.
3. Select editors from the left column and click **Add**.
4. Click **OK**.

**Editor Types**
The following table lists the available editor types with examples:

<table>
<thead>
<tr>
<th>Editor Types</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td><strong>Lookup List</strong></td>
<td>A predefined list of values that you can choose from when coding a field.</td>
</tr>
<tr>
<td><img src="image" alt="Lookup List" /></td>
<td><img src="image" alt="Radio Button" /></td>
</tr>
<tr>
<td><strong>Radio Button</strong></td>
<td>Nested radio buttons for simultaneously coding up to two field levels.</td>
</tr>
<tr>
<td><img src="image" alt="Radio Button" /></td>
<td><img src="image" alt="Radio Button" /></td>
</tr>
</tbody>
</table>
## Editor Types

<table>
<thead>
<tr>
<th>Editor Type</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td><strong>Check box</strong></td>
<td>A check box for toggling between checked and unchecked values.</td>
</tr>
<tr>
<td><strong>Multi-value List Editor</strong></td>
<td>A list of values that you can choose from when coding a field.</td>
</tr>
<tr>
<td><strong>Hyperlink Editor</strong></td>
<td>Allows you to add hyperlinks to documents.</td>
</tr>
<tr>
<td><strong>Popup Editor</strong></td>
<td>A popup window from which you can add field values.</td>
</tr>
<tr>
<td><strong>Text Editor</strong></td>
<td>A text box from which you can add field values.</td>
</tr>
<tr>
<td><strong>Date Editor</strong></td>
<td>A calendar widget from which you can select dates.</td>
</tr>
</tbody>
</table>
# Editor Types

## Masked Editor
Defines the format for field values, for example, requiring phone numbers to be entered as (123) 456-7890.

<table>
<thead>
<tr>
<th>Responsive</th>
<th>2 - Non-Responsive</th>
</tr>
</thead>
<tbody>
<tr>
<td>Privileged</td>
<td></td>
</tr>
<tr>
<td></td>
<td></td>
</tr>
<tr>
<td></td>
<td></td>
</tr>
<tr>
<td>Redaction</td>
<td></td>
</tr>
<tr>
<td>Confidentiality Status</td>
<td></td>
</tr>
<tr>
<td>Hot Docs</td>
<td></td>
</tr>
<tr>
<td>Deposition Kits</td>
<td></td>
</tr>
<tr>
<td>SSN</td>
<td>090-11-2222</td>
</tr>
</tbody>
</table>

## Currency / Money Editor
Allows you to add currency values when coding a field.

<table>
<thead>
<tr>
<th>Responsive</th>
<th>3 - Further Review</th>
</tr>
</thead>
<tbody>
<tr>
<td>Privileged</td>
<td></td>
</tr>
<tr>
<td></td>
<td></td>
</tr>
<tr>
<td></td>
<td></td>
</tr>
<tr>
<td>Redaction</td>
<td></td>
</tr>
<tr>
<td>Confidentiality Status</td>
<td></td>
</tr>
<tr>
<td>Hot Docs</td>
<td></td>
</tr>
<tr>
<td>Deposition Kits</td>
<td></td>
</tr>
<tr>
<td>Cost</td>
<td>$10,000.00</td>
</tr>
</tbody>
</table>

## Spin Editor (for numbers)
Allows you to increase and decrease integer values when coding a field.

<table>
<thead>
<tr>
<th>Responsive</th>
<th>3 - Further Review</th>
</tr>
</thead>
<tbody>
<tr>
<td>Privileged</td>
<td></td>
</tr>
<tr>
<td></td>
<td></td>
</tr>
<tr>
<td></td>
<td></td>
</tr>
<tr>
<td>Redaction</td>
<td></td>
</tr>
<tr>
<td>Confidentiality Status</td>
<td></td>
</tr>
<tr>
<td>Hot Docs</td>
<td></td>
</tr>
<tr>
<td>Deposition Kits</td>
<td></td>
</tr>
<tr>
<td>Review #</td>
<td>2</td>
</tr>
</tbody>
</table>

## Time Editor
Allows you to add time values when coding a field.

<table>
<thead>
<tr>
<th>Responsive</th>
<th>3 - Further Review</th>
</tr>
</thead>
<tbody>
<tr>
<td>Privileged</td>
<td></td>
</tr>
<tr>
<td></td>
<td></td>
</tr>
<tr>
<td></td>
<td></td>
</tr>
<tr>
<td>Redaction</td>
<td></td>
</tr>
<tr>
<td>Confidentiality Status</td>
<td></td>
</tr>
<tr>
<td>Hot Docs</td>
<td></td>
</tr>
<tr>
<td>Deposition Kits</td>
<td></td>
</tr>
<tr>
<td>Time</td>
<td>12:01:55</td>
</tr>
</tbody>
</table>

---

*Working with Editors*  41
8 Working with IntelliFolders

IntelliFolders are auto-organizing containers for documents that correspond to specific fields and field values. You can use IntelliFolders to view and code documents with the same field value.

When you add documents to a library or code documents, Case Logistix automatically adds them to new or existing IntelliFolders based on the information in the document metadata fields.

You can compare the functionality of IntelliFolders to iTunes. For example, when you add a new song, iTunes automatically classifies it by title, artist, album, genre, and so forth.

When the value of an IntelliFolder field is changed, for example, by using an editor in the Coding panel, by editing a value directly in the Document List, or by dragging documents to a different IntelliFolder, one of two things happens:

- If a static or user-defined folder for the value exists, the document moves to that folder.

  Static IntelliFolders, for example, Confidentiality Status, are created by the library Administrator and are always visible in the IntelliFolders panel, regardless of whether they contain coded documents.

- If a static or user-defined folder for the value does not exist, a dynamic folder is created for the value and the documents move to that folder.

Dynamic IntelliFolders, for example, Custodian, display sub-folders for the values that you code for those fields. When you code a document with a new custodian value, a sub-folder is automatically created for that value.

Using the IntelliFolders Panel

The IntelliFolders panel displays IntelliFolders in a hierarchy. The top-level IntelliFolder is assigned the library name and contains all documents in the library. When you select an IntelliFolder, the documents contained in the folder display in the Document List. Click the arrow next to an IntelliFolder to expand or collapse the folder.

**Note:** Depending on your user permissions, you might not have access to all of the IntelliFolders in a library. Contact your library administrator for more information.

**USING THE UNCODED SUB-FOLDER**

The Uncoded sub-folder exists at each level of the IntelliFolder hierarchy. The sub-folder contains all documents without a value for the IntelliFolder field. Documents remain in the Uncoded sub-folder until the IntelliFolder field is coded with a value. If all documents have a coded value for the IntelliFolder field, the sub-folder does not display. You can also hide the uncoded sub-folder using Library Designer. See the Library Designer Help for more information.

The sub-folder name include the word **Uncoded** and the name of the field associated with the IntelliFolder, for example, **Uncoded Custodian**.

**Using IntelliFolders to Code Documents**

You can use IntelliFolders to code documents by dragging documents from the Document List to an IntelliFolder in the IntelliFolders panel. When you drag documents to an IntelliFolder, the documents inherit the field values of the parent IntelliFolder.

For example, dragging documents to the **1-Privileged** sub-folder in the **1-Responsive** IntelliFolder, codes the Responsive and Privileged fields with Responsive and Privileged, respectively. If you dragged the documents to the **1-Responsive** folder, the documents would only be coded for the Responsive field.

**Renaming and Deleting IntelliFolders**

You can rename and delete IntelliFolders from the IntelliFolders panel.

**RENAME INTELLIFOLDERS**

When you rename an IntelliFolder, the documents in the folder are coded with the new IntelliFolder field value. To rename top-level IntelliFolders, for example, the Custodian folder, you must use Library Designer. See the Library Designer Help for more information.

1. Expand the IntelliFolders panel.
2. Right-click an IntelliFolder and select **Rename**.
3. Type a new name for the IntelliFolder and press Enter. The documents in the folder are coded with the new value. Click Refresh ( ) or press F5 to update the IntelliFolders panel.

DELETING INTELLIFOLDERS

When you delete an IntelliFolder, you have the option to send the documents in the folder to the Recycle Bin, or retain them and erase the IntelliFolder field value from the documents. You must use Library Designer to delete top-level IntelliFolders, for example, the Custodian folder. See the Library Designer Help for more information.

1. Expand the IntelliFolders panel.
2. Right-click an IntelliFolder and select Delete Folder.
3. You have the following options:
   - Remove this folder by erasing all <field name> values for the documents in the folder.
   - Remove this folder by deleting the documents in the folder and sending them to the Recycle Bin.
4. Click OK, then click Yes to confirm.

Note: Another prompt opens if the IntelliFolder field value is contained within a lookup list in a Coding panel editor. Click Yes to remove the field value from the lookup list.

Checking for Password Protected Files

You can use the Check Password Utility to verify which files in the library are password protected. These files can be organized into the following sub-folders within the Password Protected Intellifolder based on the result.

- (Uncoded Password Protected): This sub-folder contains all documents before the Check Password Utility is run. After the utility is run, this sub-folder contains documents that are in a file format that the utility cannot process (see below for a list of file type that can be processed), or documents that are not password protected.
- Not Protected: This sub-folder contains all documents that are not password protected.
- Protected: This sub-folder contains all documents that are password protected.

Note: You cannot add or drag and drop documents directly into the Not Protected and Protected sub-folders within the Password Protected Intellifolder. The classification into these sub-folders is based on file properties. Therefore, you must run the Check Password Utility to organize your documents into these sub-folders.

The Check Password Utility can only be used to verify password protection in the following file types:

- Word Document (.doc, .docx)
- PowerPoint Presentation (.ppt, .pptx)
- Excel Spreadsheet (.xls, .xlsx)
- Adobe PDF (.pdf)

All other file types will be stored in the Uncoded Password Protected sub-folder.

To check for password protected files, do the following:

1. Click the Tools menu, or right-click anywhere in the Document List pane, and select Check for Password Protected Files. Select one of the following check boxes to identify the files that will checked:
   - Full Library: Checks all documents in the library.
   - Current List: Checks all documents in the Document List.
   - Selected Tag: Checks all documents in the selected tag. Select the tag from the dropdown menu.

The Total Documents to be Processed field is updated to show the number of files that will be checked for password protection based on your selection.

3. Click Start. The Documents Processed Window displays results at a glance and shows the number of total documents processed, protected files, non protected files, and the documents that remained undetermined.

4. Click OK. Documents are moved into sub-folders within the Password Protected Intellifolder.

Note: Only .doc, .docx, .ppt, .pptx, .xls, .xlsx, and .pdf file types will be processed and moved into the corresponding sub-folders. All other file types will be moved into the Uncoded Password Protected sub-folder.
9 Working with Tags

Tags are another flexible tool for organizing the documents in a library. (See also "Working with IntelliFolders" on page 42.) Case Logistix includes two types of tags:

- **Auto-Tags**: Tags that are automatically created by Case Logistix. Auto-Tags provide a timeline of your recent workflow, for example, Documents Edited This Week or Documents Viewed Today. You can also use Auto-Tags to narrow searches, for example, by running a search on the documents in the Documents I Edited This Week tag.
- **Custom Tags**: Tags that are created by Case Logistix users. Custom tags can be public (Shared Tags) or private (My Tags).

**Using the Tag Folders and Tagging Panels**

You can view the tags in a library from the **Tag Folders** and **Tagging** panels.

- **Tag Folders Panel**: Displays all Auto and Custom tags. To view the documents to which a tag has been added, select a tag from the Auto-Tags, Shared Tags, or My Tags lists. The documents associated with the selected tag display in the Document List.
- **Tagging Panel**: Displays all Custom tags. To view the tags that have been added to one or more documents, select documents from the Document List and expand the Shared Tags and My Tags lists in the Tagging panel. A check mark next to a tag indicates that it has been added to the selected documents. If a tag has been added to some, but not all, of the documents, the check box displays a blue box.

**Note**: While in Select All mode, tags can be added from the Tagging panel, but not removed. For more information, see "Removing Tags while in Select All Mode" on page 45.

**Adding Tag Columns to the Document List**

You can view tag information by adding the following columns to the Document List:

- **Issues**: Displays the Tag icon (マークマークマーク) for documents to which one or more tags have been applied.
- **Tag Count**: Displays the number of tags that have been applied to a document.
- **Tags**: Displays the name of the tags that have been applied to a document.

**Adding and Removing Tags**

You can add and remove tags from the Tag Folders panel, Tagging panel, and Send To menu. To add or remove tags, select documents from the Document List and do the following:

- **Tag Folders Panel**: Right-click a tag in the Shared Tags or My Tags list and select **Add Tag to Selected Documents**. To remove a tag, select **Remove Tag from Selected Documents**.
- **Tagging Panel**: Select or clear the check boxes for the tags you want to add or remove.
- **Send To Menu**: Right-click the documents, point to **Send To**, point to **Tags**, and then select a tag from the My Tags or Shared Tags lists. To apply multiple tags, select **Multiple Tags**, select tags from the list provided, and then click **OK**.

**Removing Tags while in Select All Mode**

Select All mode is enabled when you select all of the documents in the Document List, and that number exceeds the maximum number of documents allowed in the Document List at one time (see "Configuring User Profile Options" on page 9 for more information). While in Select All mode, tags can only be removed from the Tag Folders panel and the following message displays at the top of the Tagging panel.

"Select All Mode: In select all mode, checks are not displayed. To remove documents use the right click menu on the tag in the Tag Folders window."

**Renaming and Deleting Tags**

You can rename, share and unshare, and delete tags from the **Tag Folders** panel. When you delete a tag, it is permanently deleted. Documents to which the tag has been added remain in the Document List, but are no longer associated with that tag. You cannot rename or delete Auto-Tags (see "Working with Tags" on page 45 for more information).

1. Expand the **Tag Folders** panel.
2. Click the arrow next to **Shared Tags** or **My Tags**.
3. You have the following options:
- **Rename a Tag**: Right-click a tag and select *Properties*. Type a name in the *Tag Name* box and click *OK*.
- **Share or Unshare a Tag**: Right-click a tag and select *Properties*. Select or clear the *Shared with* check box. If you are sharing a tag, select a workgroup from the list provided, then click *OK*.
- **Delete a Tag**: Right-click a tag and select *Delete*, then click *Yes* to confirm.
10  Working with Search

You can use Quick Search and Advanced Search to search document text and metadata. Quick Search allows you to create simple search queries, while Advanced Search allows you to create more complex queries, for example, queries that utilize SQL statements.

Choosing What to Search

Case Logistix can return up to 50,000 documents in a search (see "Narrowing Search Results" on page 52 for more information). To avoid crossing this threshold, you should identify the documents to search prior to running a Quick or Advanced search. For example, you can search a subset of documents in an IntelliFolder or tag, or use filters to restrict the documents in the Document List to documents with specific field values (see "Filtering the Document List" on page 21 for more information).

Supported Search Connectors and Wildcards

You can use the search connectors and wildcard characters described in this topic to further qualify search criteria.

SUPPORTED SEARCH CONNECTORS

You can use the following connectors in Quick and Advanced searches:

AND Connector

Use the **AND** connector when searching for two or more terms, both of which must be found in any documents returned in the results. For example, apple pie and poached pear returns documents that contain both apple pie and poached pear.

OR Connector

Use the **OR** connector when searching for two or more terms, at least one of which must be present in any documents returned in the results. For example, apple pie or poached pear returns documents that contain either apple pie or poached pear (or both).

To use more than one connector in a query, add parentheses around the search terms. For example, (apple or banana) and (pear w/5 grape) returns documents that contain *pear* within five words of grape. Noise words, such as if, the, of, and for are ignored in searches (see "Noise Words Tab" on page 17 for more information).

W/N Connector

Use the **W/N** connector when searching for terms that appear within N words of another term. For example, apple pie w/5 poached pear returns documents that contain apple pie within five words of poached pear. It is recommended that you avoid using the W/N connector in complex search queries as it can produce ambiguous results. For example, avoid queries such as (apple and banana) w/10 (pear and grape) or (apple w/10 banana) w/10 (pear and grape)

**Note:** You can use xfirstword and xlastword to search for terms that are near the beginning or end of a document. For example, apple w/10 xlastword returns documents that contain apple within ten words of the end of a document.

NOT and NOT W/N

Use the **NOT** and **NOT W/N** connectors when you want to exclude documents that contain certain terms. For example, apple pie not poached pear returns documents that contain apple pie but not poached pear. Documents that contain both terms would not appear in the results. Apple pie not w/5 poached pear returns documents that contain apple pie, but excludes documents that contain poached pear within five words of apple pie. Documents that contain both phrases are returned if poached pear is separated by more than five words from apple pie.

SUPPORTED WILDCARD CHARACTERS

You can use the following wildcard characters in Quick and Advanced searches:

<table>
<thead>
<tr>
<th>Wildcard Character</th>
<th>Description</th>
<th>Example</th>
</tr>
</thead>
</table>
| ?                  | Match any character | Query: appl?  
**Results:** Documents that contain terms that start with appl followed by one additional letter, for example, apply and apple. Documents that contain apples would not be returned. |
### Wildcard Character Table

<table>
<thead>
<tr>
<th>Wildcard Character</th>
<th>Description</th>
<th>Example</th>
</tr>
</thead>
<tbody>
<tr>
<td>=</td>
<td>Match any single digit</td>
<td>Query: N==</td>
</tr>
<tr>
<td></td>
<td></td>
<td>Results: Documents that contain terms that start with N followed by three digits, for example, NI23 but not NI234. Document that contain Nabc would not be returned.</td>
</tr>
<tr>
<td>*</td>
<td>Match any number of characters</td>
<td>Query: ap*ed</td>
</tr>
<tr>
<td></td>
<td></td>
<td>Results: Documents that contain terms that start with ap and end with ed, for example, applied and approved.</td>
</tr>
<tr>
<td></td>
<td></td>
<td>Note: It is recommended that you avoid using the asterisk (*) wildcard near the beginning of a word as it can negatively impact the time it takes for Case Logistix to return results.</td>
</tr>
</tbody>
</table>

### Using the Fuzzy Search Wildcard Character

Fuzzy search allows you to search for words with similar spellings, including misspelled words. To enable fuzzy search, add the percent sign (%) to a search term. Add additional percent signs to increase the degree of fuzziness. The placement of the percent signs within a word determines which letters words must start with in order for them to be returned in the results.

For example, ba%nana returns documents that contain words beginning with ba that have no more than a one letter difference from banana. Searching for b%anana returns documents that contain words beginning with b that have no more than a two letter differences from banana. For more information on fuzzy search, see "Configuring Quick Search Settings" on page 48 and "Configuring Advanced Search Settings" on page 50.

### Using the Stemming Wildcard Character

Stemming allows you to search for grammatical variations of a word. To enable stemming, add the tilde symbol (~) to the end of a search term. For example, apply~ returns documents that contain applies, applied, and applying.

### Working with Quick Search

**Note:** If indexing is currently running or the index is not fully up-to-date when you execute a search, a message stating that the results may be incomplete displays next to the Search button (🔍) on the Case Logistix toolbar.

You can use Quick Search to search document text and metadata. To create more complex search queries, use Advanced Search (see "Working with Advanced Search" on page 49 for more information). Before executing a Quick Search, you must choose whether to search metadata fields, document text, or both.

1. Click the arrow next to the Search button (🔍) on the Case Logistix toolbar and select Quick Search Settings.
2. Select the check boxes for the fields you want to search.
4. Under the Search In heading, select from the following options:
   - Entire Library: Search all documents in the library.
5. Click OK.

### Configuring Quick Search Settings

Quick Search settings are automatically applied to subsequent Quick Searches. To configure Quick Search settings, do the following:

1. Click the arrow next to the Search button (🔍) on the Case Logistix toolbar and select Quick Search Settings.
2. Click Settings.
3. You have the following options:
   - **Search For**
     - Any Words: Search for any term in the Quick Search box.
     - All Words: Search for all terms in the Quick Search box.
     - Boolean Search: Apply boolean rules to the search. You must select this option when using boolean connectors in the Quick Search box, for example, mold AND plastic. If you do not enable this option, the And/Or connectors are treated as noise words and are ignored. For more information, see "Noise Words Tab" on page 17.
Search Options

- **Stemming**: Search for grammatical variations of a word. For example, a search for the word apply would also return documents that contain applied, applying, and applies.

- **Phonic**: Search for homophones of a word that start with the same letter. For example, a search for the word Smith would also return documents that contain Smithe and Smythe. Phonic searching is somewhat slower than other types of searches and is often over-inclusive. It is recommended that you only enable phonic searches for individual words by adding the hash symbol (#) to the beginning of a word, for example, #smith.

- **Fuzzy Search**: Search for words with similar spellings, including misspelled words. The fuzzy search slider determines the degree of fuzziness that a word can have in order to be returned in search results. You can specify the degree of fuzziness on a scale of 1 to 10. A higher degree of fuzziness allows for more differences in spelling, and also allows those differences to be closer to the beginning of a word. For more information, see "Supported Search Connectors and Wildcards" on page 47.

- **Synonym Searching**: Search for synonyms of a word. For example, a search for the word fast would also return documents that contain the word quickly. Select the **Related Words** check box to search for related words using WordNet, a lexical database created by Princeton University.

RUNNING QUICK SEARCHES

To run a Quick Search, type terms in the **Quick Search** box on the Case Logistix toolbar and click **Search** or press **Enter**. If you execute a search that returns more than 50,000 documents, a message stating that you must refine your search criteria displays (see "Narrowing Search Results" on page 52 for more information).

USING THE SEARCH IN RESULTS BOX

When you execute a Quick Search, the **Search in Results** box displays at the top of the Document List. You can use the box to further narrow your results by typing terms in the Search in Results box and clicking **Search** or pressing **Enter**.

Working with Advanced Search

**Note**: If indexing is currently running or the index is not fully up-to-date when you execute a search, a message stating that the results may be incomplete displays next to the **Search** button on the Case Logistix toolbar.
Advanced Search allows you to create complex search queries by specifying the terms to search for and the relationship between them. For example, you can use Advanced Search to retrieve documents that contain the term mold within 25 terms of abatement, and that also belong to a particular custodian and are from a particular date range.

CONFIGURING ADVANCED SEARCH SETTINGS

Advanced Search settings are not applied to subsequent searches and must be configured each time you run a search. Alternatively, you can save an Advanced Search and run the query at a later date (see “Creating Saved Searches” on page 53 for more information). To configure Advanced Search settings, click the arrow next to the Search button (🔍) on the Case Logistix toolbar and select **Advanced Search**. You have the following options:

**Search For**
- **Any Words**: Search for any term in the Quick Search box.
- **All Words**: Search for all terms in the Quick Search box.
- **Boolean Search**: Apply boolean rules to the search. You must select this option when using boolean connectors in the Quick Search box, for example, mold AND plastic. If you do not enable this option, the And/Or connectors are treated as noise words and are ignored. For more information, see “Noise Words Tab” on page 17.

**Search Options**
- **Stemming**: Search for grammatical variations of a word. For example, a search for the word apply would also return documents that contain applied, applying, and applies.
- **Phonic**: Search for homophones of a word that start with the same letter. For example, a search for the word Smith would also return documents that contain Smithe and Smythe. Phonic searching is somewhat slower than other types of searches and is often over-inclusive. It is recommended that you only enable phonic searches for individual words by adding the hash symbol (#) to the beginning of a word, for example, #smith.
- **Fuzzy Search**: Search for words with similar spellings, including misspelled words. The fuzzy search slider determines the degree of fuzziness that a word can have in order to be returned in search results. You can specify the degree of fuzziness on a scale of 1 to 10. A higher degree of fuzziness allows for more differences in spelling, and also allows those differences to be closer to the beginning of a word. For more information, see “Supported Search Connectors and Wildcards” on page 47.
• **Synonym Searching**: Search for synonyms of a word. For example, a search for the word fast would also return documents that contain the word quickly. Select the Related Words check box to search for related words using WordNet, a lexical database created by Princeton University.

**SELECTING DOCUMENTS TO SEARCH**

To specify which documents to search, open Advanced Search and click the **Search In** tab below the Term Search tab. You have the following options:

- **Current List**: Search all documents in the Document List.
- **Entire Library**: Search all documents in the library.
- **Selected IntelliFolders or Tags**: Search the documents in selected IntelliFolders or tags. Expand the lists by clicking the arrow next to an IntelliFolder or tag and selecting the check boxes for the IntelliFolders or tags you want to search. When you select a top-level folder, all sub-folders beneath it are automatically selected.

**Note**: The Uncoded sub-folder, for example, Uncoded Custodian, contains all documents that have not been coded for a given field. If you select a top-level IntelliFolder that contains the Uncoded sub-folder, you are effectively searching all documents in the library. For more information, see "Using The Uncoded Sub-folder" on page 42.

**RUNNING ADVANCED SEARCHES**

To access Advanced Search, click the arrow next to the **Search** button (🔍🔍) and select **Advanced Search**.

**Using the Term Search Tab**

You can use the Term Search tab to add search criteria and configure search settings. The Term Search tab contains the following tabs:

- **Text**: Allows you to configure search settings and search document text (see "Using the Text Tab" on page 51 for more information).
- **Fields**: Allows you to search metadata fields (see "Using the Fields Tab" on page 51 for more information).
- **Search In**: Allows you to choose the documents to search (see "Using the Search In Tab" on page 52 for more information).

**Using the Text Tab**

You can use the Text tab to search document text. To search both document text and metadata fields (see "Using the Fields Tab" on page 51 for more information), click the **And** or **Or** connector next to the Search In tab. Click **And** to search for documents that meet the criteria on both tabs. Click **Or** to search for documents that meet the criteria on either the Text or Fields tab.

1. Click the **Text** tab.
2. Configure the Advanced Search settings (see "Configuring Advanced Search Settings" on page 50 for more information).
3. Type terms in the **Terms** box or select terms used in a previous search from the History list (🔍🔍). When you type terms in the Terms box, the Word Count Index displays a list of related terms found in the library. The number next to a term indicates the number of times it appears in a library. Double-click a term in the Word Index to add it to the Terms box.
4. To add terms from a text file, click **Add Terms from List**, browse to the file, and then click **Open**.
5. Type terms that you want to exclude from the search in the **Exclude Documents Containing** box. The Exclude Documents Containing box is enabled when you type terms in the Terms box.
6. Click **Search**. If you execute a search that returns more than 50,000 documents, a message stating that you must refine your search criteria displays (see "Narrowing Search Results" on page 52 for more information).

**Using the Fields Tab**

You can use the Fields tab to search metadata fields. To search both metadata fields and document text (see "Using the Text Tab" on page 51 for more information), click the **And** or **Or** connector next to the Search In tab. Click **And** to search for documents that meet the criteria on both tabs. Click **Or** to search for documents that meet the criteria on either the Text or Fields tab.

1. Click the **Fields** tab.
2. Select a field from the list provided.
3. Type terms in the box provided.
4. To add additional criteria, click **Add Criteria** and repeat Steps 2-3. The new criteria row is connected to the row above it by the AND connector. You can change the connector by selecting OR from the connector list. To remove a criteria row, click the red X next to the fields list. You can also rearrange the order of the rows by dragging them to a new location.
5. To group criteria together (put terms in parentheses), click **Add Group**. Repeat Steps 2-3, then click the **Add Criteria** button within the group to add additional criteria. You can also click **Add Group** to create nested groups.
6. Click **Search**. If you execute a search that returns more than 50,000 documents, a message stating that you must refine your search criteria displays (see "Narrowing Search Results" on page 52 for more information).
Using the Search In Tab

The Search In tab is where you select the documents to search. For more information, see "Selecting Documents to Search" on page 52.

USING THE SQL SEARCH TAB

You can use the SQL Search tab to create SQL queries to search for values in specific database fields. To combine the query with the criteria on the Text and Fields tabs, select the And or Or connector from the Combine with Term Search Criteria using list. Select And to search for documents that meet the criteria on both tabs. Select Or to search for documents that meet the criteria on either the Text or Fields tab.

1. Click the arrows in the Expressions pane to expand the Fields, Operators, and Special lists.
2. Double-click values from the lists to add them to the Query box or select a query used in a previous search from the History list ( ). You can also paste an existing query in the Query box or type values in the box.
3. Click Validate. If the query is invalid, a message stating validation failed displays.
4. Click Search. If you execute a search that returns more than 50,000 documents, a message stating that you must refine your search criteria displays (see "Narrowing Search Results" on page 52 for more information).

Evaluating Search Results

When you run a Quick or Advanced search, Case Logistix displays the documents that meet the search criteria and adds the Hits column to the Document List. The Hits column displays the total number of times a search term appears in a document. If a search term was found in a metadata field and not in document text, the Hits column displays the word DATA.

To view document text search hits, select a document from the Document List, select Hit from the Hit Type list on the Document Viewer toolbar, and then click the Next Hit and Previous Hit buttons to navigate between search hits. Search hits are highlighted in green by default (see "Configuring User Profile Options" on page 9 for more information).

NARROWING SEARCH RESULTS

Case Logistix limits search results to no more than 50,000 documents to facilitate the searching of large libraries. If you run a search that returns more than 50,000 documents, the following message displays:

Your search has returned more than the 50,000 results. Please refine your search terms or use the Advanced Search Fields tab to limit the number of results.

To limit the number of results, search a smaller set of documents, for example, documents in a tag or IntelliFolder. You can also limit your search to documents with specific field values (see "Using the Fields Tab" on page 51 for more information), or to a range of documents. The following example shows how to search a range of documents using the numeric range operator (~~) in Advanced Search:

**Note:** To prevent inaccurate search results, it is recommended that you avoid using the Less Than (<) and Greater Than (>) operators when searching a range of documents.

1. Click the arrow next to the Search button ( ) and select Advanced Search.
2. Configure the Advanced Search settings (see "Configuring Advanced Search Settings" on page 50 for more information).
3. Type terms in the Terms box or select terms used in a previous search from the History list ( ).
4. Click the And connector next to the Search In tab.
5. Click the **Fields** tab.
6. Select **Doc#** from the list provided.
7. Type a numerical range in the box provided, for example, 1~10000.
8. Click **Search**.

**Creating Saved Searches**

You can save and share Advanced Searches with other users. Saved searches that are not shared can only be executed by the user who created the saved search.

1. Click the arrow next to the **Search** button (🔍) on the Case Logistix toolbar and select **Advanced Search**.
2. Configure the search criteria. For more information, see "Working with Advanced Search" on page 49.
3. Click **Save**. Alternatively, click **Search** to execute the search, and then click the arrow next to the **Search** button (🔍) and select **Save Search As**.
4. Type a name in the **Search Name** box.
5. Select the **Share search** check box to share the search with other users.
6. Click **Save**.

**Managing Saved Searches**

You can run, edit, rename, and delete saved searches.

1. Click the arrow next to the **Search** button (🔍) on the Case Logistix toolbar and select **Run/Manage Saved Searches**.
2. You have the following options:
   - **Run a Saved Search**: Select the check box for a saved search and click **OK**. To combine two saved searches, select the check boxes for the searches, click the **And** or **Or** connector under the Combine Searches Using heading, and then click **OK**.
   - **Edit a Saved Search**: Click **Edit**, edit the search criteria as desired, and then click **Save**. Click **Search** to run the edited search without saving it.
   - **Rename a Saved Search**: Select a saved search name, type a new name, and then click **OK**.
   - **Share a Saved Search**: Select the **Shared** check box and click **OK**. Clear the check box to make the search private.
   - **Delete a Saved Search**: Click **Delete**, then click **Yes** to confirm. If you delete a saved search that you created, the search is also deleted for other users.
3. Click **OK**.

**Creating Search Hit Context Reports**

You can use the **Search Hit Context Report** to view the words and paragraphs surrounding each search hit. The report can be used to identify additional search criteria and is only available when searching document text.

1. Execute a Quick or Advanced Search.
2. Click the arrow next to the **Search** button (🔍) on the Case Logistix toolbar and select **View Context Report**.
3. Type a name in the **Report Title** box or accept the default name.
4. Type the number of words or paragraphs to display around each search hit in the **Show Surrounding** box.
5. Select **Words** or **Paragraphs** from the list next to the **Show Surrounding** box.
6. Type a value (in seconds) in the **Maximum Time Limit** box to specify the maximum amount of time Case Logistix should spend generating the report. The report may take a while to generate depending on the number of documents returned in the search and the number of hits within those documents
7. Click **OK**. The report opens in a web browser.
Working with Case Logistix Utilities

Case Logistix includes several utilities that can be used before, during, and after the review process. Refer to the following topics for more information:

Using the Bates Analyzer Utility

The Bates Analyzer Utility identifies invalid Bates ranges and gaps and overlaps in Bates ranges. To access the utility, click the Tools menu and select Bates Analyzer Utility, then choose from the following options:

Bates Fields

Click Use Bates range field (must contain a range with a dash, for example, 00001-00009) or Use separate Bates start and Bates end fields, then select the appropriate fields from the lists provided. For single page documents, the Bates number must be entered for both the Bates Start and Bates End fields.

Bates Grouping

Click Use Bates Prefix and type the prefix in the box provided or click Use Field Value, select a field from the Field Name list, and then type a value in the Value box. An example of the body of the Bates number is required.

Bates Number Format

Type a Prefix, Body, Separator, and Suffix in the boxes provided, if applicable.

After you finish configuring the settings, click Analyze to run the utility. A report titled TestBatesRanges.txt opens in Notepad. The report includes the following information:

- **Invalid Bates Range**: Case Logistix counts the number of pages in a document and compares that to the Bates Start and Bates End values. For example, if there are five pages in a document, but the Bates range is 1–6, Case Logistix lists each failure in the Documents with Invalid Bates Number Ranges section.
- **Overlaps**: Case Logistix locates documents with duplicate Bates numbers and lists them in the Documents with Duplicate Bates Number section.
- **Invalid Bates Number Order**: Case Logistix locates documents that contain Bates numbers in the wrong order and lists them in the Documents with Invalid Bates Number Order section.

Using the Build Markup Utility

The Build Markup Utility allows you to create markup files for one or more documents (image files and Microsoft Office documents) in a library. A markup file is a PDF version of a document and is required if you want to add notes, redactions, and link documents to other documents or notes.

**GENERATING MARKUP FILES FOR NATIVE PDFS**

If you are using Case Production to produce native PDFs, and those files have security restrictions that prevent Case Production from being able to process them, for example, print and editing restrictions, you can select the Generate markups for PDF documents check box to create separate markup files for those documents.

You can then enable the Prefer PDF Markup over Native PDF setting in Case Production to specify that the markup files be used to generate image and associated text files. The Prefer PDF Markup over Native PDF setting is located on the Advanced Job Settings drop-down menu on the Review page of the Production Job Wizard. See the Case Production Help for more information.

**Note**: Case Logistix automatically prompts you to create markup files when you add documents to a library. To create a markup file for a single document, select a document from the Document List and click the Markup Document button on the Document Viewer Mark-up tab.

1. Click the Tools menu and select Build Markup Document Utility.
2. You have the following options:
   - **Full Library**: Create markup files for all documents in the library.
   - **Current List**: Create markup files for all documents in the Document List.
   - **Selected Tag**: Create markup files for all documents in the selected tag.
3. Select the Generate markups for PDF documents check box, if applicable.
4. The Skip PDFs which are not protected check box is selected by default. Clear the check box to generate markup files for all PDFs, including those without security restrictions.
5. Select the Overwrite Current Markup Files check box to replace existing markup files with new ones.
6. The **Do not overwrite existing markup files for documents with redactions or notes** check box is selected by default. Clear the check box to create new markup files for documents that contain redactions or notes.  
   **Note:** It is recommended that you do not rebuild markup files for documents that contain redactions or notes. Rebuilding the markup file could displace the positioning of the redaction or note to the wrong place in the document. If you choose to overwrite the existing markup files, be sure to verify the results.

7. Click **Start**.

**MONITORING THE MARKUP JOB**

You can monitor the markup job and take the following actions on the Progress dialog box:

- **Skip Document:** Skip the current document. Note some file types cannot be skipped once processing has started.
- **Pause Job:** Pause the job after the current document is processed.
- **Cancel Job:** Cancel the build markup job after the current document is processed.

**VIEWING LOG FILES**

After the Build Markup Utility creates the markup files, you can view the job statistics and log files generated by the utility. The log files open in Notepad by default. You can copy the information from the log files into Excel so that you can sort, search, and perform additional calculations. The log files are automatically deleted when you close the Build Markup Job Summary dialog box.

The following log files are available:

- **Success Log:** Contains information on the documents for which markup files were successfully created.
- **Skipped Log:** Contains information on the documents that were skipped.
- **Failed Log:** Contains information on the documents for which markup files could not be generated.
- **Complete Log:** Contains all of the information from the other log files.

**Using the Duplicate Records Utility**

The **Duplicate Records Utility** identifies exact duplicates by comparing the values in a specific set of fields. When you run the utility, documents with the same field values display in the Document List and are added to a My Tag in the Tag Folders panel called **Duplicate Records(<fields>)<date and time>**, for example, **Duplicate Records(Hot Docs) 3/26/2014 2:35:38 PM**.

1. Click the **Tools** menu and select **Duplicate Records Utility**.
2. Select the check boxes for the fields you want to compare.
3. Select the **Included uncoded values** check box, if applicable.
4. Click **OK**.

**Using the Metadata Locator Utility**

The **Metadata Locator Utility** identifies and extracts metadata fields from the documents in a library. You can configure the metadata extraction options from the Metadata Extractor tab on the Index Manager (see "Metadata Extractor Tab" on page 19 for more information).

**WHAT IS METADATA?**

Metadata is information that describes the contents of a document. For example, an image can include metadata that describes the size of the image, the color depth, the image resolution, and when the image was created. A text document's metadata can include information about the length of the document, the name of the original author, when the document was created, and a short summary of the document.

1. Click the **Tools** menu and select **Identify Metadata Fields**.
2. Click **Find Fields**.
3. Select fields from the Available Fields list, then click the right-arrow to add them to the Fields to Be Added list.
4. Specify the documents from which you want to extract and populate metadata (for the selected fields) during indexing from the following options:
   - **New Documents Only**
   - **Current List and New Documents**
   - **Entire Library and New Documents**
5. Click **Create Fields**.
Using the Missing Files Utility

The **Missing Files Utility** identifies document records that have no physical files associated with them. When you run the utility, document records without a corresponding physical file are added to a My Tag in the Tag Folders panel called Documents with Missing Files <date and time>, for example, Documents with Missing Files 3/27/2014 7:21:18 AM.

To access the utility, click the **Tools** menu and select **Missing Files Utility**.

Using the Optical Character Recognition (OCR) Utility

The **Optical Character Recognition (OCR) Utility** creates associated text files from scanned documents (PDFs) and image files. The utility is intended for small jobs, individual documents, or for documents with associated text files that are missing text from the original document.

**WHAT IS OCR?**

Optical Character Recognition (OCR) is a technology that extracts text from a scanned document or digital image. For example, you can take a picture of a stop sign, add it to Case Logistix, OCR it, and then search for Stop to find the document. Without OCR, you can still add the image to Case Logistix, but the image is just an image. You can annotate the image, but if the court has ordered you to turn over all documents with the word Stop in them, you would want Stop to be a searchable term that you can easily find, tag, and code. OCR provides the solution.

Case Logistix automatically prompts you to run OCR when adding documents to a library. You can also run OCR by clicking the **OCR Document** button (OCR) on the Document Viewer toolbar.

**Note:** The OCR utility can create associated text files from TIFF files (Tagged Image File Format) that are 8-bit black and white or grayscale.

1. Click the **Tools** menu and select **OCR Image Utility**.
2. You have the following options:
   - **Full Library:** Run OCR on all image files in the library.
   - **Current List:** Run OCR on all image files in the Document List.
   - **Selected Tag:** Run OCR on all image files in the selected tag.
3. Select the **Overwrite Current Text Files** check box to create new associated text files for image files that have already been OCR'd.
4. Select the **Use Markup Files for Protected PDF Files** check box to use the markup file to create text files for password protected PDFs. If the OCR utility is unable to locate the markup file or a markup file does not exist, a message asking whether you want to skip the document displays. Select the **Skip all PDF documents that are missing markup files** check box, if applicable, then click **Yes** to confirm.
5. Click **Start**.

To verify that a document was successfully OCR'd, click the **Toggle Split View** button ([ ]) at the bottom of the Document Viewer to view the image and text file in split screen mode.

Using the Orphan Files Utility

The **Orphan Files Utility** identifies orphan files in a library. Orphan files are physical files that do not have document records associated with them. When you run the utility, Case Logistix opens a report in Notepad titled OrphanFiles.txt that lists all orphan files and their respective locations.

1. Click the **Tools** menu and select **Orphan Files Utility**.
2. Type the path to the folder where you want to save the results, or click the ellipsis, browse to a folder, and then click **OK**.
3. Select the **Create batch file to delete orphan files** check box to create a batch file that allows you to delete the orphan files. The batch file is saved to the output folder specified in Step 2.
4. Click **OK**.

**Note:** Depending on the contents of the library, you might want to consider retaining the orphan files. For example, if you have document records for physical evidence and no corresponding electronic file, you may want to retain the document records even though they have been identified as orphan files.
Printing Documents

The Print Document Wizard allows you to print selected documents from the Document List, all documents in the Document List, or all documents in a library. When you configure the print settings and click Next, you are presented with additional options based on your selections. For example, if you choose to include an endorsement, you are given the option to specify the endorsement text and its location on the page.

To access the Print Document Wizard, click the File menu and select Print Document. You have the following options:

SELECT DOCUMENTS TO PRINT
- Selected Documents: Print the selected documents.
- Current List: Print all documents in the Document List.
- Entire Library: Print all documents in the library.

PAGES TO PRINT
- All Pages: Print all pages.
- Current Page: Print the current page only. The current page in a document is the page displayed in the Document Viewer Mark-up tab. This option is only available when the Mark-up tab is selected.
- Pages from _ to __: Print a range of pages. Type the page number of the first and last page you want to print in the boxes provided.

PRINTING OPTIONS
- Copies: Specify how many copies of each document to print. Use the arrows to increase or decrease the number of copies.
- Print Redactions: You can configure redaction settings on the Redaction Options page. When you print redactions, you have the option to choose which redaction codes to print, as well as the Background Color, Border Color, and Text Color of the redactions. All redaction codes are selected by default.
- Print Annotation Highlights: Select this check box to enable the Include Note Text option.
- Include Note Text: Include note text in the page footer. Document Notes are prefaced by the word [doc] and are listed before Anchor and Transcript notes in the footer. If the notes do not fit in the page footer, a new page is added for the remaining notes.
- Scale Font to Paper Size: Increase or decrease the size of the note text based on the page size. For example, note text on a 24x36 page may be larger than note text on a letter-sized page.

PRINTING NOTES
Please note the following when printing document, anchor, and transcript notes:

- If you do not have View Notes rights, the Print Annotation Highlights and Include Note Text check boxes are disabled. See the Library Designer Help for more information.
- Each note's position on the page is highlighted and numbered in the left margin of the page. The notes are numbered sequentially based on the order (top to bottom) in which they are found on the page. The number increases incrementally across all pages (that is, the numbers do not reset on each page). A black border separates the left margin from the rest of the document.
- Documents that contain notes are scaled to 90% of their original size to create additional space in the left margin and in the page footer. However, if the original document is smaller than the paper size, the document is printed using its actual size instead of scaling to fit the page.
- If all or a portion of an Anchor or Transcript Note has been redacted, the redacted portion is not printed on the page. Instead, the redacted text is printed in the page footer.
- Private notes only print if the user who created the print job has access to the note.

- Print Endorsements: You can configure endorsement settings on the Endorsement and Watermark Options page. To specify the location of the endorsement, click the Set button that corresponds to the location on the page where you want the endorsement to display. Use the Format Expression Builder to create the endorsement text.
- Print Watermark: Case Logistix allows you to use .jpeg and .gif images for watermarks.
- Print Attachments: Include attachments. Attachments are printed as separate documents. For example, if a document has two attachments, a total of three documents (the parent document and the two attachments) are printed.

BATCH OPTIONS
- Print Separator Page: The separator page prints before each document and contains identifying information, such as the filename and document number. You can use the separator page templates included with Case Logistix, or you can create your own template. Type the path to the separator template in the box provided, or click the ellipsis to browse to the file. If
you accepted the default path when you installed Case Logistix, the templates are located in C:\Program Files (x86)\Westlaw CaseLogistix\Westlaw CaseLogistix\Separator Templates.

- **Print Batch Log**: The batch log contains information about the print job. The success section includes the document master number, number of pages printed, number of redactions printed, and so forth. The failure section includes the file name, document number, and the reason the document failed to print. Click **View Log** after the print job is complete to open the batch log. The log is stored in your user-specific temp directory.
- **Halt if document fails to print**: Stop printing if a document fails to print.
- **Halt if preprocess fails (i.e. endorsement)**: Stop printing if a document fails to preprocess.
- **Halt if unable to convert document to PDF**: Stop printing if a document fails to convert to PDF.

After you finish configuring the print settings, click **Finish** to start the print job.
Using the Format Expression Builder

The Format Expression Builder allows you to construct an expression for endorsements or other outputs such as notes reports.

Building an Expression

Build an expression by typing text in the text box and by selecting values from the Special Values and Field Values lists. When you select a value, the value displays in both the text box and Sample box. The text box displays the name of the value. The Sample box displays the actual value that appears in the final output.

To move the cursor down a line in the text box, click New Line. Click Clear to remove the expression from the text box.

Note: When you first open the Format Expression Builder, some information may be filled in by default. Additionally, Case Logistix saves the last expression entered in the Format Expression Builder. Click Clear to remove this content.

Selecting a Special Value

Click the arrow to the left of Special Values to expand the list. Click a value to view its description. Double-click a value to add it to the expression.

Some values allow you to add additional information, for example, a Starting #. Add the value to the expression, click the value name in the text box, and then type the appropriate values in the boxes provided. You can add the following information to these special values:

- #Document Number#: Padding and Starting #
- #Document Page Number#: Padding and Starting #
- #Batch Page Number#: Padding and Starting #
- #Document Label#: Padding and Starting #
- #Folder Name#: Root Folder and Folder Level #

Selecting a Field Value

Click the arrow to the left of Field Values to expand the list. Click a value to view its description. Double-click a value to add it to the expression.
14 Producing Documents

You can use Case Production, a separately licensed application in the Case Logistix suite, to produce the documents in a library. See the Case Production Help for more information.

Preparing for a Production

Before sending documents to Case Production, be sure to complete the following tasks:

- Organize the documents you plan to produce using Tags. Keep in mind that you can apply multiple tags to a document. Applying multiple tags can be useful if you plan on using slightly different sets of documents for multiple productions.
- Redact sensitive and confidential information from the documents. For more information, see "Working with Redactions" on page 34.
- Create markup files for all non-native PDF documents. You must create markup files if you plan on producing documents with endorsements and redactions. For more information, see "Using the Build Markup Utility" on page 54.
- Verify that page counts exist and are correct for
- Verify that the documents you plan on producing have correct page counts. To update page counts, click the View menu, select Folder Information for <library name>, and then click Update.
Case Logistix Analytics analyzes text and metadata to determine how closely related documents are to one another. Analytics automatically identifies and groups documents by email thread, cluster, near duplicates, and exact duplicates. After you run the Case Logistix Analytics Wizard, you can use the grouping options in Case Logistix to view documents by email thread, cluster, and so forth (see "Grouping Documents" on page 22 for more information).

For more information on Case Logistix Analytics, contact a sales representative at 1-888-728-7677.

Setting up Case Logistix Analytics

The first step in setting up Case Logistix Analytics is to install the Analytics Server. See the Case Logistix Analytics Installation Guide for more information.

After you install the Analytics server, you can connect a library to the server using Library Designer. See the Library Designer Help for more information.

SPECIFYING THE JOB STORAGE LOCATION

Before you can run Analytics jobs, you must specify the job storage location for the analytics files using the Analytics Administration website. The Analytics Administration site allows you to manage your analytics jobs and view error logs. The site uses the following URL format:

http://<servername>/analytics

To access the site, open a web browser, type the server address in the Address bar and press Enter.

Note: You might need to disable IE Enhanced Security Configuration (IE ESC) for Administrators. Open Server Manager and select Configure IE ESC in the Security information summary.

1. Click the Storage tab.
2. Click New Storage.
3. Type the storage name and path in the boxes provided.
4. Click Update.

CONFIGURING ANALYTICS GROUPING AND SORTING OPTIONS

Analytics uses fields to communicate with Case Logistix. When you enable grouping mode in the Document List, Case Logistix groups and sorts each document group using the values obtained from the Analytics fields. For more information, see "Grouping Documents" on page 22.

DEFAULT ANALYTICS FIELDS

Warning: Do not experiment with the Analytics field settings. Only someone who understands the implications of changing the default fields should make changes. If you change the default fields, the new fields must have the same data type as the default fields. For example, if you change the field for CLX Cluster Title, the new field must have a data type of varchar(900).

To view the default grouping and sorting fields, start Library Designer, double-click Library Properties, and then click the Related Documents tab. The following table lists the default Analytics grouping and sorting fields:

<table>
<thead>
<tr>
<th>Field Name</th>
<th>Data Type</th>
<th>Purpose</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Near Duplicates</td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>CLX NearDupe Group</td>
<td>VarChar(900)</td>
<td>Grouping Field</td>
<td>Displays a unique value for each near duplicate group.</td>
</tr>
<tr>
<td>CLX NearDupe Sort</td>
<td>Integer</td>
<td>Primary Document Field</td>
<td>Displays a value that indicates the order in which the documents in each near duplicate group display. The value for the principal document in a group is always 1.</td>
</tr>
<tr>
<td>CLX NearDupe Similarity</td>
<td>Decimal</td>
<td>% Duplicate Field</td>
<td>Displays the near duplicate score for each document in a near duplicate group.</td>
</tr>
</tbody>
</table>
### Using the Case Logistix Analytics Wizard

You can configure analytics job settings using the Analytics Wizard. To access the Analytics Wizard, you must be granted **Process Analytics** rights by an administrator. See the Library Designer **Help** for more information.

**Note**: You can also access the Analytics Wizard after importing files into WayPoint.

1. Click the **Analytics** menu and select **Analytics Wizard**.
2. You have the following options:
   - **Near Duplicates**: Identify documents that contain similar text.
     - **Process entire library**: Analyze all documents in the library.
     - **Process current list**: Analyze the documents in the Document List.
   - **Clustering**: Identify documents that are conceptually similar to one another.
     - **Process entire library**: Analyze all documents in the library.
     - **Process current list**: Analyze the documents in the Document List.
   - **Email Threading**: Identify emails that belong to the same conversation.
   - **Delete the converted email cache before starting jobs**: Email (.msg) files must be converted to text files before they can be uploaded to the Analytics server. Analytics automatically generates the files and stores them in the Analytics folder located in the library file share directory. This setting allows you to delete and then recreate the cached text files. It is recommended that you leave this setting disabled to improve performance; however, you might want to enable it if you modify the documents in the library or delete a large number of documents.

**Warning**: Do not enable the delete email cache setting if there are Analytics jobs currently running as it may corrupt those jobs and cause them to fail.

3. Click **Next**.
4. Choose how near-duplicate documents are identified from the following options:
   - **Search Method**
     - **Comprehensive search for near duplicates (slower)**: Compares all words against all primary near-duplicate documents.
     - **Optimize search for near duplicates (faster)**: Compares whole sentences against the first primary near duplicate document. This is the recommended setting.
   - **Documents must be at least ___ percent similar**: It is recommended that you accept the default value (90%).
5. Click **Next**.
6. Choose how clusters are identified from the following options:
   - **Terms per IntelliFolder title**: The number of terms displayed in the title of the cluster IntelliFolder. You can display up to ten terms in a title.
   - **Number of sub-folders**: The number of levels (sub-folders) displayed in the IntelliFolder. You can display up to four levels.
7. Click **Next**.
8. Verify the analytics settings are correct, then click **Next** to start the analytics job. If errors are encountered, click the **View Errors** link to display a list of errors.
9. Click **Load Selected**, then click **OK**.

**Excluding Terms from Cluster Titles**

Case Logistix Analytics allows you to exclude specific terms from cluster titles. For example, if a library contains emails from only one company, you can exclude that company's name from appearing in cluster titles.

1. Click the **Analytics** menu and select **Excluded Cluster Terms**.
2. Type the terms you want to exclude in the box provided. Each term must be on a separate line.
3. Click **OK**.
Dashboard Utilities contains three sets of additional functionality for Case Logistix:

- **The Dashboard**: A collection of administrative tools and reports for administrators and reviewers. For more information, see “Admin Dashboard Tools” on page 68 and “User Dashboard Tools” on page 65.
- **The Batching Utility**: Utility that allows you to create and manage batches. For more information, see “Batching Utility” on page 64.
- **The Batching User Filtering Utility**: Utility that allows you to filter the Document List so that reviewers only see the documents in their assigned batches. For more information, see “Batching User Filtering” on page 80.

Troubleshooting Dashboard Utilities

If you receive a message that states User Dashboard Tools or Admin Dashboard Tools are unavailable, you need to either install the Dashboard Utilities or connect the Dashboard Utilities to the current library. For more information, see the Dashboard Utilities Installation Guide.

Batching Utility

The Batching Utility consists of several tools for creating and managing batches. The tools can be used to create quality check (promotion and completion) rules and reports for monitoring batches within the overall review process.

**BATCHING EXAMPLES**

The following examples describe simple and advanced batching scenarios:

**BATCHING SCENARIO (SIMPLE)**

A simple batching scenario is to create groups of documents to prevent users from accidentally reviewing the same document twice. The following diagram shows the workflow for this scenario:

- An administrator performs the tasks of creating batches and assigning batches to reviewers. Assigning batches to reviewers is an optional step as reviewers can assign themselves a batch to work if they do not have one already assigned to them.
- Each reviewer can perform the tasks of getting a batch, reviewing a batch, and completing a batch.
- If the batching filter is installed, reviewers can only see the documents in the batches assigned to them. If the filter is not installed, reviewers should use the BatchAssignedTo Intellifolder to work on the documents in their assigned batches. For more information, see "Batching User Filtering" on page 80.

**BATCHING SCENARIO (ADVANCED)**

An advanced batching scenario is to use a multi-step review workflow with quality check rules to control whether documents are promoted to the next status. The following diagram shows the workflow for this scenario:
In the above workflow, there are four batch statuses: Initial Review, Issue Review, Key Document Review, and Complete. Each status has a Completion rule and Promotion rule. When a reviewer finishes a step, the rules are run to update the document status.

- If a document passes the completion rule, its status is set to Complete. The completion rule runs before the promotion rule.
- If a document passes the promotion rule, its document status is set to the next status.
- If a document fails the promotion rule, it remains at the current status.

After the completion and promotion rules have been run, the batch status is set:

- If the status of all documents is Complete, the batch status is set to Complete.
- If all of the documents are moved to the next status, the batch is also set to the next status.
- If one or more documents remain at the current status, the batch also remains at the current status.

**BATCHING ITEMS CREATED DURING INSTALLATION**

The following batching items are created when you install Dashboard Utilities:

**Fields**

The fields listed in the following table should be read-only for all security groups. Changing the fields to read-only prevents users from accidentally changing batch values outside of the batching tools.

<table>
<thead>
<tr>
<th>Field Name</th>
<th>Field Type</th>
<th>Length</th>
<th>Purpose</th>
</tr>
</thead>
<tbody>
<tr>
<td>BatchID</td>
<td>Varchar</td>
<td>128</td>
<td>Contains the name of the batch to which a document is assigned.</td>
</tr>
<tr>
<td>BatchStatus</td>
<td>Varchar</td>
<td>256</td>
<td>Contains the current batch status.</td>
</tr>
<tr>
<td>BatchDocumentStatus</td>
<td>Varchar</td>
<td>256</td>
<td>Contains the current document batch status.</td>
</tr>
<tr>
<td>BatchAssignedTo</td>
<td>Varchar</td>
<td>128</td>
<td>Contains the user name of the currently assigned reviewer.</td>
</tr>
<tr>
<td>BatchLastAssigned</td>
<td>Varchar</td>
<td>128</td>
<td>Contains the user name of the previously assigned reviewer.</td>
</tr>
</tbody>
</table>

**IntelliFolders**

- **BatchID**: Contains sub-folders for each batch. Batches are listed by name (BatchID).
- **BatchAssignedTo**: Contains nested sub-folders for each reviewer that has an assigned batch. Top-level sub-folders are listed by reviewer. The (Uncoded BatchAssignedTo) sub-folder contains batches that do not have an assigned reviewer.
- **Batch Status**: Contains sub-folders for each of the current batch states. Only the states that have batches associated with them are listed.
- **Batch ID**: Contains sub-folders for each batch assigned to the reviewer. Batches are listed by name (BatchID).
- **Batch Document Status**: Contains sub-folders for each batch status. Only the states that have documents associated with them are listed.

**Editors**

- **Batching Editor**: A read-only editor that displays the batching values for selected documents.

**User Dashboard Tools**

User Dashboard Tools is a collection of administrative tools and reports.

To access **User Dashboard Tools**, click the **Tools** menu and select **User Dashboard Tools**. User Dashboard Tools contains the following tools and reports:

**BATCH REPORTS**

For more information, see "Batching Utility" on page 64.

**Review Status Chart**

The Review Status Chart provides a quick look at the progress of a review by listing the batch status of all batched documents.

1. Click the **Tools** menu and select **User Dashboard Tools**.
2. Click the **Batch Reports** tab.
3. Click **Review Status Chart**.
Batching Chart

The **Batching Chart** displays the total number of documents in the library, total number of batched documents, and the total number of documents in each batch state.

To access the Batching Chart, do one of the following:

- Click the **Admin** menu and select **Admin Dashboard Tools**. Click the **Batching Admin Tools** tab, and then click **Batching Chart**.
- Click the **Tools** menu and select **User Dashboard Tools**. Click the **Batch Reports** tab, and then click **Batching Chart**.

Batch Status Report

The **Batch Status Report** provides an overview of the batches in a library. The report includes the current status, assigned reviewer, number of documents in each batch, and so forth.

To access the Batch Status Report, do one of the following:

- Click the **Admin** menu and select **Admin Dashboard Tools**. Click the **Batching Admin Tools** tab, and then click **Batch Status Report**.
- Click the **Tools** menu and select **User Dashboard Tools**. Click the **Batch Reports** tab, and then click **Batch Status Report**.

Reviewer Status Report

The **Reviewer Status Report** lists the review status and total number of documents assigned to reviewers.

**Note:** The Reviewer field is empty for unassigned documents.

1. Click the **Tools** menu and select **User Dashboard Tools**.
2. Click the **Batch Reports** tab.
3. Click **Reviewer Status Report**.

Batch History Report

The **Batch History Report** lists all activities that have occurred for a given batch. The activities listed are Created, Assigned, QA Failed, Updated # Documents, Completed, and Released.

1. Click the **Admin** menu and select **Admin Dashboard Tools**.
2. Click the **Batching Admin Tools** tab.
3. Click **Batch History Report**.
4. Select a batch from the batch list. The report includes the following details:
   - **BatchID:** Name of the batch.
   - **Date:** Date and time of the action.
   - **Performer:** User who initiated the action.
   - **Action:** Action that occurred.
   - **Batch Assigned To:** User to whom the batch is assigned.
   - **Batch Start Status:** Batch status at the start of the action.
   - **Batch End Status:** Batch status after the action was completed.

BATCHING USER TOOLS-ALL LEVELS

For more information, see “Batching Utility” on page 64.

Batching User Tools (My Batches)

The **My Batches** tool allows you to view the batches assigned to you, update batches, mark batches as complete, release batches (make it available to other reviewers), and assign yourself new batches.

1. Click the **Tools** menu and select **User Dashboard Tools**.
2. Click the **Batching User Tools-All Levels** tab.
3. Click **My Batches**.
4. Select a batch from the My Assigned Batches list, and then choose from the following options:
   - **Update Batch:** Run the Completion and Promotion rules on the documents in the selected batch. If a document passes either rule, the document batch status updates, but the batch state remains the same. The updated document batch status is reflected in the sub-folders under the **BatchAssignedTo** IntelliFolder. The sub-folders allow you to view documents that are in a specific batch state.
   - **Mark Complete:** Run the Completion and Promotion rules for the current batch status.
     - If all documents pass the Completion rule, the batch status is set to complete.
     - If all documents pass the Promotion rules, the batch status is set to the next state.
- If any document fails either the Completion or the Promotion rules, the batch status remains the same.
- If there are no Completion or Promotion rules, the batch is automatically promoted to the next state.

**Note:** When you complete or update a batch, a QA Details section displays with information about the number of documents that were promoted, marked complete, or failed. Click **Batch Rule Report** to view details on the rules and field values for the documents in the batch. For more information, see "Batch Rule Report" on page 67.

- **Release Batch**: Move the batch to the Available Batches list. The batch status does not change.
- **Assign Batch**: Select a batch from the Available Batches list and click **Get Batch** to assign it to yourself.

### My Batch Status Chart
The **My Batch Status Chart** displays the status of a reviewer's batches. The chart includes the total number of batched documents assigned to the reviewer, the name and status of each assigned batch, and the total number of documents in each batch state.

**Note:** Each batch has its own bar for each batch state. For example, if you're assigned two batches and the state for each batch is 1-Initial Review, you would see two bars for each of the two batches.

1. Click the **Tools** menu and select **User Dashboard Tools**.
2. Click the **Batching User Tools-All Levels** tab.
3. Click **My Batch Status Chart**.

### Batch Rule Report
The **Batch Rule Report** allows reviewers to view the results of the Completion and Promotion rules for the documents in their assigned batches. The report lists whether a document passed or failed the promotion and completion rules, and includes the coded field value for the field associated with each promotion or completion rule. Reviewers can only generate a report for the batches assigned to them.

For example, if the criteria for a promotion rule is that the Responsive field be coded as 1-Responsive, then all documents that passed the rule have 1-Responsive as the value for the Responsive field. If a document did not pass, the current value of the Responsive field is listed instead. If no value exists for the field, NULL displays.

**Note:** The fields associated with the each completion and promotions rule only display if the field name is contained within brackets [ ] in the rule criteria. For more information, see "Save Batch QC Rules" on page 78.

1. Click the **Tools** menu and select **User Dashboard Tools**.
2. Click the **Batching User Tools-All Levels** tab.
3. Click **Batch Rule Report**.
4. Select a batch from the batch list.

### REPORTS
- **User Productivity Chart**: A bar chart that displays information about the tasks users performed.
- **User Hours (approx.) Chart**: Allows you to view the activity hours for all users on a particular day (see "User Hours (approx.) Chart" on page 71 for more information).
- **Database Overview Report Chart**: Lists the total number of documents in the Library, the number of batched and unbatched documents, and the respective status of the batched documents - 1-Initial Review, 2-Issue Review, 3-Key Documents, and 4-Complete (see "Database Overview Report Chart" on page 71 for more information).
- **User Productivity Report**: A more detailed version of the User Productivity Chart. The report includes the number of fields and tags modified by a user, the number of documents viewed, Tags selected and cleared, and Fields updated and cleared for the life of the library (see "User Productivity Report" on page 72 for more information).
- **Field Populated & Null Count Report**: Lists all fields in the library, the number of documents for which the field is populated, and the number of documents for which the field is Null (see "Field Populated & Null Count Report" on page 72 for more information).
- **Custom Reports**: Allows you to create custom reports that list all values for specific fields and documents (see "Custom Report" on page 73 for more information).

### USER TOOLS
- **Field Value Report**: Lists the field values and document counts for each value within a selected field (see "Field Value Report" on page 71 for more information).
- **Search Tags**: Allows you to create SQL queries to search for documents in specific tags (see "Using the Search Tags Utility" on page 71 for more information).
Admin Dashboard Tools

Admin Dashboard Tools is a collection of advanced administrative tools and reports.

To access Admin Dashboard Tools, click the Admin menu and select Admin Dashboard Tools. You must have administrator rights to access the Admin menu. Admin Dashboard Tools contains the following tools and reports:

**ADMIN REPORTS**

- **User Productivity Chart**: A bar chart that displays information about the tasks users performed.
- **User Hours (approx.) Chart**: A bar chart that displays the productive hours of a user. For more information, see "User Hours (approx.) Chart" on page 69.
- **Database Overview Chart**: A bar chart that displays configurable values that can monitor the progress of a review. For more information, see "Database Overview Report Chart" on page 69.
- **Logged In Users Reports**: These two reports respectively display the list of current Case Logistix users for the library or the Case Logistix system. For more information, see "Logged In Users Reports" on page 71.
- **User Productivity Report**: A row report that contains user productivity information (documents viewed, fields coded, tags set). For more information, see "User Productivity Report" on page 69.
- **Distinct Users Per Day Report**: Displays a report that shows the number of users who accessed the library per day. For more information, see "Distinct Users Per Day Report" on page 72.
- **Field Populated & Null Count Report**: A row report that displays a row for each field in the library that specifies the field name, number of documents for which the field is populated, and the number of documents for which the field is Null. For more information, see "Field Populated & Null Count Report" on page 70.
- **Document Notes Report**: A row report that contains the note count for each document. For more information, see "Document Notes Report" on page 73.
- **Tag Count Report**: A row report that contains the tag count for each document. For more information, see "Tag Count Report" on page 73.
- **User Tag Count Report**: A row report that contains user and tag information. For more information, see "User Tag Count Report" on page 73.
- **Custom Report & Custom Report Executer**: The Custom Report tool allows a custom report to be defined and executed. It can be saved, and users can execute the report with the Custom Report Executer.
- **Load Report**: Allows the documents to be summed for individual values within a field. The best example is Load Reports where a field such as Load Volume contains the volume that contains the documents and this report is used to sum the documents for the values in the Load Volume field so document counts can be checked.
- **Login History Report**: Displays a report that shows all users who have logged into the library, their first login date and time, the last login date and time, and the total number of times they have logged in. For more information, see "Login History Report" on page 73.
- **Document File Report**: A row report with lists the files for each specified document. For more information, see "Document File Report" on page 73.
- **Tag Detail Report**: Displays an Excel report that lists the tags, document count, tag sharing property, the user or workgroup, if appropriate, and if family tagging is enabled for the tag. For more information, see "Tag Detail Report" on page 74.
- **Document Tags Report**: Lists all the tags within each document.

**ADMIN TOOLS**

- **View Library Designer**: A read-only version of Library Designer that allows you to review the design of the Case Logistix library. For more information, see "View Library Designer" on page 74.
- **Define Quick Codes**: Allows reviewers to code a single field that can be used to populate other fields.
- **Manage Tags**: Allows tags to be managed and reassigned to workgroups or a different user than the one who created it.
- **Identify Duplicates**: Allows you to identify duplicate documents, based on fields in the Library. For more information, see "Identify Duplicates" on page 74.
- **Link Attachments**: Allows attachments to be linked to the parent document. For more information, see "Link Attachments" on page 75.
- **Store Attachment Range**: Builds the attachment range for a set of documents, allowing the document identifier to be chosen and the attachment start and end fields. For more information, see "Store Attachment Range" on page 75.
- **Create Editor**: Quickly builds a read-only editor by select fields. The editor can be edited in Library Designer. For more information, see "Create Editor" on page 75.
- **Apply Quick Code**: Allows you to apply quick codes to documents.
- **Manage Tag Custom URL**: Replaces the default dashboard page of a tag with the URL provided.
- **Identify Family Groups**: This sets a field for all the documents in the family to a specific value, allowing the Data Propagation tool to be used on the family. For more information, see "Identify Family Groups" on page 75.
• **Update Intellifolder Static Values**: Updates the static values displayed in the Intellifolder with values contained in the field associated with the Intellifolder. For more information, see "Update Intellifolder Static Values" on page 76.

• **Create Intellifolders**: Provides a method for creating an Intellifolder without accessing Library Designer. For more information, see "Create Intellifolders" on page 76.

• **Gather Family Into Tag**: Pulls the family into the tag if one or more members are in the tag.

• **Copy Tag to Field**: Allows a field to be set to a value based on whether a selected tag is set for the document. For more information, see "Copy Tag to Field" on page 76.

• **Propagate Duplicate Data**: Allows Data (fields, tags, notes, redactions) to be propagated from the Primary document to the duplicates. For more information, see "Propagate Duplicate Data" on page 76.

• **Configure Database Overview Report**: Allows the definition of items to be created and saved. These are displayed on the Database Overview Report. For more information, see "Configure Database Overview Report" on page 77.

• **Delete Markup Object**: Allows you to delete redactions and notes.

### BATCHING ADMIN TOOLS

For more information, see "Batching Utility" on page 64.

#### User Hours (approx.) Chart

The **User Hours (approx.) Chart** lists the activity hours for all users during a specific date range. The times listed in the chart represent the first and last time a user edited a document on a specific date. The chart does not account for periods of inactivity throughout the day.

1. Do one of the following:
   - Click the **Tools** menu and select **User Dashboard Tools**, click the **Reports** tab, and then click **User Hours (approx.) Chart**.
   - Click the **Admin** menu and select **Admin Dashboard Tools**, click the **Admin Reports** tab, and then click **User Hours (approx.) Chart**.
2. Select the start date and end date from the Start Date and End Date calendars.
3. Select the sort order from the **Sort Order** list. Select **User then Date** to sort by user. Select **Date then User** to sort by date.
4. Click **Update Report**.

#### Database Overview Report Chart

The **Database Overview Report Chart** displays the total number of documents in the library, the number of batched and unbatched documents, and the respective status of the batched documents. The default batch statuses are 1-Initial Review, 2-Issue Review, 3-Key Documents, and 4-Complete.

You can customize the items on the report using the Configure Database Overview Report (see "Configure Database Overview Report" on page 77 for more information). For example, you can add counts for documents coded as 1-Responsive and label them as Responsive Docs. To view the Database Overview Report Chart, do one of the following:

- Click the **Tools** menu and select **User Dashboard Tools**, click the **Reports** tab, and then click **Database Overview Report Chart**.
- Click the **Admin** menu and select **Admin Dashboard Tools**, click the **Admin Reports** tab, and then click **Database Overview Chart**.

#### User Productivity Report

**Note**: The User Productivity Report only displays the number of fields and tags that were modified, and not the number of documents like the User Productivity Chart.
The **User Productivity Report** is a more detailed version of the User Productivity Chart. The report includes the number of fields and tags that were updated by a user, the number of documents viewed, the number of tags applied and removed from documents, and so forth. Columns that contain #### are too small to display data and must be resized.

1. Do one of the following:
   - Click the Tools menu and select User Dashboard Tools, click the Reports tab, and then click User Productivity Report.
   - Click the Admin menu and select Admin Dashboard Tools, click the Admin Reports tab, and then click User Productivity Report.
2. Select a date range from the Date Range list.
3. Select a user or workgroup from the User list.
4. Select a value to group data in the report by from the First list. To include a secondary grouping order, select a value from the Second list. For example, to view all data for each selected user by day, select User from the First list and Day from the Second list.
5. Click Run Report.

**Field Populated & Null Count Report**

The **Field Populated & Null Count Report** lists all of the fields in a library, the number of documents for which each field is populated with a value, and the number of documents for which the field value is NULL.

To access the report, click the Admin menu and select Admin Dashboard Tools, click the Admin Reports tab, and then click Field Populated & Null Count Report.

**Custom Report**

The **Custom Report** tool allows you to create a report that lists the values for selected fields and documents. Only unique value combinations display in the report. For example, if you run the report on the Custodian and Responsive fields, and multiple documents are coded with Gil Bower in the Custodian field and 1-Responsive in the Responsive field, only one row displays in the report.

1. Click the Admin menu and select Admin Dashboard Tools.
2. Click the Admin Reports tab, then click Custom Report.
3. Select a tag from the Documents in Tag list. Select Entire Library to run the report on all documents in the library.
4. Select a saved report from the Defined Reports list, if applicable.
5. Select fields from the Fields column, then click Add to add them to the Report Fields column. You can order the fields in the Report Fields column by clicking Move Up or Move Down.
6. Type a name for the report in the Report Name box. The report name is required if you plan on saving the report definition.
7. You have the following options:
   - **Save Report**: Saves the report.
   - **Update Report**: Updates the selected Report Definition.
   - **Delete Report**: Deletes the selected Report Definition.
Field Value Report

The Field Value Report lists the values and document counts for each value within a selected field. The report can help you understand which values are contained within a field when creating Quick and Advanced searches (see "Working with Search" on page 47 for more information).

1. Click the Tools menu and select User Dashboard Tools.
2. Click the User Tools tab, then click Field Value Report.
3. Select a tag from the Tag list.
4. Select a field from the Field list.

Using the Search Tags Utility

You can use the Search Tags utility in Case Logistix Dashboard Utilities to create a SQL query to search for documents in specific tags. After you create the query, you can paste it in the Query box on the SQL Search tab in Advanced Search.

1. Click the Tools menu and select User Dashboard Tools.
2. Click the User Tools tab, then click Search Tags.
3. Select the tags to include in the query from the Shared Tags list under the Tags to Include heading.
4. Select the tags to exclude from the query from the Shared Tags list under the Tags to Exclude heading.
5. Click the And or Or connector next to the Combine Included Tags with heading.
6. Click Copy Advanced Syntax to Clipboard.

User Hours (approx.) Chart

The User Hours (approx.) Chart lists the activity hours for all users during a specific date range. The times listed in the chart represent the first and last time a user edited a document on a specific date. The chart does not account for periods of inactivity throughout the day.

1. Do one of the following:
   a. Click the Tools menu and select User Dashboard Tools, click the Reports tab, and then click User Hours (approx.) Chart.
   b. Click the Admin menu and select Admin Dashboard Tools, click the Admin Reports tab, and then click User Hours (approx.) Chart.
2. Select the start date and end date from the Start Date and End Date calendars.
3. Select the sort order from the Sort Order list. Select User then Date to sort by user. Select Date then User to sort by date.
4. Click Update Report.

Database Overview Report Chart

The Database Overview Report Chart displays the total number of documents in the library, the number of batched and unbatched documents, and the respective status of the batched documents. The default batch statuses are 1-Initial Review, 2-Issue Review, 3-Key Documents, and 4-Complete.

You can customize the items on the report using the Configure Database Overview Report (see "Configure Database Overview Report" on page 77 for more information). For example, you can add counts for documents coded as 1-Responsive and label them as Responsive Docs. To view the Database Overview Report Chart, do one of the following:

- Click the Tools menu and select User Dashboard Tools, click the Reports tab, and then click Database Overview Report Chart.
- Click the Admin menu and select Admin Dashboard Tools, click the Admin Reports tab, and then click Database Overview Report Chart.

Logged In Users Reports

TheLogged In Users reports list all logged in users for the current library (Logged in Users: Library) or all Case Logistix libraries (Logged in Users: All). In order for the reports to run, the user account used to generate the reports must have the proper permissions to access master.dbo.sysprocesses and view all users. Note the user running the report may, in some situations, be listed as a new login.

To access the reports, click the Admin menu and select Admin Dashboard Tools, click the Admin Reports tab, and then click Logged in Users: Library or Logged in Users: All.
permissions to access master.dbo.sysprocesses and view all users. Note the user running the report may, in some situations, be listed as a new login.

To access the reports, click the Admin menu and select Admin Dashboard Tools, click the Admin Reports tab, and then click Logged in Users: Library or Logged in Users: All.

### User Productivity Report

**Note:** The User Productivity Report only displays the number of fields and tags that were modified, and not the number of documents like the User Productivity Chart.

#### User Productivity Report - Gil Bower v. DC Corporation

Criteria - Start Date = 10/01/2014 End Date = 11/25/2014 All Users Group By = USERNAME and DATE

<table>
<thead>
<tr>
<th>Username</th>
<th>Date</th>
<th>Total Docs Viewed</th>
<th>Total Fields Updated</th>
<th>Total Fields Erased</th>
<th>Total Tags Set</th>
<th>Total Tags Unused</th>
</tr>
</thead>
<tbody>
<tr>
<td>Admin</td>
<td>10/27/2014</td>
<td>0</td>
<td>0</td>
<td>0</td>
<td>0</td>
<td>0</td>
</tr>
<tr>
<td>qa test</td>
<td>10/27/2014</td>
<td>14</td>
<td>3</td>
<td>0</td>
<td>11</td>
<td>0</td>
</tr>
<tr>
<td>qa test</td>
<td>10/30/2014</td>
<td>3</td>
<td>0</td>
<td>0</td>
<td>0</td>
<td>0</td>
</tr>
<tr>
<td>qa test</td>
<td>11/3/2014</td>
<td>0</td>
<td>2</td>
<td>0</td>
<td>0</td>
<td>0</td>
</tr>
<tr>
<td>qa test</td>
<td>11/4/2014</td>
<td>12</td>
<td>0</td>
<td>0</td>
<td>0</td>
<td>0</td>
</tr>
<tr>
<td>qa test</td>
<td>11/5/2014</td>
<td>3</td>
<td>0</td>
<td>0</td>
<td>0</td>
<td>0</td>
</tr>
<tr>
<td>qa test</td>
<td>11/21/2014</td>
<td>3</td>
<td>6</td>
<td>0</td>
<td>0</td>
<td>0</td>
</tr>
</tbody>
</table>

The User Productivity Report is a more detailed version of the User Productivity Chart. The report includes the number of fields and tags that were updated by a user, the number of documents viewed, the number of tags applied and removed from documents, and so forth. Columns that contain #### are too small to display data and must be resized.

1. Do one of the following:
   - Click the Tools menu and select User Dashboard Tools, click the Reports tab, and then click User Productivity Report.
   - Click the Admin menu and select Admin Dashboard Tools, click the Admin Reports tab, and then click User Productivity Report.
2. Select a date range from the Date Range list.
3. Select a user or workgroup from the User list.
4. Select a value to group data in the report by from the First list. To include a secondary grouping order, select a value from the Second list. For example, to view all data for each selected user by day, select User from the First list and Day from the Second list.
5. Click Run Report.

#### Distinct Users per Day Report

The Distinct Users Per Day Report lists the number of users who accessed a library on a specific date. If no users accessed the library on a specific date, then that date is not listed in the report.

To access the report, click the Admin menu and select Admin Dashboard Tools, click the Admin Reports tab, and then click Distinct Users Per Day Report.

#### Field Populated & Null Count Report

The Field Populated & Null Count Report lists all of the fields in a library, the number of documents for which each field is populated with a value, and the number of documents for which the field value is NULL.

To access the report, click the Admin menu and select Admin Dashboard Tools, click the Admin Reports tab, and then click Field Populated & Null Count Report.
Document Notes Report
The Document Notes Report lists all of the notes in a library. The report includes the document number, date added, date updated, and the name of the user who last edited the note.

To access the report, click the Admin menu and select Admin Dashboard Tools, click the Admin Reports tab, and then click Document Notes Report.

Tag Count Report
The Tag Count Report lists all of the tags in a library and the number of documents associated with each tag.

To access the report, click the Admin menu and select Admin Dashboard Tools, click the Admin Reports tab, then click Tag Count Report.

User Tag Count Report
The User Tag Count Report lists the tags that each user has applied to documents, as well as the number of documents to which they applied each tag.

To access the report, click the Admin menu and select Admin Dashboard Tools, click the Admin Reports tab, and then click User Tag Count Report.

Custom Report
The Custom Report tool allows you to create a report that lists the values for selected fields and documents. Only unique value combinations display in the report. For example, if you run the report on the Custodian and Responsive fields, and multiple documents are coded with Gil Bower in the Custodian field and 1-Responsive in the Responsive field, only one row displays in the report.

1. Click the Admin menu and select Admin Dashboard Tools.
2. Click the Admin Reports tab, then click Custom Report.
3. Select a tag from the Documents in Tag list. Select Entire Library to run the report on all documents in the library.
4. Select a saved report from the Defined Reports list, if applicable.
5. Select fields from the Fields column, then click Add to add them to the Report Fields column. You can order the fields in the Report Fields column by clicking Move Up or Move Down.
6. Type a name for the report in the Report Name box. The report name is required if you plan on saving the report definition.
7. You have the following options:
   - Save Report: Saves the report.
   - Update Report: Updates the selected Report Definition.
   - Delete Report: Deletes the selected Report Definition.

Login History Report
The Login History Report lists the users that have logged in to a library. The report includes the user name, login dates and times, and the total number of times a user has logged in to the library.

To access the report, click the Admin menu and select Admin Dashboard Tools, click the Admin Reports tab, and then click Login History Report.

Document File Report
The Document File Report lists all of the files associated with a single document or range of documents. For example, you can run the report on a TIFFLIST to view a list of the files that make up the TIFFLIST.

Note: The Run Report button is disabled if the number of document files returned is more than 65,000.

1. Click the Admin menu and select Admin Dashboard Tools.
2. Click the Admin Reports tab, then click Document File Report.
3. Type the starting and ending document numbers (Doc#) for the range of documents you want to run the report on. To run the report on a single document, leave the Ending Document Number box blank. To run the report on all files in the library, leave the Starting Document Number and Ending Document Number boxes blank.
4. Click Get Count to display the number of documents in the specified document range.
5. Click Show SQL to generate a SQL query that can be run in SQL Server Management Studio.

Working with Dashboard Utilities   73
Tag Detail Report

The **Tag Detail Report** is a more detailed version of the Tag Count Report (see "Tag Count Report" on page 73 for more information). The report includes the name of each tag in the library, the number of documents contained in each tag, the Tag Type (Global, Shared, or Private), and whether Family Tagging is enabled for each tag.

**Note**: If a tag is private, the name of the user who created the tag displays. If a tag is shared, the name of the workgroup that has access to the tag displays.

To access the report, click the **Admin** menu and select **Admin Dashboard Tools**, click the **Admin Reports** tab, and then click **Tag Detail Report**.

View Library Designer

The **Library Designer Viewer** allows you review Library Designer information in read-only mode.

1. Click the **Admin** menu and select **Admin Dashboard Tools**.
2. Click the **Admin Tools** tab, then click **View Library Designer**.
3. Expand the lists in the left panel by clicking the plus sign (+) next to each item. Click an item in a list to view details about that item in the right panel.

Identify Duplicates

The **Identify Duplicates** tool identifies duplicate documents based on field data. The tool compares the field data of the documents; groups documents with the same field values into a duplicate group; marks one of the documents as the primary document; and marks the remaining documents as duplicate documents.

**Note**: You can copy field values from primary documents to duplicate documents using the Propagate Duplicate Data tool (see "Propagate Duplicate Data" on page 76 for more information).

1. Create the following items:
   - A field to contain the identification number for primary documents, for example, **Primary Doc ID**.
   - A field to contain the number of duplicate documents in each duplicate group, for example, **Dupe Count**.
   - A tag to contain the primary documents, for example, **Primary Docs**.
   - A tag to contain the duplicate documents, for example, **Duplicate Docs**.
2. Click the **Admin** menu and select **Admin Dashboard Tools**.
3. Click the **Admin Tools** tab, then click **Identify Duplicates**.
4. Select a tag from the Documents in Tag list.
5. Select the **Exclude Parent Documents** and **Exclude Attachment Documents** check boxes, if applicable. It is recommended that you exclude parent and attachment documents. To review parent and attachment documents, use the Identify Family Groups tool (see "Identify Family Groups" on page 75 for more information).
6. Select fields from the Fields list. It is recommended that you select metadata fields, for example, **MD5**, **To**, **From**, or **Subject**.
7. Click **Add Duplicate Field** to add the fields to the Duplicate Identification Fields list.
8. Select a field that contains a unique value for each document, for example, **Doc#**, from the Document ID Field list.
9. Select the **Use Previously Assigned Primary Document** check box to prevent the primary document from being changed if a duplicate group has a previously assigned primary document. This option allows new documents to be added to existing groups and new groups to be formed, if applicable. It also allows new documents to be added to duplicate groups.
10. Click **Use Lowest Value** or **Use Greatest Value** to specify how primary documents should be identified. If you click Use Lowest Value, the document with the lowest value in the field you selected in Step 8 is designated as the primary document.
11. You have the following options:
   - **Save Primary Document ID To**: The field you created to contain the identification number for primary documents.
   - **Save Duplicate Count To**: The field you created to contain the number of duplicate documents in the duplicate group.
   - **Tag Primary Documents As**: The tag you created to contain primary documents.
   - **Tag Duplicate Documents As**: The tag you created to contain duplicate documents.
14. Click **Show Duplicate Report** to display the values set when you click Assign Primary ID’s.
15. Click **Assign Primary ID’s** to display the total number of primary and duplicate documents.
Link Attachments

The **Link Attachments** tool allows for the relating of attachments to their parents after they have been added to a Case Logistix library. The tool assumes that the document identifier field contains a unique value for each document and that the parent ID field for each child document contains a value that is also contained in the document identifier field.

1. Click the **Admin** menu and select **Admin Dashboard Tools**.
2. Click the **Admin Tools** tab, then click **Link Attachments**.
3. Select a field from the Document Identifier Field list.
4. Select a field from the Parent Id Field list.
5. Click **Attach**.

Store Attachment Range

The **Store Attachment Range** tool populates the designated Attachment Begin and Attachment End fields with the values from the selected document identifier field. The attachment information determines the attachments and the order of the attachments.

**Note:** Case Logistix does not require attachments to immediately follow their parent. The Store Attachment Range tool records the document identifier for the first and last attachment. This might cause a disjointed attachment range.

1. Click the **Admin** menu and select **Admin Dashboard Tools**.
2. Click the **Admin Tools** tab, then click **Store Attachment Range**.
3. Select the tag from the Documents in Tag list.
4. Select the field from where the attachment beginning and attachment ending are referenced from the Document Identifier Field list.
5. Select a field to contain the value for the Attachment Begin field from the Attachment Begin Field list.
6. Select a field to contain the value for the Attachment End field from the Attachment End Field list.
7. Click **Assign Attachment Range**.

Create Editor

The **Create Editor** tool allows you to create editors using any field in the library. You can add the following items to the editor:

- **+Divider** - A divider allows you to group fields in the editor under a common heading.
- **Read Only** - A field that you can view in the editor, but not modify.
- **Lookup List** - A pre-defined list of values that you can choose from when coding documents.

When you create an editor, the editor is automatically assigned a default name (your user name and the current date and time). To rename or modify the editor, use Library Designer. See the Library Designer **Help** for more information.

1. Click the **Admin** menu and select **Admin Dashboard Tools**.
2. Click the **Admin Tools** tab, then click **Create Editor**.
3. Select fields from the Fields list, then click **Add Fields** to add them to the Editor Items list. To reorder the fields, click **Move Up** or **Move Down**.
4. To add a divider, type a name in the **Divider Name** box and click **Add Divider**.
5. Click **Build Editor**.

Identify Family Groups

The **Identify Family Groups** tool allows you to identify documents that are members of a family group. The Family Group ID is always the Doc# of the parent document.

**Note:** You can copy field values from the parent document to other documents in the same family using the Propagate Duplicate Data tool (see "Propagate Duplicate Data" on page 76 for more information).

1. Create the following items:
   - Click the **Admin** menu and select **Admin Dashboard Tools**.
2. Click the **Admin Tools** tab, then click **Identify Family Groups**.
3. Select the field you created to contain the identification number for parent documents from the Save Family Group ID To Field list.
4. Select the tag you created to contain parent documents from the Tag Family Root Document As list.
5. Click **Show Family Group Report** to display the Family Group ID for each document that is a member of a family.
6. Click **Assign Family Group ID's** to display the total number of documents that were updated.
**Update IntelliFolder Static Values**

The **Update IntelliFolder Static Values** tool allows you to update the static sub-folders for an IntelliFolder based on the existing values in the IntelliFolder field.

1. Click the **Admin** menu and select **Admin Dashboard Tools**.
2. Click the **Admin Tools** tab, then click **Update Intellifolder Static Values**.
3. Select an IntelliFolder from the IntelliFolders list.
4. Click **Update**.

**Create IntelliFolders**

The **Create IntelliFolders** tool allows you to create IntelliFolders without having to access Library Designer. You have the same options as in Library Designer, minus the ability to add a lookup list of values. See the Library Designer **Help** for more information.

1. Click the **Admin** menu and select **Admin Dashboard Tools**.
2. Click the **Admin Tools** tab, then click **Create Intellifolders**.
3. Select a field from the Field list.
4. Type a name for the IntelliFolder in the **Title** box. If you leave the Title box blank, the IntelliFolder is assigned the field as its name.
5. Select the **Hide uncoded folders** checkbox to hide the Uncoded sub folder (see “Using The Uncoded Sub-folder” on page 42 for more information).
6. Select the **Create static folders for field lookup list values** check box to create static folders using the lookup list values from the field selected in Step 3.
7. Select the **Only display static folders** check box to only display static folders.
8. Click **Create Intellifolder**.

**Copy Tag to Field**

The **Copy Tag to Field** tool allows you to update field values for the documents in a selected tag. You can set the field value to the tag name or to one of the existing values for the field.

1. Click the **Admin** menu and select **Admin Dashboard Tools**.
2. Click the **Admin Tools** tab, then click **Copy Tag to Field**.
3. Select a tag from the Tag to Update list.
4. Select a field from the Field to Update list.
5. Select a value from the Field Value that will be Populated list.
6. Click **Update Value**.

**Propagate Duplicate Data**

The **Propagate Duplicate Data** tool allows you to copy field values from a primary document to the documents in the same group, for example, from a parent document to the child documents in a family group. Note you must re-run the Propagate Duplicate Data tool if you update field values, for example, if you modify a field value for the primary document and want to propagate the new value to the other documents in the group.

1. Click the **Admin** menu and select **Admin Dashboard Tools**.
2. Click the **Admin Tools** tab, then click **Propagate Duplicate Data**.
3. You have the following options:
   - **Documents in Tag**: The tag that contains the documents to propagate.
   - **Document ID Field**: The field that contains the duplicate group or Family ID. If you are propagating to a family group, you must select Doc#.
   - **Primary Document ID Field**: The field that contains the Group ID for each duplicate group or family group, for example, Primary Doc ID or Family Group ID.
4. Select the fields to propagate from the Fields list, then click **Add Propagate Field** to add them to the Propagated Fields list.
5. Select the tags to propagate from the Tags list, then click **Add Propagate Tag** to add the tags to the Propagated Tags list.
6. Select the **Propagate Redactions** and **Propagate Notes** check boxes, if applicable.
   - **Note**: Be sure to verify the positioning of the redactions and notes in the propagated documents as the file size might be different or the documents might not be true exact duplicates.
7. Click **Propagate Values**.
Configure Database Overview Report

The Configure Database Overview Report tool allows you to add items to the Database Overview Chart using a SQL query (see "Database Overview Report Chart" on page 71 for more information). To validate the query, paste it in the Advanced Search SQL Search tab and click Validate. If the query is valid, a Validation Passed message opens.

1. Click the Admin menu and select Admin Dashboard Tools.
2. Click the Admin Tools tab, then click Configure Database Overview Report.
3. Type the Report Item Order in the box provided. The item order determines the order in which items appear in the Database Overview Chart and must be an integer. If multiple items have the same order number, the Report Item Name is used as a secondary sort order.
4. Type a name for the item in the Report Item Name box.
5. Type the SQL query for the item in the Report Item Criteria box. The Report Item Criteria cannot reference Calculated Fields.
6. Click Add Report Item. To edit an item, select an item from the list, make the appropriate edits, and then click Edit Report Item. To remove an item, select an item from the list and click Delete Report Item.

Create Batches

The Create Batches tool allows administrators to create new batches. When you create a new batch, you select a tag that contains the documents you want to assign to the batch. Parent documents and their attachments are automatically assigned to the same batch.

Note: You must create new batches in order to include newly added parent documents or attachments.

1. Click the Admin menu and select Admin Dashboard Tools.
2. Click the Batching Admin Tools tab.
3. Click Create Batches.
4. Select a tag from the Tags to Batch list. The Total Docs in Tag box displays the number of documents in the selected tag.
   Note: The Batch ID is the field that contains the Batch ID for each batch. You can change the Batch ID by modifying the batching utilities. Contact Technical Support for more information.
5. Select the Include All Family Members not in the Tag check box to include family members that are not in the selected tag.
6. Select a secondary field by which to group documents into batches from the Grouping Field list, if applicable.
7. Select the Prevent Splitting of Groups check box to place all documents with the same grouping field value in the same batch. Note the batch size is ignored if the number of documents with the same field value exceeds the specified batch size.
8. Select the Combine Groups check box to allow multiple documents with different Batch IDs to be placed in the same batch until the Batch Size is reached. If you do not select the check box, a new batch is created for each unique field value.
9. Type the batch prefix in the Batch Prefix box or accept the default prefix (BATCH).
10. Select the Prevent Re-Batching of Documents check box to prevent documents that are already in a batch from being assigned to a new batch.
11. Type the length of the number to append to the batch prefix in the Batch Padding box or accept the default value (6).
12. Type the maximum number of documents for each batch in the Batch Size box.
13. Click Create Batches. The Tag Batcher Report opens. The report lists the Batch ID and document count for each batch.

Note: The Batch Start box contains the starting batch number, which is determined by the largest batch number currently present in the Batch ID field. You can change the value, but doing so might affect existing batches by adding additional documents to them.
Manage Batches

The **Manage Batches** tool allows administrators to assign batches to reviewers and return existing batches to a previous state. To promote batches or mark them as complete, use the My Batches tool (see "Batching User Tools (My Batches)" on page 66 for more information).

1. Click the **Admin** menu and select **Admin Dashboard Tools**.
2. Click the **Batching Admin Tools** tab.
3. Click **Manage Batches**.
4. Select a batch from the list provided, and then choose from the following options:
   - To assign the batch, select a reviewer from the Reviewer list and click **Update Reviewer**. The Reviewer list contains all reviewers who have access to the library.
   - To return the batch to a previous state, select a status from the ReviewStatus list and click **Update Status**. The ReviewStatus list contains all batch states up to the current batch status.

**Note**: The **Update Reviewer** and **Update Status** buttons are disabled if the current reviewer or current batch status is selected. You must select a different reviewer or batch status in order to enable the buttons.

Save Batch QC Rules

The **Save Batch QC Rules** tool allows administrators to configure the promotion and completion rules for each batch status. The default batch status names are as follows:

- 1-Initial Review
- 2-Issue Review
- 3-Key Documents
- 4-Complete

The rules ensure that documents are coded or reviewed in a particular way, and are executed when reviewers indicate they are done with a batch. The promotion rule allows the documents in a batch, as well as the batch itself to move to the next batch status. The promotion rule runs on all documents in a batch. Documents that pass the rule are promoted to the next status. If all documents in a batch pass the rule, the entire batch moves to the next status. If the promotion rule is Null or empty, all documents pass the rule.

The completion rule allows the documents in a batch, as well as the batch itself to move to the Complete status. The completion rule always runs before the promotion rule. Documents that pass the rule are moved to the Complete status. If all documents in the batch pass the rule, the entire batch moves to the Complete status. If the completion rule is Null or empty, no documents pass the rule.

**Note**: It is recommended that you test the rules by creating a SQL query on the Advanced Search SQL Search tab.

1. Click the **Admin** menu and select **Admin Dashboard Tools**.
2. Click the **Batching Admin Tools** tab.
3. Click **Save Batch QC Rules**.
4. Select a batch status from the Status list.
5. Select a rule type from the Rule Type list.
6. Type the rule criteria in the Rule box. Field names in a rule must be in brackets in order to appear on the Batch Rule Report.
7. Click Save Rule.

Configure Batch Status Report

The **Configure Batch Status Report** tool allows you to use SQL queries to add items to the Batch Status Report (see "Batch Status Report" on page 66 for more information). It is recommended that you test the query in SQL Server Management Studio.

1. Click the Admin menu and select **Admin Dashboard Tools**.
2. Click the **Batching Admin Tools** tab.
3. Click **Configure Batch Status Report**.
4. Type a number in the Report Item Order box. The Report Item Order controls the order of the items in the report, and can contain duplicates and gaps in numbering. If multiple items have the same number, the Item Name is used as a secondary order method.
5. Type the item name in the **Report Item Name** box.
6. Type the SQL query for the item that you want to add to the report.
7. Click Add Report Item.

Review Status Chart

The Review Status Chart provides a quick look at the progress of a review by listing the batch status of all batched documents.

1. Click the Tools menu and select **User Dashboard Tools**.
2. Click the **Batch Reports** tab.
3. Click **Review Status Chart**.

Batching Chart

The **Batching Chart** displays the total number of documents in the library, total number of batched documents, and the total number of documents in each batch state.

To access the Batching Chart, do one of the following:

- Click the Admin menu and select **Admin Dashboard Tools**. Click the **Batching Admin Tools** tab, and then click **Batching Chart**.
- Click the Tools menu and select **User Dashboard Tools**. Click the **Batch Reports** tab, and then click **Batching Chart**.

Batch Status Report

The **Batch Status Report** provides an overview of the batches in a library. The report includes the current status, assigned reviewer, number of documents in each batch, and so forth.

To access the Batch Status Report, do one of the following:

- Click the Admin menu and select **Admin Dashboard Tools**. Click the **Batching Admin Tools** tab, and then click **Batch Status Report**.
- Click the Tools menu and select **User Dashboard Tools**. Click the **Batch Reports** tab, and then click **Batch Status Report**.

Reviewer Status Report

The **Reviewer Status Report** lists the review status and total number of documents assigned to reviewers.

Note: The Reviewer field is empty for unassigned documents.

1. Click the Tools menu and select **User Dashboard Tools**.
2. Click the **Batch Reports** tab.
3. Click **Reviewer Status Report**.

Batch History Report

The **Batch History Report** lists all activities that have occurred for a given batch. The activities listed are Created, Assigned, QA Failed, Updated # Documents, Completed, and Released.

1. Click the Admin menu and select **Admin Dashboard Tools**.
2. Click the **Batching Admin Tools** tab.
3. Click **Batch History Report**.
4. Select a batch from the batch list. The report includes the following details:

   - **BatchID**: Name of the batch.
   - **Date**: Date and time of the action.
   - **Performer**: User who initiated the action.
   - **Action**: Action that occurred.
   - **Batch Assigned To**: User to whom the batch is assigned.
   - **Batch Start Status**: Batch status at the start of the action.
   - **Batch End Status**: Batch status after the action was completed.

**Batching User Filtering**

The Batching User Filtering utility allows administrators to filter the documents in the Document List, so that reviewers only see the documents contained in the batches assigned to them. The SQL Script has a variable to set to apply the filter to the Workgroups to which you belong.

1. Start **SQL Server Management Studio** and log in to the SQL Server instance that contains the library Central Database.
2. Click **New Query**
3. Set the Database to the library where you want to add the Document List filter.
4. Add the contents of the 4 - Add CLX-Batching User Filter for Workgroup.sql script to the query. If you accepted the default installation path, the script is located in C:\Program Files (x86)\Westlaw CaseLogistix\WCLX-Dashboard\Installation Scripts\Optional Batch Filtering.
5. Specify the workgroup you want to apply the filter to by modifying the following section in the script:

   ```sql
   Set @WorkgroupName = ''
   For example, Set @WorkgroupName = 'BatchViewOnly'.
   ```
6. Click **Execute**.
7. Start Case Logistix.

The script updates the stored procedure User_LoginWork. The default implementation of User_LoginWork performs no actions. If the stored procedure has been modified, this installation deletes the altered version and replaces it.